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Getting started

Correct exposure
This shot shows a vast colour 

range with all of the details clearly 
visible, including the highlights 
and shadows of the scene 

Leading line
  The leading line going 

through this photo draws 
the eyes across the entire 
scene and to the main 
feature, which is the 
different colours in the sky

T aking your first steps in photography need not be 
a daunting venture. By following a simple set of 
guidelines you can be on your way to taking fantastic 

shots in no time at all. 
Photography is a very broad subject, which can encompass 

everything the world has to off er. It is therefore diffi  cult to give 
defi nitive steps as to what will make a good photo. However, 
despite this, it is important to consider how you are 
photographing your subject or scene, and the diff erent aspects 
of what is being shot that will make it a good photo. 

Composition is important in every area of photography, and 
generally refers to how the subject is framed in order to make 

a compelling photo. Along with many aspects of composition, 
leading lines can draw the eye through a photo, and encourage 
the viewer to take in the whole scene. Having an interesting 
focal point is key. 

Lighting is a very important part of photography, and 
exposing the light correctly is a fundamental step to achieving 
a good photograph. Therefore something as simple as 
shooting at the right time of day can have a huge eff ect on 
how the scene looks. 

These are the core things to consider when taking your shot 
and when you get these things right you will create some great 
imagery. We show you how… 

In this ultimate guide, we take you through the essential 
skills and techniques needed to take the perfect photo

Getting  started 
with photography

10



“Exposing the 
light correctly is a 

fundamental step to 
achieving a good photo”

Getting started with photography

Lighting
Using only harsh natural light, 

this scene has been evenly lit 
across the entire range 

Composition
Simple composition has 

placed an even amount of sky 
and foreground in this shot, 
using a leading line to force 
the eye across the scene

Focus point
 Having a main point of focus is 

important as it gives the eyes something to 
focus on when first looking at the image

11
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Rule of thirds
For a balanced image, 
place your main point 
of interest a third 
of the way up and 
preferably off-centre. 

Distracting 
backgrounds
Ensure you have a good 
backdrop to your photo, 
regardless of the subject. 

Top tips for great shots

Lighting
Make sure the light is right 

Adding artificial light, such as a camera 

flash, can help brighten up a scene 

where natural light is not available. 

When using natural light, consider the 

ideal times for the best results. Harsh 

sunlight can make a photo look flat and 

unattractive, which makes shooting in 

the middle of the day very undesirable. 

Always consider the composition, how 
the photo will look, and what you are 
trying to show. The position of the main 
subject in the frame is key, and correct 
placement can enhance the overall 

look of the photo. It is important to 
make the shot visually interesting, while 
encouraging the viewer to scan the 
entire image. Using leading lines and the 
correct lighting will do this. 

Leading lines
Consider your subject and how 
you want to portray it in the photo 
before firing away. When framing 
the shot, use leading lines to draw 
the viewer towards the subject.

Correct lighting
A badly lit or under 
exposed image will not be 
pleasing to look at, and will 
not present the subject 
very well. 

Focus point
Have a main point of 
interest, and place 
the camera’s focus 
upon this point.

Composition
A good composition is the first step to a great photo

Low light
Low light can create 
dramatic images, 
but they’re hard to 
master. Try a night- 

time setting or use a higher ISO to let 
more light onto the camera’s sensor.

Harsh lighting  
– natural light
Natural light can 
often have a harsh 
effect on the photo. 

This is common when shooting in the 
middle of the day, and when the position 
of the sun hasn’t been considered. 

Artificial light
Often used when 
shooting indoors or 
when there is no 
natural light. It can 

be used effectively to light the subject, 
but it can be difficult to get even results. 

Bounce the light
Bouncing the light 
is great for directing 
it where it is 
needed, and can be 

done with a dedicated reflector or any 
light surface, such as white card. 

Natural light
This is often the 
most flattering form 
of light to use, as it 
gives an even 

spread across the scene, without over or 
under exposing any part of it. 

Essential
photography
tips & tricks
Get started with these fundamental 
hints and techniques
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Aperture
Aperture determines 
how ‘open’ the lens is, 
so how much light is 
‘seen’ by the sensor. 
Set using ‘f-numbers’, 
the lower the f-number, 
the wider the aperture. 
Aperture can also be 
used to create different 
depths of field, so how 
much of the scene is  
in focus. 

Your camera’s white balance can affect 

the overall tone of your photo. It is a 

function that removes the different colour 

casts created by the lighting in the scene. 

In simple terms, it is used to ensure the 

colours in the scene are as accurate as 

possible. It does this by measuring the 

colour temperature of the photo and 

adjusting the colours accordingly. 

Cloudy
The Cloudy setting will 
compensate for the 
lack of sunlight and 
harsh cloud coverage, 

generally enhancing the photo with a 
warmer tone. 

Tungsten
This white balance 
setting is used when 
shooting indoors, under 
harsh and direct 

fluorescent lighting. It cools down the 
photo and removes unwanted colour casts. 

Flash
When using a camera’s 
flash, the shot can be 
quite washed out and 
cool. This white balance 

setting therefore compensates for the flash 
by warming the photo slightly. 

Shade
A scene which is 
covered by lots of 
shade has a cooler look, 
with a flat tonal range. 

The Shade white balance setting warms up 
the shot and gives it a more natural look. 

Exposure
The exposure of an image dictates light levels
Your camera’s exposure tells it 
how much light to let in when 
taking the photo. The amount 
of light let in determines how 
bright or dark the image will 
appear once it has been taken.

Exposure is one of the key 
parts of photography; learning 
how to master it will go a long 
way to ensure you get the 
very best photo each time you 
press that shutter. 

There are several settings 
primarily formed around 
correctly exposing the 
photograph, and these 
settings can be manually or 
automatically controlled. 

Ultimately, an image 
which comes out too dark is 
commonly referred to as  
being underexposed,  
while an image which is too 
bright is referred to as  
being overexposed.

Histogram
A graph displaying light 
levels across the photo, 
from black on the left 
to white on the right. 
The heights display 
how many pixels sit at 
that light level. View 
a histogram to get an 
even exposure across 
the range. 

Shutter speed
Determining for how 
long the shutter is 
open. A fast speed 
means the photo is 
taken quickly. Slower 
speeds mean more 
light gets on to the 
sensor. Leave a shutter 
open for longer for 
movement blur. 

ISO
The ISO value 
determines what the 
camera’s sensor does 
with light. A higher ISO 
value will make the 
camera more sensitive 
to it, allowing for a 
brighter image. A lower 
ISO makes the sensor 
less sensitive to it, but 
will also produce a 
more crisp image. 

White balance
Getting colours accurate 

Main focus point
Having a main point of interest 

gives the viewer something to 
focus on, allowing the rest of the 
shot to complement and frame it 

Leading line
A leading line in the 

image draws the viewer’s 
eyes through the entire 
frame, encouraging them 
to take in the whole photo

Use the  
whole frame

Make sure 
you use all of the 
space available to 
frame the image, 
ensuring there is 
no empty space 
which does not 
add interest to 
 the shot
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Photography FAQ

6 Is there a way of using the 
flash for more even results?

Using a camera’s flash can sometimes 
give harsh results. However, coupling 
the flash with natural light can allow 
you to fill in the darker shadows, and 
ultimately achieve an evenly lit photo. 

2 How can I freeze the action 
at a sport event? 

Freezing action can be very important 
for moving subjects, as well as 
combating any camera shake. Set your 
camera to shutter priority and select a 
fast shutter speed, or alternatively use 
the sport scene mode. 

4 When taking a portrait, 
where is best to focus? 

Rather than simply leaving it up to the 
camera to choose focus, take control 
and set it yourself. Place the focus 
point over the eyes of the subject, 
because this is where we naturally 
look when viewing the photo. 

7 How can I isolate my subject from 
the background? 

Isolating your subject from the background can 
sometimes be extremely beneficial and is, in 
fact, quite simple to do. Select the aperture 
priority setting and choose a low f-number. This 
will consequently throw the background out of 
focus while keeping the subject nice and sharp. 

3 What is the best time of day 
to take an outdoor portrait? 

Natural light can be very difficult to 
use effectively, because you are 
unable to control its effect on your 
subject. For the most flattering light, 
you should shoot shortly after sunrise 
or just before sunset.

We answer the most common questions of beginner photographers

5 Is it best to zoom in or crop 
the shot afterwards? 

Zooming in can allow you to retain the full 
image resolution of the photo, however it 
is much harder to capture the shot 
effectively this way. If you have a lot of 
megapixels to play with, you may find 
that shooting further out is slightly  
more beneficial. 

1 How can I ensure my horizon is 
kept straight?

A wonky horizon can be distracting, so 
ensuring it is straight is very important. 
Many cameras come with a grid overlay 
function, or a spirit level that will ensure 
your photo is perfectly straight. 
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Your accessories are very 
important, and allow you to 
work better as a photographer

Kit bag
A camera bag like this Lowepro 

Stealth Reporter (www.lowepro.
com) is essential. It off ers a 

convenient way to transport your 
camera and accessories, as well 
as a safe environment for them 

to be stored.  

8  What can I do to avoid 
blurry images? 

Blurry images can be the result of many 
things. Commonly it is down to camera 
shake, so try using a faster shutter speed, 
a lower f-number, or a higher ISO, all of 
which will speed up the camera, 
eliminating camera shake. 

9  How can I take better 
indoor shots? 

Indoor photography can be very 
diffi  cult, due to the light available. Try 
using a tripod or resting the camera on 
a surface which will hold the camera 
still, allowing it to soak up the available 
light for an evenly exposed photo. 

10  How do I make the most 
of my camera and get 

better all-round photos? 
Learning the diff erent functions and 
features of your camera will help you 
make the most of what it has to off er. 
Experiment with the manual modes, as 
well as the many automatic scene modes 
that are available. 

Editing 
software
Editing 
software is 
becoming 
more and 

more popular, and is 
extremely useful in 
modern photography. 
Programs like 
Photoshop Elements 
(www.adobe.com) can 
enable you to apply 
basic fi lters, eff ects and 
fi x problem photos.

Tripod
A tripod such as this 
Manfrotto 055 
Carbon Fibre Tripod  
(www.manfotto.com) 
is a useful piece of kit. 
It reduces risk of 
blurry images and 
allows you to easily 
compose your 
shots. 

Lenses
If your camera can change lenses, 
you will likely use a combination 
rather than a single lens, such as this 
Nikon 18-55mm f3.5-5.6G (www.
europe-nikon.com). Ensure you have 
lenses that cover each focal length 
so you can photograph any subject.  

Memory cards
Memory cards are one of the most 

important pieces of kit. Ensure you have 
enough memory cards, such as this one 

from Samsung (www.samsung.com), so 
you are never caught short of space.

Essential 
kit for 
beginners
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Compacts and superzooms are 
referred to as point-and-shoot 
cameras, billed as easy to use 
and suitable for all types of basic 
photography. They come with 
automatic settings and a general-
purpose lens designed to cover 
the focal lengths that the average 
person will need. 

Compacts and superzooms 
generally do not offer manual 
settings, or use external accessories, 
but with the advancement in 
photography, compacts and 
superzooms are adopting more 
and more advanced technology. 
The Panasonic TZ60 pictured here 
(www.panasonic.co.uk) comes with 
image stabilisation, Intelligent Auto 
mode and HD video.

The Nokia Lumia 1020 
here (www.nokia.co.uk) 
comes with a 41MP camera. 
Cameraphones commonly 
have small sensors and 
therefore limited pixel 
quality, but can produce 
excellent photos in the right 
conditions. The lens fits 
within the device’s body, 
meaning there’s not much 
possibility of a decent zoom, 
but apps can improve this.

Fixed lens cameras
Compact cameras and superzooms are 
basic all-round cameras for any situation

Downloadable apps:
Apps offer more advanced 
features and controls

On-screen controls: 
Commonly operated using 
the device’s touch-screen

LCD screen :  Large screen 
makes composition and fine 
tuning of settings very easy 

Lens: Fixed optical zoom 
range so more suited to 
capturing close subjects

 Usually to hand
  Small in size so 
easy to carry

  Downloadable 
camera apps

  Small in size so 
easy to carry 

  Many automatic & 
scene modes

  Relatively 
cost-eff ective 

  Small sensor aff ects 
image quality 

  Fixed lens 
limits captures

  Limited results

CONS 
   Small sensor

aff ects image 
quality 

   Lack of manual 
controls 

  Can’t be used 
      with accessories

Choose a camera
The essential guide to picking the right equipment

Shutter release: Basic 
shutter release. Half 
depress it to focus and 
fully press it to shoot

Controls: Settings are 
at easy-to-use places, 
Advanced features 
are in the menus

LCD: A rear LCD 
for composition 
and changing 
settings

Lens: Fixed to the body and 
allows for an extensive 
amount of zoom, from wide 
angle to medium telephoto

Flash: Basic, 
built-in fl ash for 
taking photos in 
dark conditions 

Cameraphones 
Mobile phone cameras are a convenient 
option and are becoming more advanced

PROS                                                             

PROS                                                             

 CONS
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Compact system cameras (CSCs), 
like the Olympus PEN E-PL5 here 
(www.olympus.co.uk), are built 
to allow for DSLR quality images, 
but with the simplistic nature of 
a compact camera. They utilise 
the available automatic and scene 
modes and include creative filters. 
Unlike compact cameras they 
include manual shooting modes. 

The CSC has interchangeable 
lenses and accessories. The lenses 
therefore dictate the focal range and 
apertures available. 

The image quality of CSCs are fast 
becoming as good as DSLR cameras, 
as they utilise the larger APS-C 
size image sensor and use more 
advanced optics. 

  A very 
compact body

 Very easy to use
  Large sensor for 
good image 
quality

  Large sensor for 
good image quality

 Full manual control
  Accessories and 
lenses can be used

  Expensive 
system to use

  Handful of 
 lenses available

  Not as functional 
as a DSLR

  An expensive 
system to use 

  Diffi  cult to use 
for beginners

  Large in size 
so hard to carry  

Compact system cameras
Compact system cameras are a new, yet 
popular alternative to larger DSLRs

DSLR cameras
At the forefront of image quality, utilising 
large sensors and high-quality lenses

DSLRs are professional-level 
cameras that produce images 
of the highest quality. Although 
most come with automatic 
modes, they are primarily 
designed to be used with full 
manual settings. 

People also use DSLRs for 
the level of control that you 
are able to have over how the 
image looks. There is also the 
large benefit of using multiple 
lenses, as well as a vast range of 
accessories. 

DSLRs are not necessarily 
built to be beginner friendly, 
although entry-level models 
such as the Canon 1200D (www.
canon.co.uk) pictured here are 
attempting to bridge the gap.

Interchangeable 
lenses: Lenses used 
can be removed and 
changed for others

Accessible controls:

Most are on the 
camera body so 
can be adjusted 
fast. Designed to 
be intuitive 

Viewfi nder: Allowing you to 
look through the line of 
sight of the camera, making 
framing and composition 
more intuitive

LCD:
Settings can be 
changed, images 
played back, 
and Live View 
mode used

Large body grip:
It can be firmly 
gripped in the hand 
when taking photos

Larger sensor: 
Usually the APS-C 
sized sensor that is 
used in DSLRs, 
providing excellent 
image quality 

LCD screen: 
At the back, the 
LCD screen is used 
for composing the 
shot and also 
adjusting settings

Manual controls:
Often found on the 
top of the body, 
but this varies

Interchangeable lenses:
Can be swapped for 
alternatives. It dictates focal 
ranges and aperture values

PROS                                                              

CONS                                                              

PROS                                                              

CONS
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T aking photographs may seem like 
a simple process, and one which 
does not need much thought. 

Where this is true of simple snapshots, 
it takes a lot more thought to get great 
photos each time. 

Many great subjects cannot be 
captured well with simple snapshots, and 
it requires more control of the camera 
and subject to get the most out of them. 

Equipment needed:  DIGITAL CAMERA | TRIPOD | SUBJECT | EDITING SOFTWARE

Good photos take time to capture, and 
are the work of the photographer as 
much as the camera. 

Before taking the photo, consider the 
composition you wish to use, the lighting 
of the surroundings and what you want 
to present with your photo. You will then 
be able to focus on the camera setup, and 
go through the process of adjusting the 
settings to your preference. 

1 Consider the lighting
Look at lighting before 

taking a photo. It determines 
what settings to use and the 
outcome of the shot. This is 
badly lit, so we moved to a 
different flower in better light.

2   Set up a tripod
Using a tripod is often 

essential. Attempting to hold 
the camera still while focusing 
on the subject can cause you 
to lose the focus or end up 
with a blurry image. 

3   Compose the shot
When composing there 

are principals that can be 
followed, like the rule of thirds. 
Think about these at this stage 
as they can help to better 
frame the subject.

4 Change the settings
Use the correct settings 

for your subject. Consider 

what is needed in order to get 

the correct amount of light, 

and how you want to 

represent the scene.  

5  Apply in-camera effects
If you would like to add 

effects, do so now. Most 
compacts come with a range 
and DSLRs have some options. 
Choose the effect from your 
menu screen. 

6  Focus the camera
Ensure the subject is in 

focus. This can be done by 
allowing your camera to focus 
automatically by half pressing 
the shutter or manually 
adjusting the focus.  

7  Take the photo   
When taking any shot, 

don’t move the camera too 
much, but retain the original 
composition and focus, 
ensuring the shot comes out 
as originally planned. 

8 Edit the image  
Editing can offer simple 

but effective improvements. 
Cropping in to the main subject, 
straightening a horizon, or 
sharpening a portrait can have a 
huge effect to the overall look.  

Setting up your very first photo shoot 
can be a rather daunting task. However, 
by laying out the steps one by one, you’ll 
find it is actually an easy process that 
will let you take control of how your shot 
comes out. 

Follow this basic step-by-step tutorial 
of how to take great photographs every 
time, and you should be rather pleased 
with the final result.

Your first 
photo shoot
A step-by-step guide to getting a 
great shot on your first photo shoot
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How do you take a good shot?
The key things to consider when 
taking your first photo

9  Share your shot  
Once happy with how your 

shot has come out, you can 
then use the many different 
sharing websites to display 
your photographs for all to see.  

 

“Before simply taking 
the photo, consider the 

composition you wish to use”

Colours
Colour is an important part 
of your image. With this shot, 
boosting the colours in editing 
software has ensured they are 
punchy and attractive, drawing 
the eye in to the photograph

Lighting is key
Try to make use of natural light, 
but if you are shooting in harsh 
conditions, or do not have 
a capable lens, try using the 
camera’s built-in flash to boost 
the brightness of the scene. 

Focus
Ensure the key part 
of your subject is in 
focus, such as the eyes 
in portraits. Here the 
focus point is in the 
middle of the flower

Composition
Composition is key – 
remove distractions 
from your subject and 
try to fill all areas of 
the frame

Depth of field
Consider if you want 
your background to 
be in focus or not. By 
using a wide aperture 
(low f-number) here 
the background has 
been put out of focus, 
drawing attention to 
the main subject 
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P hotography isn’t just about getting 
your camera settings correct or 
being in the right place at the right 

time. A lot of what makes a photo great is 
down to how it utilises the objects within 
it. By taking one subject and shooting it 
in a variety of ways, you can see what a 
difference composition can make. 

Think about angles. Try shooting a 
portrait straight-on, and then shooting 
it at an exaggerated angle – the angled 

image looks more modern and dynamic. 
In a landscape, try shooting lying on the 
floor to exaggerate the foreground, then 
shoot standing up and see the difference. 
Your zoom can help with composition too. 
Shoot your scene at both the widest angle 
and the telephoto (full zoom) to pick out 
little details in a scene. 

Whatever you shoot, try to think about 
different ways you can photograph the 
same scene and experiment!

Discover how a new composition can 
dramatically alter your photo

Improve your 
compositions

Shooting these flowers 
from above creates a fairly 
uninspiring image

02

01

Get up close to your subject for a 
macro shot like this
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By lying on the ground and zooming in on the 
underneath, the shot changes again03

21

Improve your compositions



shutter speeds
T he shutter speed dictates the 

amount of time the camera’s 
shutter is open for. Changing your 

shutter speed produces a range of effects, 
and certain areas of photography  
take advantage of this. Sport 
photographers can use a high shutter 
speed to freeze the action, or you can use 

slow speeds of one second, for example, 
on a subject such as moving water and its 
surface can be softened and blurred for a 
creative effect.

There’s no better place to experiment 
with shutter speed than in nature. This is 
where you can take your time composing 
a scene and playing with exposure for the 

best image. We try out three different 
shutter speeds on this waterfall to see 
how each one looks. You’ll notice that 
as the shutter speed gets quicker, more 
detail in the water is captured. If you have 
a tripod handy, set your camera to Shutter 
Priority or Manual mode and work your 
way up through the shutter speeds.

Use different shutter speeds to produce creative effects

Master your camera’s
Getting started
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01

Using a slow shutter speed 
results in a milky effect in the water

1sec
Using a shutter speed of 
one second, with the help 
of a tripod, exaggerates the 
movement in the water flow



Keep the  
camera steady 
At slower shutter speeds a 
tripod may be necessary to 
keep the camera still and 
stop unwanted blur from 
occurring in your shots
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Master your camera’s shutter speeds

03
1/80sec
Speeding up the shutter even more 
to 1/80sec captures the water in its 
tracks. Bubbles are now visible but 
still some movement is captured

1/10sec
To reduce the blurriness of the water, the 

camera’s shutter speed is set to 1/10sec. 
Slight detail can be seen in the water

02



Getting started

A perture plays an important part 
in photography as it dictates how 
far open the lens is and therefore 

how much light it takes in. This is set in ‘f’ 
numbers – the lower the number the wider 
the aperture, allowing more light to be let in. 

The aperture can also be used to create 
different depths of field. This is how much 

of the scene is in focus. Using a wide 
aperture, the main focus point will be in 
focus, with the rest of the scene blurred. 
Using a larger f-number will allow the entire 
photo to be in focus.

For portraits especially, many 
photographers will blur the background 
behind the subject, so as to remove any 

distracting elements. But sometimes 
keeping the background sharp has its 
advantages too, just in case something 
interesting may be happening around  
the subject. 

 We shoot three different approaches 
 to capturing one portrait so you can see 
how aperture effects the overall look.

See how the aperture decides how much light is let in and what is in focus

Control light and focus

01
f4.5
If you’re close to the model, 
make sure the background 
isn’t a distraction – using 
f4.5 creates a shallow 
depth of field

A low aperture creates a 
blurred background

24
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Control light and focus

25

A high aperture keeps 
the whole image sharp

f8
Because the model is closer to the 
lens, using f8 creates a gradual blur 
from the subjects in the foreground to 
the ones in the background

02

03
f16
With the aperture set at 
f16, the entire image is 
kept sharp. This works 
well when there’s an 
interesting background 
around the main subject



Getting started

26

Change colour casts
W hite balance refers to how the camera 

reads what type of light is being used for 
an image. Although this isn’t something 

we usually think of on a day-to-day basis, the correct 
white balance setting can make all the difference. 
The idea of white balance is that a certain colour of 
light is offset with another colour, such as blue or red. 
Work your way through the various settings, such as 
Flash, Cloudy, Daylight, Tungsten and Fluorescent, 
and you’ll notice a significant change in the colour of 
the image.

 We look at the same close-up shot of this 
chessboard, but using the camera’s Flash, Auto and 
Kelvin white balances. Shooting under flash lighting, 
the obvious choice is the first one of the three, but it’s 
interesting to see how the camera performs on Auto, 
and also how adjusting the setting manually creates a 
more artistic effect.

Learn how the white balance setting will drastically change a photo’s colour

“The correct white balance  
setting can make all the difference”

Flash white balance is the correct setting for 
when you are shooting with flash. Results are 
natural and well balanced, as if shot in daylight

01
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Change colour casts

02

03

In Auto white balance the camera is 
left to its own devices, setting white 
balance depending on the lighting. 
The results are quite warm here

K (Kelvin) white balance lets you assign a 
white balance yourself. We set the camera to 
4500K, for a slightly colder-looking image

27
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T ake one subject, one camera and 
three lenses, and you will create 
three very different photos. If 

you’ve invested in a DSLR or compact 
system camera, chances are you’ll 
have just one lens – the 18-55mm (or 
thereabouts) kit lens that came with the 
body. But what lens do you buy next and 
what can you achieve with it?

We’re here to show you how a prime 
wide angle, a high zoom telephoto and 

a creative fisheye lens could change or 
improve your photography by making 
you think differently about the way you 
compose. Each lens has its strengths and 
weaknesses, and knowing how to use 
yours will make you a better photographer. 
For instance, with fisheye lenses you 
need to use the edges and the angles – 
high or low – to achieve a creative effect. 
Experiment with your lenses and you may 
be surprised at what you can achieve.

Discover how a lens can change your photo

Experiment with lenses

Zoom in on small details and use the 
zoom to help play with perspectives

01
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Experiment with lenses

29

02

03

With fisheye lenses you should shoot at high 
or low angles or tilt the camera to one side

This image is the 
standard way to shoot 
a landscape – with a 
wide-angle lens
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L andscape photography is all about shooting when the light is just 
right. Arrive at the right time and the sun can change and shape 
the land from the ordinary into the spectacular, so it’s important 

to know just when to strike.
Dawn shoots can often be a real struggle, but it is this time of the 

morning when magical elements like fog and mist can occur. Staying 
in bed for those few extra minutes can become ‘make or break’, so set 
your alarm clock early and get to a viewpoint three quarters of an hour 
before dawn.

After the peak of colours, the sunrise changes drastically. As the sun 
rises it loses its golden colour, the saturation fades and the light levels 
increase sharply. Don’t be surprised if the conditions change entirely, 
just like this scene. Make the most of the changing light and witness the 
action unfold, instead of imagining what could have been.

Learn to shoot stunning 
images at any time of day

Choose the 
right times

If you’re creating a sunrise scene, make sure you 
choose a suitable white balance

01

Getting started

5:15am
Just before the break of dawn, the sky 

is lit from underneath. The reflected 
light turns the mist slightly magenta
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02
5:45am
Just minutes later the 
saturation begins to 
fade, with the mist 
turning white. As the air 
warms, the fog builds

Camera Settings 
We shot at 75mm and 
f4 using a custom white 
balance to make sure all the 
hues were captured

03
6:30am
Three quarters of an hour later, 
fog engulfs the landscape. 
With the sun diffused, the 
image lacks dimension

Shoot in  
RAW format 
Even with a shot like this, 
you can rescue a lot of 
detail hidden by shooting 
RAW and editing later

Choose the right times
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Get to know your 
camera and you’ll soon 
be taking your best 
ever photos 

D eciding which camera to buy 
can be rather tricky. There 
are different camera types, 

manufacturers, features and prices to 
consider, but we believe it’s not just 
about the camera, it’s about knowing 
how to use it. 

Each type of camera has its own set of 
pros and cons, and which one you choose 
will be dependent on what you’re using 
the camera for and your past experience 
in photography. If you simply want to 
catch quick shots on holiday or take 
videos of a grandchild, then a compact 
or cameraphone will probably suit your 
needs. But people looking for large 
printouts and more advanced shooting 
options will need to look towards DSLRs.

No matter what type you choose, with 
this Quick Start guide you’ll get to know 
all the key aspects of your camera and 
you’ll soon be taking amazing shots.  

Digital 
Camera    
Guide

+

–

+ –

  Delete 
– found on 
all cameras

Playback – 
use to review 
photos 

Flash – 
switch it 
on or off  
via this 

Night time/
low-light 
scenes 

Zoom in on 
your photos

Zoom out of 
your photos 

Self timer 
for self 
portraits etc  

Image 
stabilisation 

Symbols explained

Burst mode 
button 

Metering icon 
on pro 
cameras 

Exposure 
compensation 

Movie mode 
features

Macro – for 
close-ups 

Sports – for 
fast action 

Landscapes 
– for wide 
angles  

Portrait 
– perfect for 
people

Manual mode 
– for control

Aperture
Aff ects the 
amount of your 
image that is in 
focus – the ‘depth 
of fi eld’
Shutter speed
Fast speeds freeze 
action while 
longer ones blur 
motion
ISO
Refers to how 
sensitive the 
sensor is to light 
and makes 
low-light photos 
clearer
White Balance
Aff ected by the 
ambient light 
around you, your 
camera can alter 
this setting to 
ensure a natural 
colour result
Exposure
A balanced 
exposure has 
detail in light and 
dark areas
Metering
Refers to the way 
the camera reads 
the light in the 
scene

Jargon buster
Focal lengths
Wide-angle – 
a wider angle of 
view than normal, 
eg 28mm; 
Telephoto – 
a magnifi ed view 
of distant 
subjects, eg 
200mm
LCD
The screen on the 
rear of  the 
camera
Megapixels
Number of pixels 
on the sensor, in 
millions
Viewfi nder
Optical – 
shows you the 
view through the 
camera lens and is 
good for accurate 
framing;
Electronic 
– shows the view 
on an LCD in the 
viewfi nder 
DSLR
This stands for 
digital single lens 
refl ex camera
CSC
Compact system 
camera 



1 Auto
Your camera 

makes all the 
decisions for you in 
this mode

2 Scene
You select the 

type of scene, the 
camera does the 
rest

3 Program
You have 

control over 
aspects like white 
balance, fl ash or 
ISO

4 Aperture 
Priority

You control the 
aperture, but your 
camera controls all 
of the other 
settings for you

5 Shutter 
Priority

You control the 
Shutter speed, but 
your camera 
controls the other 
settings

6 Manual
You decide on 

all of the camera 
settings; the 
camera doesn’t 
choose any

Top Tip 
If you’re shooting 
with a compact 
camera that 
doesn’t have a 
mode dial on it, 
you should be 
able to locate 
your modes in 
the Menu system
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Camera types Accessories Modes

Your cameraphone can shoot, 
edit and share images instantly

Fixed lens camera are easier 
to use and cheaper

Compact system 
camera

DSLR

Compact Superzoom

DSLRs and CSCs are more expensive 
but have better image quality

Pros…
   Light and 
compact
Cool app 
add-ons 
Instantly share 

Cons…
   Small lens and 
sensor
Flattens 
perspective 
Less features

CAMERAPHONES

Pros…
   Easy to use
Light and 
versatile 
Lots of features 

Cons…
 Fewer manual 

options
Can be slow 
Less adaptable

FIXED LENS 

Pros…
   Image quality
Fast shooting 
speed
Manual and Auto
  

Cons…
   Can be expensive
Can be complex
Can be heavy to 
carry around

INTERCHANGEABLE LENS

1 Card reader: You can pick these up 
cheaply for one card, but you’ll pay 

more for multiple slots

2 Memory card: Check what type your 
camera accepts before you buy

3 Bag: Protect your camera, card and 
any accessories with a camera bag

4 Editing software: Your camera 
usually comes with its own free 

editing program on a disc in the box

5 Lens cloth; Keep your camera clean. 
You could try an old glasses cloth

6 Support: A beanbag will keep shots 
steady while you decide on a tripod

7 Batteries: Spare batteries are a 
must have

8 Connection: Check you have all the 
leads to connect your camera

01 02

03 04

05 06

01 02

0403

05

06

07 08



Modes & Settings

36 Settings explained
 Learn about the Auto mode

40 Scene modes
 Tips on the scene modes

44  Program
 Take control over settings

48  Aperture
 Aperture Priority mode

52 Shutter speed
 Use Shutter Priority

56 White Balance
 Understand the settings

Take more 
control of  
your camera 
by getting  
to know  
how it works

34

36
Learn about 
Auto mode

40
Tips on Scene 

Modes



“Once you have learnt all about 
the modes and settings, 

you will create much 
better photographs”

35

48
What is 

aperture?

52
Shutter 
speeds

56
Colour casts 

explained
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Modes & Settings

All digital cameras come equipped with an 
automatic shooting mode that’s designed to do 
all of the work for you, so you can concentrate 
on what is being shot. Auto often utilises the 
camera’s best settings in all situations, but 
these don’t always yield the best results. 

We will be showing you each of the functions 
that Auto mode carries out behind the scenes, 
how these functions will change the outcome 
of your photographs and how slight manual 
adjustments can help you get the most out of 
your camera. 

 Settings explained

36

We take you through what your camera’s settings can 
do, and how you can tweak Auto mode for better results

What the 
camera chose

This shot, taken on 
an ISO setting of 400, 
is a little grainy, but 
has retained the low-
light colours of sunset 
– making it a warm 
shot. The camera 
chose a relatively high 
ISO as there was little 
ambient light

The settings we chose
We decided to drop the ISO setting 

to 80 in order to get rid of some of the 
grain and noise. Although the image 
is still nice, it is a little darker and the 
warm colours of sunset have been lost 

The ISO is the camera’s sensitivity 
to light. The larger the ISO, the 
more sensitive the camera’s 
sensor is. If the ISO is low, the 
shots will be clear but darker. 
Images will be brighter with a high 
ISO, but will appear grainy. 

ISO settings
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The camera automatically measures 
light intensity using different parts 
of the scene, and then finds the best 
settings for the image exposure. 
Getting the exposure right for the 
end photo can often require one 
or two attempts. 

Metering

The aperture controls how 
wide the lens is open, and 
ultimately the depth of 
field. A large aperture (a 
low f-number, eg f2.8) will 
let in more light and give a 
main point of focus with a 
blurred background. 

Aperture

The settings we chose
While the camera chose to meter one 
point only, we chose to use multi-
point metering to meter the sky and 
church and achieve better exposure

The settings we chose
By using a low f-number, the main subject is in focus and the 
rest of the photo is blurred, putting emphasis on the flower

If there’s not enough light, 
the camera will fire its 
built-in flash to illuminate 
the subject at the time 
of taking the photo. The 
flash symbol may appear 
to inform the user that it’s 
going to be used.

Flash What the camera chose
Because this was a bright day 
the camera’s flash has not 
gone off. However, the sun was 
behind our subjects so their 
faces are in shadow.

“ Getting the exposure right 
for the end photo can often 
require one or two attempts”

What the camera chose
Leaving the camera on 
Automatic mode has given us a 
large depth of field. This means 
that most of the photo is in focus

The settings we chose
By turning the camera’s in-built flash on we have filled in the 
shadows on the faces, caused by the sun being behind them
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 Settings explained

What the 
camera chose
Due to the focus 
being set on the 
sky, the camera has 
metered for the 
bright sunlight. This 
means the detail of 
the foreground has 
been lost

      Technical tip
ISO changes how 

sensitive a sensor is to 
light. Higher ISOs gather 
more light and are better 
for low-light scenes.
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Modes & Settings

White balance is designed to 
ensure white objects appear white 
in the photo, and other objects are 
free of colour casting. Most digital 
cameras come with a variety of 
white balance settings, each 
tailored to shooting conditions.

White balance

What the camera chose
This automatic white balance 
has made the sky appear too bright, 
losing the detail in the clouds

The shutter speed determines how 
long the lens is open for, and 
therefore how long the picture is 
taken for. A faster shutter speed is 
useful for shooting fast-moving 
subjects (cars, sport etc) while a 
slower shutter speed is best for being 
creative with long exposures.

Shutter speed

What the camera chose
Using Auto, the camera isn’t 
aware the subject is moving, and 
therefore uses a normal shutter 
speed, making the subject blurred

38

The settings we chose
By using a different white 
balance setting, such as 
‘cloudy’ or ‘daylight’, the detail 
in the sky can be clearly seen

The settings we chose
Using a faster shutter speed 
means the subject appears 
completely still in the photo 
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Face priority autofocus

01 If you’re shooting people then opt 
for face priority or face recognition, 

which most new cameras off er. You’ll 
usually see a little square appear around 
the faces that the camera is focusing on 

– some cameras recognise multiple faces 
at any one time.

Tracking or continuous

02 If you have a moving subject 
then opt for tracking or 

continuous mode. It will lock onto the 
subject and move with it. Keep the 
active subject in focus. This will be easier 
than trying to learn how to pan to keep 
focus on a moving subject.

Single, spot and multi

03 Single or spot modes ensure that 
the centre of the image is in 

focus, while multi-area will focus on a 
number of points. Spot is generally more 
accurate. If you don’t want the subject in 
the centre of your shot, half-press the 
shutter to focus, then reframe.

Focusing 
problems 
solved

3 common…

Wrong focus point
To select the right focus 
point, aim at your 
subject, half-press the 
shutter button, 
recompose your shot, 
and release.

Moving subject
Active subjects can be 
hard to focus on. Go into 
your menu system and 
select AF Tracking or 
Subject Tracking Focus.

Low-light focusing
In low light, you might 
fi nd your focus hunts 
and cannot fi nd a 
subject. You can switch 
to Manual focus in 
these situations.

Types of focus Commonly used focus settings on your camera

Focus

39

 Settings explained

      Technical tip
Every manufacturer calls 

its focus modes by slightly 
different names, but the 
icons will usually be similar.

Blurred/Out of focus
Because we have focused 
on the person and used a 
shallow depth of field, the 
background is blurred

Sharp/In focus chose
Make sure you focus on 
the right subject to ensure 
crisp details where it is most 
important to the photo

Digital cameras have the 
ability to automatically focus 
on the subject, and many 
now come with diff erent 
focusing abilities that are 
suited to diff erent subjects 
or situations.
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M odern digital cameras, from compacts right up to 
DSLRs, are very user-friendly. With many cameras, 
there is a focus on preset camera settings which help 

users of all levels get the most out of their camera in any given 
situation. These presets are called the camera’s scene modes, and 
they are becoming more diverse with new cameras. 

Setting your camera to a new mode when out and about can be 
cumbersome, and often cause you to lose the shot. However, we 
will be showing you the advantages of taking the extra time to set 
up your camera to the correct scene mode.  

Scene modes
We take you through each of the scene 
modes you’re likely to find on your camera 
and give tips on how best to use them

Landscape mode will set 
the camera up for capturing 
large and detailed scenes. 
Using a small aperture 
(large f-number) ensures 
as much of the scene is 
in focus as possible. To 
compensate for this, a 
slower shutter speed will 
be used, meaning a tripod 
may be required to keep 
the camera steady. 

Landscape

Modes & Settings

      Technical tip
Want to get a similar 

effect with filters? Try 
using a polarising filter, 
which will darken the 
blues and greens.

Landscape scene mode
Landscape scene modes 

enhance the blues and greens

40

Automatic mode
In Auto the sky and the land 

are exposed for, but they’re a 
little bland
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Macro shooting modes will usually change 
the minimum focusing distance of your 
camera, allowing you to get up close and 
personal with your chosen subject. This 
mode will also widen the aperture (lower 
f-number), putting the main subject in 
focus while blurring the background. 

Macro

Portrait mode is great for shots 
of a single person. Much like 
macro mode, it selects a large 
aperture (low f-number) to put 
the person in focus with the 
background blurred. This draws 
all attention to the person. 

Portrait
Sport/Action mode is for taking 
photos of moving subjects. It 
increases the shutter speed, 
attempting to freeze the 
subject in place when you take 
the photo. This mode works 
great in bright light. 

Sport/Action

“Macro shooting modes 
allow you to get up close 

and personal with your 
chosen subject”

Macro scene 
mode

With a closer 
focusing distance 
we were able to 
get some great 
detail from the 
individual flower

Automatic mode
 The Automatic mode has 

prompted the flash to fire, 
resulting in an overexposed 
shot with flat skin tones

Automatic mode
On Automatic, our camera 

hasn’t recognised the fast-
moving subject so hasn’t 
upped the shutter speed

Sport scene mode
 On the sports scene 

mode, the camera uses 
a higher ISO and shutter 
speed to freeze the motion

Portrait scene mode
 This mode selected a 

longer exposure instead of 
using flash and created a 
more flattering shot

41

Scene modes

Automatic mode
Here the minimum 

focus distance is too 
far away to capture 
the detail in the flower
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Night portrait mode’s designed 
for taking shots of people in dark 
situations. It will slow down the 
shutter speed and allow more light to 
get into the camera, as well as fire the 
flash. This can give some great shots, 
but may require a tripod. 

Night portrait

When shooting bright scenes such as 
sandy beaches or snow, the camera 
will automatically underexpose, 
darkening the image and losing the 
detail of the bright areas. Placing 
your camera on beach/snow scene 
mode will brighten up the shot and 
expose the colours correctly.  

Beach/Snow

Automatic mode
 This photo shows how your flash 

on Auto can light the subject, but 
you miss the background detail

Automatic mode
Although the Auto mode 

has captured the sky well, the 
foreground and sand are a little 
on the dark side 

Night Portrait  
scene mode

 This shot, taken using 
the night portrait mode, 
shows how the dynamic 
range can be increased for 
a better photo result

Beach scene mode
 Beach and snow scene modes 

are often combined as the camera 
is dealing with a lot of bright/light 
colours, which it exposes for
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Scene modes

Normal exposure
Trying to expose for both the sky 
and the foreground has left this 
image with no detail in the sky

Underexposed
In this shot the foreground is 
too dark, but the sky is a nice 
representation of real life

Overexposed
There’s still some great detail in the 
brickwork, but the sky is completely 
blown out

Automatic mode
 By merging the photos 

together, either in camera or 
using editing software, the final 
image should turn out like this 

Panorama
Depending on your 

camera this will either help 
you line up a number of 
shots or let you sweep the 
camera across the scene.

Sunset
Sunsets are notoriously 

tricky to capture, but by 
using the dedicated scene 
modes your colours will 
be enhanced.

Museum
This mode enables you 

to capture images in low-
light settings without a 
flash and it also turns 
off all incidental beeps 
and noises.

Scene modes
3 alternative…

High dynamic range photography 
is a technique of taking a number 
of exposures which cover the 
dynamic range of the scene. This 
means you are able to capture 
both the highlights and 
lowlights of a scene, giving the 
photo a better tonal range. 
When processed, HDR photos 
can look very striking and 
bring out detail which may not 
normally be visible. 

HDR mode
Shooting 

using an HDR 
mode usually 
takes three 
exposures, one 
normal, one 
under-, and one 
overexposed

High dynamic 
range
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P rogram mode can be found on almost 
all modern cameras. It’s signified by 
a small P in either the shooting mode 

menu or on the mode dial. In this mode, your 
camera still chooses the shutter speed and 
aperture for the scene in front of it, but it 
enables you to take control of aspects like 
white balance, focus modes, ISO settings and 
flash modes. By controlling these features 
you can get more creative with your images 
and ensure that you produce better-looking 
photos than ever before.

 Program
Program mode can be 
found on compacts, 
CSCs and DSLRs – so it’s 
one feature everyone 
should get to grips with

“The higher the ISO 
number, the more 
light the camera can 
gather, which is great 
for low-light scenes”

ISO
The ISO setting refers to how 

sensitive the camera sensor is to 
light. The higher the number (eg 
ISO 800 and above), the more light 
the camera can gather, which is 
great for low-light scenes where 
you’re unable to use a flash. Your 
camera will try to opt for low 
numbers to keep the photo noise 
free (higher ISOs do suffer from 
noise or grain), but sometimes 
upping the ISO is the only answer.

Automatic mode
By letting the camera choose the ISO it has 

quickened the shutter speed and lessened the 
ISO, causing less grain but less atmosphere

Chosen mode
We wanted to create a blurred 

water effect, so upped the ISO (thus 
slowing the shutter speed), which 
caused a small amount of grain
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 Program

When left on Auto, your camera’s white balance will choose the 
setting it feels is most appropriate, like cloudy, incandescent or 
tungsten. However, the camera can’t always choose for mixed 
lighting or for situations like sunsets and sunrises, which will 
cause washed-out colours that don’t represent real life. By setting 
the right white balance you can also add ‘creative’ colour casts, 
which could add a new dimension to your shot.

White balance

Chosen mode
 We chose ‘Daylight’, which 

produced more neutral tones 
that were closer to real life

Automatic mode
 The camera has selected a 

warm white balance, probably 
due to it being quite cloudy

On most system cameras, you can select the Focus mode while 
shooting on Program. This can benefit you in a number of ways. 
Manual focus can be a great option for macro shots and those 
with poor light. Continuous autofocus or tracking focus can be 
great if you know your subject will be moving. Your camera will 
not be able to anticipate these aspects so may choose the wrong 
focus and cause you to miss the shot.

Focus

Chosen mode
You can half-press the 

shutter release to focus and 
then recompose your image

Automatic mode
Set your focus on the most 

important part: the foreground, 
subject or background

      Technical tip
If you have to up the ISO, try 

converting it post-shoot to black and 
white, as grain looks retro-cool in mono.
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Exposure Compensation is 
represented by a plus and minus 
symbol, and often has a button for 
access. Press this button to rotate 
the control wheel or use the d-pad 
to move up or down a scale. To 
correct overexposure (image too 
bright) use a negative number; to 
correct underexposure (image too 
dark) use a positive one.

Exposure 
Compensation

Chosen mode
 Most cameras offer EV 

mode, where you can add or 
take away exposure ‘stops’ to 

get the correct balance of light

Some cameras enable 
photographers to alter the 
Drive mode when in Program 
mode – this is great for action 
lovers in particular. In Single 
Shot mode the camera will fire 
just one shot, which is typical 
when on Automatic. If you select 
Continuous Drive mode instead, 
the camera will fire a rapid 
succession of shots. Self-timer is 
usually available here too.

Drive mode

Automatic mode
Your camera will automatically 

shoot single frames which can 
mean you miss the action

Chosen mode
 By switching to Burst mode 

you can take a series of photos 
and stitch them together 

afterwards for creative effect

Automatic mode
When shooting in bright 

conditions, your camera’s 
Auto mode can easily over or 
underexpose a scene
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 Program

Flash can be very useful and yet 
very underused. Depending on the 
situation you may want to turn it off 
completely, use red-eye reduction 
mode or opt for something more 
creative like rear curtain or slow 
sync. All of these terms can be very 
confusing, though, so most of us 
just leave the flash to the camera to 
manage. However, photos can be 
vastly improved by taking control of 
the flash settings. Here we’re talking 
about in-camera flash and not a flash 
that is connected to the camera via 
the hotshoe, for instance.

Flash

Flash modes
3 alternative…

Slow sync
When using Slow 
Sync, your camera 
will use both a 
flash and a longer 
shutter speed, 
which can be 

great for creative movement effects, 
like capturing a sharp photo of your 
subject and blurred background.

Rear curtain
Rear and front 
curtain refer to  
when your camera 
will fire the flash 
during the shot. 
With rear curtain it 

fires at the end of the exposure, but 
with front curtain it fires at the start of 
the capture.

Fill in
Great for backlit 
subjects, fill in 
flash refers to the 
‘filling in’ of dark 
areas. For instance, 
if you’re shooting 

inside a church against a window, the 
background will be light but faces 
may be in the dark.

 “Your photos could be vastly improved  
by taking control of the flash settings” 

Automatic mode
Although it’s a bright day, 

as we’re shooting inside 
there are a lot of shadows 
caused by harsh side lighting

Chosen mode
 By using a flash to 

‘fill in’ the light – a fill 
flash – the end result 
is much more pleasing

      Technical tip
Portraits can benefit greatly from 

fill flash, especially on days with 
harsh, bright or direct sunlight.

      Technical tip
You can alter the flash’s 

strength, or you can bounce 
it or diffuse it by putting 
some masking tape over it.
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T he idea of apertures and f-numbers are enough 
to leave many confused, but the general 
outline is that smaller f-numbers create a 

wide aperture and larger f-numbers result in a small 
aperture. But what does all this really mean? 

In brief, your aperture works like the iris of an 
eye: the wider the aperture the more light can pass 
through the lens, and vice versa when referring to a 
small aperture. F-numbers simply break this down 
and represent different opening stages as stops. 
Depending on the lens you’re using you can work with 
apertures as wide as f1.8 or as small as f32.

It’s aperture that creates the artistic blurry  
background you see in many professional shots, 
otherwise known as depth of field. A wide aperture, 
generally anything below f8, will create a shallow depth 
of field effect, making the subject you are focused on 
the main point in the frame by softly blurring out any 
background distractions. A smaller aperture (above 
f8), however, creates a larger depth of field, enabling 
you to bring more objects into focus from both the 
foreground and background. 

Follow along as we’re going to show you the benefits 
of using your camera’s Aperture Priority mode in 
order to creatively control this professional-looking 
effect. Take a look at our aperture suggestions for 
specific photographic genres and then simply set the 
f-number that you want to work with. Your camera will 
then select the right shutter speed for you, ensuring 
professional, even exposures every time.

Aperture
Take control of your 
aperture and start creating 
some stunning artistic shots 
in camera

“A wide aperture will 
create a shallow depth 
of field effect, making 
the subject you’re 
focused on the main 
point in the frame”

f2
The wide 

aperture used 
to take this shot 
creates a beautiful 
shallow depth of 
field effect with the 
focus area just on 
our model’s face

f4
The background 

remains blurred and 
the image is bright. 
The focus area has also 
begun to expand with 
more of the model’s 
body coming into focus 

      Technical tip
A low f-number such as this can also 

be referred to as a wide aperture, and 
will create a soft backgroundsubject.
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Aperture

f16
A lot more 

of the image is in 
focus now, and 
due to a smaller 
aperture the 
shutter speed has 
extended, making 
shots more prone 
to camera shake

      Technical tip
When using a wide aperture you’ll have 

less focus area, so ensure you’ve focused 
your camera on the right subject.

f22
With most 

of the image in 
focus now, you 
are able to pick up 
on details in both 
the foreground 
and background

f5.6
Noticeably 

more of the 
foreground has 
focused and is 
beginning to bring 
back details from the 
bush on the left-hand 
side of the frame

f8
The focus 

is now beginning 
to extend to the 
background, 
although this 
f-stop still has a 
great effect 

      Technical tip
Aperture is affected by how much light is let 

into the lens. It can be made bigger or smaller 
by changing the settings on your camera

      Technical tip
Bring more of the shot into 

focus by using a larger f-number
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Create picture-perfect and 
professional-looking portraits 
by using a wide aperture setting. 
The artistic shallow depth of 
field effect will draw you into 
the frame and bring focus to 
the model’s eyes and features. 
A smaller aperture, however, is 
great for shooting group shot 
portraits, as it will help to ensure 
everyone remains in focus. 

Portraits

Landscape photographs are 
best when they’re sharp and 
perfectly in focus. A small 
aperture setting is ideal for this 
genre, as it will ensure most of 
the frame is in focus from the 
foreground to the background. 
Remember to use a tripod 
where possible, as the slower 
shutter speeds when working 
with a smaller aperture will 
result in motion capture.  

Landscapes

F5.6
 The blur effect is 

distracting and restricts 
the view, making wide 
apertures unsuitable 
for landscapes 

F11
 Not unsuitable, but  

the small aperture 
makes the image  
appear more ‘snapshot’ 
than professional 

A wide aperture works well 
when photographing pet 
portraits or wildlife. The 
Aperture Priority mode will 
prevent your image from 
becoming overexposed 
by extending the shutter 
speed, which is also great for 
freezing fast-moving or fidgety 
subjects. Like a human portrait 
you should always ensure your 
subject’s eyes are in focus.

Wildlife and pets

F22
Not ideal for fast-

moving subjects 
like wildlife and 
pets – a smaller 
aperture will 
require a longer 
shutter speed

F10
This sharp landscape shot 

is well focused and enables 
you to explore the frame 
from corner to corner 

F2
 Keep the focus on your subject 

using a wide aperture and get an 
artistic shallow depth of field effect

F2.5
 The shutter speed increase has ensured a 

sharp shot, and the out-of-focus background 
brings the image focus to the pet
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You can capture beautiful macro 
shots with wide apertures. 
They’re ideal for location 
lighting, and will result in well-
exposed images. The faster 
shutter speed will freeze motion 
from the breeze or camera shake 
when shooting up close. The 
out-of-focus background also 
adds depth and makes your 
subject the focus of the frame. 

Macro

Still-life objects can be found 
all around the home and are 
really great for practising 
your photography techniques 
on. Why not have a go at 
photographing more than 
one object to best see how 
aperture control works? For 
the most artistic results you 
should use a wide aperture  
and focus your camera on  
just one of the objects within 
the composition.

Still life

Fast-paced sports don’t always 
require quick shutter speeds to 
get more artistic action-packed 
shots – just practise your 
panning technique. Use a large 
f-number for a small aperture 
in Aperture Priority mode; the 
camera will compensate for 
the exposure by slowing down 
the shutter speed, enabling 
you to capture motion blur  
and speed.  

Sports

F8
A smaller 

aperture adds 
drama but can 
make an action-
themed image 
look a little static 
and uneventful

F11
A smaller 

aperture will 
bring all of your 
subject(s) sharply 
into focus, but the 
results may not be 
as interesting 

F25
The in-focus  

background 
creates an 
unwanted 
distraction from  
our macro subject

F3.5
 A smaller  

f-number and longer 
shutter speeds are 
required for panning 
shots like this

F2.5
 Using a wide 

aperture you  
can create a great, 
artistic still-life shot 
like this one 

F3.5
 Softly blur your 

background with a 
wide aperture setting, 
making your macro 
subject the focus

      Technical tip
A small aperture setting will 

require longer shutter speeds 
so you may need a tripod to 
ensure your shots are sharp.  
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S hutter speed controls how much 
light is let through the lens. It is 
measured in seconds and fractions 

of a second, with most cameras enabling 
you to shoot as slow as 30sec and as fast 
as 1/4000sec. Depending on the speed of 
the setting, you can control how under-, 
over- or well-exposed your image is. 

As a rule you should avoid shooting at 
speeds slower than 1/60sec unless using 
a tripod, as the shutter is also responsible 
for capturing movement. Camera shake 
and motion blur have ruined many a good 
photo; however, you shouldn’t always 
overlook capturing movement in a still 
image. Depending on the genre you’re 
shooting, movement can add an element 
of energy into an otherwise static shot. 
By using the right shooting techniques 

(such as panning and light painting) and 
manipulating your shutter speed, you can 
get some great, creative results in camera. 

Freezing motion is another matter, and 
not always as easy as setting a faster speed 
– the lens you shoot with can play a big 
part. When setting your shutter speed, pay 
attention to the focal length of your lens. 
Your shutter speed should always be faster 
than the focal length. If you’re shooting 
with a 55-80mm lens then set your shutter 
speed upwards of 1/125sec to prevent any 
motion from being captured.

Take a look at our examples over the 
next few pages and switch your mode dial 
to the Shutter Priority setting. Your camera 
will determine the correct aperture for the 
exposure, so you’re free to experiment 
and explore how your shutter works. 

Shutter speed

“By using the right shooting techniques and manipulating your 
shutter speed you can get some great, creative results in camera”

Capturing a carousel See what a change in shutter speed can do

One third of a second

 This image is overexposed because 
the shutter’s open for an extended 

amount of time. Hardly any details are 
visible on the carousel due to the speed 
of the movement and slow shutter. 

One tenth of a second

 Stationary details are beginning to 
show through with only the moving 

horses remaining blurred. A tripod is 
necessary when using a shutter speed as 
slow as this.

One fi fteenth of a second

 There is not a huge amount of 
difference in this shot to the last, but 

the shapes of the horses are becoming 
more defined and the slow shutter speed 
does give the image a more creative edge.

1/15th1/10th1/3rd

Shots like this are  captured 
using slow shutter speeds

Select the Shutter Priority mode on your camera 
and take control of your creativity 

      Technical tip
Remember the higher the shutter 

speed, the wider the aperture; 
the slower the shutter speed, the 
smaller the aperture. 
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One twenty-fifth of a second

  The horses and details of colour are 
becoming more apparent at this 

shutter speed. The horses at the front of 
the carousel are beginning to get more 
shape than before. 

1/25th

One fortieth of a second

  This image is much better in terms 
of the overall exposure as the whites 

aren’t completely blown out as before. It 
still requires a tripod to shoot successfully, 
but motion blur has eased considerably.

1/40th

One sixtieth of a second

  1/60sec is ideal for shooting most 
subjects handheld, but even 

faster shutter speeds are required to 
avoid the inevitable motion blur when 
photographing fast-moving subjects.

1/60th

One eightieth of a second

 This image is a lot sharper than 
previous shots, but motion blur is still 

present up close. We will need to increase 
the shutter speed further to freeze the 
movement successfully.

1/125 second

 A great shutter speed to use on 
bright days. The exposure in this 

image is well balanced. The horses and 
sign are clear, although slight motion blur 
can still be detected around the edges.

1/160 second

  1/160sec enables you to freeze all 
the action, even when shooting 

handheld. If in Shutter Priority mode, the 
camera will set the correct aperture to 
ensure you get an evenly exposed image. 

1/160th

One second

 An extremely slow shutter 
speed to use on a bright 

day, a 1sec shutter speed will 
overexpose an image and create 
a largely blank white space. 
Motion will also be recorded as 
just light strips of colour.

1/80th

1sec1/200th

One two hundredth of a second

  At 1/200sec the carousel is frozen 
and all of the detail can be seen

1/125th
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You will ensure that your 
portraits are sharp and 
picture-perfect by avoiding 
camera shake and motion 
blur. Work in Shutter  
Priority and increase your 
shutter speed setting 
– your camera will then 
compensate for the 
exposure by opening up 
the aperture, creating a 
beautiful shallow depth of 
field effect that is perfect 
for portraiture.

Portraits

1/5sec
 Slower speeds 

will record camera 
shake. The slightest 
movement will blur 
what could have been 
a great shot

1/250sec
 Faster shutter 

speeds can create 
snapshot-style  
images that are a  
lot less interesting  
and engaging

1/20sec
 When shooting with 

a large focal length 
lens, increase your 
camera’s shutter 
speed to avoid getting 
camera shake

Slower speeds are ideal for 
landscapes, as they enable 
you to close down the 
aperture and get an evenly 
focused, much sharper shot. 
The longer the shutter is 
open, the more dramatic the 
results – perfect for capturing 
moody sunsets in low light. 
Try shooting a seascape with 
an extended shutter speed 
and see how you can capture 
water as mist. 

Landscapes

Fast-moving pets and wildlife 
can be tricky to capture without 
motion blur, but faster shutter 
speeds are ideal for getting 
great shots. Be sure to increase 
your shutter speed to freeze 
your subjects while they are on 
the go, but always remember 
that the faster the shutter 
speed the wider the aperture, 
so there will be less available 
focus area.

Wildlife  
and pets

1/400sec
 Increasing your 

shutter speed 
will open up your 
aperture, resulting 
in a professional, 
softly focused 
background

1/20sec
 Slow shutter 

speeds are perfect 
for landscapes; the 
shot will be sharp 
and in focus from 
corner to corner

1/125sec
  An increased 

shutter speed will 
freeze fast-moving 
subjects and 
ensure all your 
shots are sharp 
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When taking macro 
photographs in Shutter 
Priority mode, you should 
avoid using shutter 
speeds that are slower 
than 1/60sec handheld. 
The longer the shutter 
stays open the more likely 
it is that you will record 
movement and camera 
shake, which will prevent 
your macro shot from 
looking professional, sharp 
and in focus.

Macro

1/10sec
Slower shutter 

speeds record 
movement and aren’t 
ideal when shooting 
macro images outside 
in a breeze

Experiment with your 
camera’s shutter speed 
settings when shooting still 
life in a controlled lighting 
environment like a studio. 
Faster shutter speeds 
are great for getting a 
professional, shallow depth 
of field effect, but you can try 
slowing down your shutter 
speed and experimenting 
with the light source for some 
really creative results. 

Still life

1/125sec
This image is not 

unsuitable, but when 
working in Shutter 
Priority mode you can 
experiment and avoid 
playing it safe

Avoid making energy-
packed shots look static 
by extending your shutter 
speed to record motion. 
Panning is a great technique 
for sport, because it enables 
you to keep subjects sharp 
while the background 
blurs out. It is important 
to remember that, when 
using this technique, your 
camera’s autofocus is set 
to continuous so that it can 
keep up!

Sports

1/1250sec
 A faster shutter 

speed will freeze 
movement and 
result in detailed 
but static shots 
like this one

1/800sec
 Faster shutter 

speeds will allow you 
to take sharper shots 
that have an artistic 
shallow depth of field 
effect due to a wider 
aperture setting

1/60sec
Extended 

shutter speeds 
enable you to pan 
with your subject, 
creating exciting 
and energetic 
shots like this

25sec
A much slower 

shutter speed like 
this enables you 
to paint with light 
and get creative 
results in camera

      Technical tip
Avoid recording movement 

when shooting handheld by 
setting your shutter speed to 
1/60sec or quicker.
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B efore you make white balance 
alterations in camera it’s 
important to know how white 

balance can be affected by the light 
source you’re shooting within. 

All light has a colour temperature, 
which can range from warm orange 
and red tones (tungsten bulbs) to cool 
blue and green tones (fluorescent 
bulbs). Without the right white balance 
setting these lights will create a colour 
cast in the photo. The white areas will 
have a noticeable blue or orange tone.

To overcome this, most cameras 
have an auto white balance setting 
to compensate for the casts and 
neutralise the image so it’s a more 

accurate representation of the 
scene. However, it isn’t perfect and 
sometimes the camera will struggle 
to remove all traces of a cast. This is 
where your manual white balance 
settings become useful. Simply match 
the white balance settings to suit your 
light source. 

You can also get creative and 
apply the opposite white balance 
setting to the light source. This will 
create a controlled colour cast that 
adds an edge to your image. Most 
photographers use this in order to 
warm up an otherwise cold scene or 
to enhance a mood or feeling that the 
photograph portrays. 

White balance
Understand how white balance 
settings can affect your captures

Bad example
 The incandescent/tungsten white balance setting 

has failed to compensate for the natural light indoors 
and has created a cool blue colour cast over the image 

Compact 
system camera

Compact camera
 Compacts have 

pretty accurate 
auto white balance 
modes

 White balance 
often has to be 
changed within 
the Settings menu 
interface

Cameraphone
 Smartphones 

have plenty of 
editing app options 
to choose from and 
download

 Most don’t come 
with optional 
settings so you have 
to rely on Auto

 Offers custom 
white balance 
settings for more 
advanced users and 
most have in-built 
colour correction

 With so many 
other settings to 
adjust, a DSLR can 
be overwhelming

Good example
We selected the cloudy white balance setting as the 

subject was shot indoors using natural window light. 
This setting preserves the warmth of the natural light 

Does my camera do it? 

 “Auto white balance isn’t perfect 
– the camera can struggle to 
remove all of a cast”

 Most have a 
button on the body 
for quick access 
to white balance 
setting

 The auto white 
balance setting 
won't be as accurate 
as a pro DSLR's

DSLR

Jargon buster
Colour temperature of light

Colour temperature refers to how warm or cool 
an image appears. Lights that produce colour 
temperatures over 5,000 Kelvin create a cool 

blue cast; lower colour temperature lights 
create warmer orange casts. 
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Auto
Auto white balance allows the camera to 
determine the best setting for the shot 
based on the lighting conditions. Most 
cameras will have a reliable and accurate 
automatic white balance setting that is 
suitable for changing light conditions.

Tungsten/Incandescent
Tungsten or incandescent light 
produced by a warm light bulb can 
create an orange cast like this. By 
selecting the tungsten/incandescent 
white balance setting the camera will 
cool down the effect.

Fluorescent
Fluorescent lights that are often used in 
public places create a cooler blue-toned 
colour cast. To counteract the effect 
you should use the Fluorescent white 
balance setting so that your camera can 
compensate by warming up the scene. 

White balance modes  Learn what the different white balance settings do

What the icons mean

Daylight/Sunshine
The Daylight/Sunshine white balance 
setting is, rather unsurprisingly, perfect 
for shooting on bright and sunny days. 
This setting is relatively neutral and 
ensures your daytime scene is recorded 
without any unwanted colour casts.

Cloudy/Shade
Overcast cloudy days often appear dull 
and cool in photographs, but the Cloudy 
setting helps to warm up the scene. This 
also makes it ideal for shooting low-light 
scenes like sunrise and sunset as it brings 
out the warmth in the sky.

Flash
When you're shooting with your studio 
or on-camera flash, you can create a cool  
cast on your images. However, by 
switching your white balance 
setting over to Flash, the camera will 
compensate and warm up the shots.

Custom
Although it’s a more advanced white 
balance setting, most cameras will offer 
a custom mode that enables you to 
make specific adjustments to your white 
balance settings, whether you want to 
cancel out casts or add them in creatively.

Auto Auto is a default setting that 
enables the camera to determine the 

best white balance setting for the scene.

AWB

Tungsten/Incandescent 
Represented by a light bulb, the 

tungsten/incandescent setting is ideal for 
shooting indoors under warm bulb lighting.

Fluorescent This setting is perfect 
for shooting public places where 

Fluorescent lights are used, like cafes, 
gyms and subways.

Daylight/Sunshine The sun symbol 
represents an ideal setting for 

shooting on a summer’s day as it ensures 
you won’t capture any colour casts.

Cloudy/Shade Perfect for shooting 
on a cloudy day. This setting is also great in 
low light, when shooting sunrise or sunset.

Flash If using flash in the studio or 
working with your on-camera flash, 

use this to keep shot results warm.

Custom Ideal for removing more 
complex colour casts, you can also 

experiment with custom settings to add 
creative casts.



 This image, shot in natural 
light with the Daylight white 
balance setting, is technically 
sound but uninspired

You can apply the same technique 
to create a cooler colour cast. In this 
image the blue cast adds a creative 
edge to the photograph and also 
works with the subject matter. 
Shot in natural daylight, the white 
balance setting was switched to 
incandescent, which cancelled out 
the warming effect of the daylight 
and added a blue colour cast. 

Cooling casts
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This image was taken using the Shade 
white balance setting, which has helped 
to warm up the tones in the natural light

The blue colour 
cast adds drama to 
an otherwise simple 
shot and is also in 
keeping with the 
subject matter

Taken using the Automatic white balance 
mode, the early morning light creates a 
slight blue tone that has an uninviting feel

      Technical tip
Remember to preview your settings 

on the back LCD before you shoot to 
ensure colour casts are corrected.

The image above was shot in natural 
daylight using the Automatic white 
balance mode. Due to the time of day the 
natural light appears cooler and makes the 
cupcakes less appealing. You can switch 
your white balance to Shade to warm up the 
image and give the cakes an inviting feel. 

Warming casts



Correcting the cast
Open the image in Photoshop. 
Go to Levels (Image>
Adjustments>Levels). Zoom in 
and locate the brightest 
highlight area. Use the Set 
White Point eyedropper tool 
to select what should be the 
brightest part of the photo. 

Correcting a colour 
cast in Photoshop

Editing fix:

Bringing back the detail
You will now need to select 
the ‘set black point’ 
eyedropper tool and click on 
the darkest area of the image. 
Zoom in to ensure you select 
the right area and use the 
Preview button to check that 
the adjustments are correct.

To revive colours in this shot we switched the white balance settings to daylight, which added 
an orange glow. This was overpowering and didn’t reflect the flower. Using a Fluorescent 
white balance we added a magenta cast that highlighted the delicacy. You can also use a 
custom setting to create a more specific colour cast by selecting a high or low Kelvin number.

Custom adjustments

 This image isn’t technically 
incorrect; however, the warm 
hues can be overwhelming so 
we selected a different white 
balance setting

Finishing touches
You can now use the Set Gray 
Point eyedropper and select the 
grey areas. Alternatively you can 
use the midtone slider along the 
bottom of the histogram to 
tweak the midtones and ensure 
your image is true to life. Finally, 
save your corrected photograph.

After mastering shutter speed and aperture 
settings you will want to start exploring ISO 
and white balance. If you already change 
the white balance according to where 
you are shooting, you might now want 
to understand the custom white balance 
setting a little better. 

White balance moves from cool to warm 
and is displayed in Kelvin (K), but you need 
to know how and when to use it. Your 
camera’s custom white balance setting is 
ideal for correcting colour casts in tricky 

lighting situations or when the camera’s 
other white balance settings are not quite 
right. The Kelvin values represent the 
colour temperature of the light, with higher 
numbers refl ecting cooler light sources and 
lower numbers representing warmer lights. 
Select the right number to cancel out or 
create a colour cast, depending on where 
you are shooting. 

Check out our quick reference guide below 
to see what value Kelvin you would need for 
certain lighting situations. 

When to use custom white balance
Common problems solved…

Colour Temperature/Kelvin Light Source

1000-2000K Candlelight/Flames

2500-4000K Tungsten/Ambient

4000-5000K Fluorescent

5000-5500K Flash

5000-6500K Sunshine/Daylight

6500-8000K Slight overcast skies

9000-10000K Cloudy/Shade/Sunrise/Sunset
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White balance

The Fluorescent 
white balance setting 
adds a magenta cast 
that creates a 
more aesthetically 
pleasing image
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A good composition is key to 
any great photograph. Your 
composition should draw 

in the viewer’s gaze – it should be 
engaging yet easy on the eye. 

Composing what is essentially a 
restricted view on a real-life scene is 
not always easy, but knowing some 
of the rules can certainly simplify 
shooting. Understanding how to 
balance a composition is important, 
and knowing where to place your  
point of interest is essential to a 
successful outcome.

Over the next few pages we’re going 
to take you through some of the oldest 

composition rules that were developed 
by master painters of the past. You 
can apply the same techniques to your 
photographs while shooting in any 
genre. Learn how to shoot using some 
of the essentials as a guide, including 
the rule of thirds, lead-in lines and the 
golden spiral. We’ll also show you three 
of the best ways to improve incorrect 
compositions in Photoshop.

The following rules can be applied to 
all shooting scenarios and work with 
any camera type. Take a look at our 
inspiring image examples, follow the 
rules and start composing some great 
captures in camera for yourself.  

Composition
Learn how to compose stunning  
images in camera with our examples

Bad example
 This composition 

doesn’t work because 
there is a distraction in the 
foreground. The bad crop 
prevents you from seeing 
more of the scene and 
makes it less interesting

 “The following rules can be applied to all 
scenarios and work with any camera type”

Good example
 This image shows good use of 

space in the frame. By obeying 
the rule of thirds there is a balance 
throughout the composition and 
the lead-in line helps draw the eye 
into the image

Compact camera 
 You can crop your 

compositions in 
camera using basic 
editing features 

 No viewfinder  
and a relatively 
small LCD screen 
make it harder  
to compose

Cameraphone 
 Offers 

downloadable 
image-editing apps 
for compositional 
corrections

 Produces low-
quality images that 
won’t look as sharp 
when printed

DSLR
 Option to use 

both a viewfinder 
and LCD screen to 
compose, with an 
added grid feature 
for the rule of thirds

 Expensive, and 
you may not always 
have it on hand for 
impromptu shooting

Does my camera do it? 

Compact  
system camera
  Great-quality 
LCDs with some able 
to tilt/rotate for 
shooting at awkward 
angles

 With a smaller 
sensor than a DSLR 
model, images won’t 
be as high in quality
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1 
Top third 
You can apply the rule of thirds in 

a multitude of ways. In this image the 
point of interest rests on the top third of 
the frame in the composition. It works 
particularly well because the columns help 
draw your eye up to the point of interest.

2 
Portraits 
The rule of thirds works just as well 

when applied in portraiture. Position your 
model off-centre in either the left or right 
third of the frame. Use the background 
to lead your eye up to your subject and 
create a more interesting composition. 

3 
Balancing thirds 
The rule of thirds applies here, which 

works because the subject fills the entire 
right third of the frame before falling 
onto the left third line. The aeroplane trail 
creates an added point of interest in the 
space and balances the shot.

How to use the rule of thirds   Other ways to apply this compositional law

Use the rule of thirds to correctly line up your landscape scene and ensure you have 
a balanced composition. Try to place your main point of interest a third of the way 
up and preferably off-centre. Always remember to avoid shooting too much sky or 
foreground in a landscape.

Rule of thirds
Tips for great 
in-camera 
composition

3 of the best…

Compose fi rst
Create a paper viewfinder 
or use your hands to form 

a rectangle. Look through and pan 
around yourself for compositions.

Grid guidance
Activate the available grid 
in your camera’s viewfinder 

or back LCD screen. Use the lines as a 
guide to follow the rule of thirds. 

Correction
Press Playback and zoom into 
your composition. This will 

enable you to determine if you have the 
best possible composition.

      Technical tip
Ensure the horizon line is straight 

before you shoot to avoid making 
extra adjustments in Photoshop.
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Lead-in lines

 Lead-in lines work equally well in 
monochrome images. This shot features 
several lead-in lines to great effect 

      Technical tip
Use a wide aperture 

to softly blur out the 
background and keep 
the main point of interest 
focused in the frame.  

The softly out-
of-focus petals lead 
you towards the 
centre of the flower, 
which remains 
sharply in focus

The golden spiral composition is great when shooting 
macro images. Place the point of interest in either the top 
or bottom corners of the frame and use the shape of the 
petals or background to gradually draw your eye around 
the frame. This image works as there’s more visual space.

Golden spiral

Lead-in lines are great for navigating 
your eyes through a composition. 
You can use them to add depth to an 
image, lead up to a focus point in any 
photograph or wander through a 
landscape scene. The photograph to 
the left has been taken with an 
abstract approach, using lead-in lines 
to create a more artistic image.

Taken at an angle, the lines run 
diagonally through the image, leading 
you from the top-left-hand corner of 
the frame to the bottom right
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In photography, odd numbers such 
as threes or fives work better than 
evens when composing an image. 
Odd numbers look more natural to 
the eye, creating a balance within 
the frame. 

Rule of odds

Getting the perfect composition is often a case 
of trial and error. Consider what the best angle 
on your subject is and think about what you 
want your final result to be. You can make 
buildings look large and imposing by shooting 
from a low angle, or create a dynamic portrait 
by shooting at an angle rather than straight on. 
The way you crop your image can make all the 
difference to the success of a photo. Don’t be 
afraid to extend your lens and zoom in closer. 
The well-known pattern of the zebra here 
means you needn’t take such a literal shot of it; 
often a tighter crop can create a more 
interesting image. Play around and experiment.

Think about the angle  
and consider your crop

Grid
Open the image you want to 
correct in Photoshop. Now 
select the grid via View>Show> 
Grid. Use the vertical and 
horizontal lines to make a more 
considered composition with 
the rule of thirds as a guide.  

Ways to fix a 
composition 
in Photoshop

3 of the best…

Crop in
Select the Crop tool from the 
Tools menu and select the 
entire image. Hold the Shift key 
to maintain correct proportions 
and slowly drag up on the 
corners of the frame. Move the 
selection area until happy.

Rotate
Before confirming your crop, 
hold the cursor in the top 
corner of the frame until the 
rotate icon appears. Click and 
slowly rotate the selection 
until the horizon’s straight, 
then click OK.

Consider carefully the colours you 
frame in your composition. Too 
many conflicting colours can often 
create a distraction from your 
focus area. Complementary or 
repetitive tones create great shots.

Colour
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Try using a prop like this umbrella to add interest 
and colour to your portraits



Compact system camera
 Interchangeable lens 

options and flexible 
shooting modes

 Sensor is not as large as 
a DSLR’s so image quality is 
not quite as good 

Compact camera
 Lightweight and easy 

to use with Auto settings 
and portrait modes

 Has a fixed lens that 
is usually wide angle, 
unflattering for portraits

Cameraphone
 It’s always on hand so 

it’s perfect for impromptu 
portrait moments

 No adjustable exposure 
settings and the image 
size and quality is poor 

W hether you consider yourself 
a photographer or not, you 
will most likely have taken 

a portrait photograph at some point 
in your life. Often it would just be a 
snapshot of friends or family members 
to mark special occasions or milestones. 
But for some these photographs just 
don’t do the moment justice or bring 
out the personality of the people they’re 
shooting, and they’re often in need of 
timely retouches in Photoshop to crop in 
or remove red-eye. 

Over the next few pages we’re taking 
you back to the beginning and sharing 
some of our insider tips and techniques to 
getting perfect portrait results.

After highlighting some of the most 
common portrait mistakes, we will 
then show you how to change your 
bad shooting habits for the better with 
some inspirational images and advice on 
shooting modes and techniques along 
the way. 

It is important to remember that a 
portrait need not be as staged as 
reciting the word ‘cheese!’ before the 
flash – it should be about getting some 
relaxed and happy portrait smiles. If the 
weather is warm, why not try taking 
your portraits outside? If you get a little 
bit more creative with your camera you 
will find new ways to photograph your 
loved ones. 

Perfect your 
portraits

Over the next few pages: Portrait shooting advice for 
every photographer and every type of camera

DSLR
 It has a larger sensor so 

you get bigger and better 
quality images

 It’s harder to use for a 
beginner who’s unfamiliar 
with DSLR settings
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Learn how to improve your portraits by following 
our five essential lessons



Perfect 
portraits
5 ways to…

Follow our five top tips to 
portrait perfection
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 Go from this snapshot…
When composing your portraits, 
make sure that your model’s hair isn’t 
in her eyes. Place her off-centre in the 
frame and try using a large aperture 
(eg f2) to blur out the background

 …to this perfect portrait!
This photo, taken just a few minutes 
after the one shown above, takes in 
all of our simple rules and produces 
a much better overall result 
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2 Background 
Place your model in 

front of attractive 
surroundings. Avoid places 
where there is too much 
going on the background as 
this will be too distracting.

3 Be aware of hair
Make sure you pull 

back any unwanted hair 
from the model’s face and 
eyes so you can clearly see 
their features.

4 Careful cropping
Try to avoid cropping 

your photographs above the 
shoulders as this can make 
an otherwise great portrait 
look unbalanced.

5 Focus on 
the eyes

Ensure you focus correctly 
on the eyes and avoid 
getting in too close to your 
subject. You may cause an 
unfl attering lens distortion.

1 Don’t go low 
Avoid shooting up from a 

low angle as this can be 
unfl attering. Angle yourself 
above the model and shoot 
looking down.

Most compact cameras and newer compact system cameras 
offer advanced Automatic portrait settings. From face detection 
focusing to smile detection shutter releases, it has never been 
easier to rely on your Auto mode. Beginners can even shoot 
using Beauty modes that are designed to enhance skin tones and 
disguise blemishes. 

Some cameras even offer a background blur adjustment, which 
enables you to achieve professional-looking portraits without 
messing with aperture controls. Another benefit of shooting in Auto 
is that you don’t have to worry about exposure settings, so you can 
focus solely on correctly positioning your model and shooting. 

4. Autofocus (AF) settings
These enable the camera to search and select one 
area of the frame to focus on without you having to 
manually search for it via the focus ring on the lens.
Does your camera do it?

 DSLR Compact system camera
 Compact camera  Cameraphone

1. Portrait scene mode
Portrait scene mode settings enable you to get 
the best results by balancing the exposure to suit 
the subject. They also soften the background.
Does your camera do it?

 DSLR Compact system camera
 Compact camera  Cameraphone

2. Beauty mode
Beauty modes soften skin tones and help disguise 
blemishes. More advanced beauty modes will let 
you adjust the intensity of the eff ect as you shoot.
Does your camera do it?

 DSLR Compact system camera
 Compact camera  Cameraphone
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Use advanced 
Automatic settings
Portrait scene modes help you achieve great results

1. Setting up

Does your camera do it?
 DSLR Compact system camera
 Compact camera  Cameraphone

3. Black & White mode
In-built fi lters, like black and white, allow you to 
achieve more artistic portrait results without 
making adjustments later using editing software.

Jargon buster
Aperture

An important setting for 
portraits is Aperture. 
Turn your camera to 

Aperture Priority (A) if 
it has it, and try taking 

the same photo at 
different apertures. Low 
numbers (like f2) create 
background blur while 

higher numbers (like 
f22) keep the whole 

photo sharp.
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Shooting group  
portraits
There are plenty of fun ways to  
photograph more than one person

Family gatherings and weekends away with friends 
can be great opportunities to all get together in 
front of the camera. These images are fantastic for 
Christmas cards or the family album, so make the 
most of your time together and get some great 
fun-filled shots. 

Remember that not all family portraits need to 
be formal – try to think outside the box and look 
for creative new ways to capture your loved ones. 
Jumping shots are a great way to add energy to an 
image and are always popular, especially with the 
kids. You could also look at shooting from more 
extreme angles, whether that’s getting down low 
in the grass or standing up high to look down for a 
new perspective. Above all, just keep it relaxed and 
try to bring out each individual’s personality. 

2. Group shots

 Synchronise  
your models
Try to get your models to 
synchronise poses and get 
them looking in the same 
direction. For a shot like 
this you will probably need 
several attempts before 
getting it right.
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 Get down to  
their level
When shooting children it 
is ideal to get down low and 
shoot at their level, but it can 
sometimes work out better 
to shoot high up from an 
angle to capture their small 
size and innocence. 

Use the continuous shutter 
mode for action shots like these



 Out of focus

 Bad composition

Anything from a wonky horizon line to red-
eye can ruin your perfect portrait shots, so 
knowing what to look out for when shooting 
can help to prevent the same problem pictures 
in the future.  

One of the most common but easy-to-
correct photo mistakes is working in the 
wrong settings; whether you’re using Manual 
or Automatic modes, you must ensure your 
camera settings are correct for the best 
exposure results. 

You will also need to think carefully about 
your composition. A portrait needn’t be full 
body or just a tight head and shoulders crop, 
so move around with the camera and see how 
else you can frame up. 

Most importantly, don’t be afraid to take 
more than one photograph as this will give you 
a greater chance of getting the right shot.

Pick out common errors
Improve your portraits by identifying any oversights 

3. Avoiding mistakes

Ways to tag 
your photos

3 of the best…

Facebook:  Tag others 
by clicking on the Tag 
This Photo icon once 

the image has uploaded. 

Flickr:  Add tags to 
your Flickr uploads 
and make them 

easier to search for. 

iPhoto: Tag images in 
iPhoto using 
keywording to help 

organise them in categories.

 Hair in eyes

 Red-eye

 Incorrect white balance
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  Use colourful 
props to add 
interest
Try adding a prop 
to your portraits in 
order to add interest 
and colour. Balloons, 
beach balls and 
flowers all work well

1/250th F8

Jargon buster
Tagging photos

Many image editors 
and photo-sharing 
websites will now 

allow you to tag 
photos with names, 
locations and other 
information so that 
you can search for 

specific images later 
on with ease. Try 

Facebook’s tagging 
feature next time you 
upload your images.

 Blinking
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Editing images is part and parcel of photography 
these days, whether to make a minor correction or a 
complete clone-out of unwanted dust, marks or 
people. Software like Photoshop is great for tweaking 
images and correcting distortions, as it helps improve 
the quality of your captures. Technophobes are often 
put off  by the menus, but getting to grips with just 
the essentials can see your portraits perked up in no 
time. Follow along with these steps to see how easy it 
is to bring out the best in your portraits. 

1  Crop the photo
Select the Crop tool from 

the Tools menu. Click in one 
top corner of the frame and 
drag the cursor diagonally to 
the opposite bottom corner. 
Hold Shift on your keyboard 
to retain the image 
proportions and select one of 
the corner anchor points, 
slowly dragging it up until 
you’re happy. 

 Filling in the light
Flash is not always needed when shooting inside, 
particularly if it is a bright day and you’re near a 
large window. Use a refl ector or a large piece of 
white card to bounce light back into the image 
and fi ll in some of the stronger shadows. You 
could even increase your ISO slightly to 
compensate for lower lighting conditions. 

Master your 
Manual modes
Move away from Auto for 
more professional portraits

More advanced camera users who like 
to venture into Manual mode settings 
every now and then are off ered a lot 
more exposure fl exibility and creative 
freedom. Understanding aperture is 
fundamental to getting great portrait 
results, and a camera that off ers a 
wide aperture setting is essential for 
adding depth to an image by blurring 
out the background. 

Being able to adjust your camera’s 
ISO and white balance settings can also 
be handy when shooting portraits in 
low light or under diffi  cult lighting 
conditions. Don’t be afraid to 
experiment even if you’re not an 
accomplished manual user – this is a 
great way to pick up on using the 
exposure settings and work out 
hands-on what each setting can do.

4. Manual settings
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Essential 
editing steps
Use image-editing software to touch 
up your picture-perfect portraits

5. Editing

 After
We’ve cropped in, got rid of the  red-eye 
and any blemishes, and finished with a 
black and white conversion

 Before
There’s too much of the background 
visible, and our model has red-eye



Camera Fun Pro
This fantastic Android 
shooting app enables 

you to see live photo effects on 
your screen before you shoot. 

4 Black and white 
Convert to black and 

white by going to Image>
Adjustments>Black and white 
to desaturate your image. Now 
adjust the sliders in order to 
bring out more tonal contrast. 
Ensure you have selected the 
Preview button so that you 
can see exactly how each 
adjustment will aff ect your 
monochromatic masterpiece.

2Red-eye removal
Use the Red-eye Removal 

tool from the menu on the 
left. Adjust the pupil size 
percentage to suit the area 
you want to correct and 
increase amount to darken. 
Click above the pupil and 
drag the box diagonally, fi lling 
the space with the entire 
pupil. Click OK in order to see 
the transformation.

3   Clone Stamp 
Ideal for removing 

blemishes. Select Clone 
Stamp from Tools and zoom 
in to the aff ected area. Adjust 
brush size to match the mark 
and select a soft edge with 
the opacity set between 
85-100%. Hold down Alt and 
select a clear area next to the 
mark you wish to clone out. 
Now brush it away.

 Focus on the eyes
Always focus on the eyes. The viewer will be drawn to them fi rst, 
so they should be nice and sharp. Try using your camera’s built-in 
autofocus modes as these can be quicker and more precise than 
manual adjustments. 

 Depth of fi eld
Using a wide aperture can create artistic results. A shallow depth 
of fi eld will blur out the background and bring the focus onto the 
subject. Remember that you will need a faster shutter speed with 
a wider aperture.

1/100th F2
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Try using a 
reflector or a piece 
of white card to 
reflect light onto 
your subject

Fast Burst Camera
Great for capturing 
action portraits with 

the kids. It can take between 
5-10 shots per second.

Sharing apps
2 of the best…

Photobucket Mobile
A free app that lets 
you upload and share 

mobile pictures and videos with 
everyone in your network. 

Plixi for Android
Share photos 
on Twitter and 

Facebook. Upload from your 
gallery or the camera.

2 of the best…

Editing apps
2 of the best…

Colour Touch Eff ects
A cool colour-editing 
app, it enables you to 

selectively recolour black-and-
white or sepia images.

TouchRetouch
An editing app that’s 
great for removing 

unwanted items and marks 
from cameraphone photos.

Shooting apps
for Android
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Compact system camera
 Great image quality 

with a high resolution, 
which is fantastic for  
large prints

 Can be more 
complicated to use for 
some novices

Compact camera
 Fantastic in-camera 

creative settings; most 
offer rather good  
image quality 

 No flexible lens 
options or use of 
manual settings

Cameraphone
 Most offer great shoot 

settings such as HDR and 
photo-specific apps

 With a fixed lens and 
a low resolution, image 
quality is not always 
particularly good

L andscapes are constantly 
changing throughout the day, 
month and year, and they give 

everyone an opportunity to capture 
some great, scenic shots. Although 
landscapes are among photography’s 
most popular genres, they can often be 
a lot more challenging to shoot than they 
first appear, as various essential elements 
have to be considered beforehand to 
ensure you get great shot results. 

Simply changing the way you shoot and 
compose your captures will dramatically 
alter the appearance of your landscape 
photographs, helping you go from 
shooting basic snapshots to impressive 

vistas. Landscapes are also very 
unpredictable and can change within 
mere minutes, so you should learn how 
best to be prepared and know what you 
and your camera are capable of. 

Over these pages we’re going to show 
you how you can improve your shot 
success rate with some fantastic tips 
and advice on correctly composing your 
captures, selecting the right settings, 
shooting and editing your final shots. 

Regardless of what type of camera 
you have to hand, you are able to  
apply the same tips and techniques 
to any scene and still get impressive 
landscape results. 

 

Picture-perfect 
landscapes
Capture inspiring scenes with our lessons in 
landscape photography

Over the next few pages: Landscape shooting advice 
for every photographer and every type of camera

DSLR 
 Great image quality, 

choice of lenses and 
manual options

Usually high cost for 
body and lens combos, 
heavy to carry and can be 
complicated to use
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Picture-perfect landscapes
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Take a minute to 
frame your photo
Learn how to compose your scene 
correctly in the frame and get some 
stunning shots

Composition is a key element to getting some great 
shot results, and framing your captures correctly can 
make all the difference. Start to think more creatively 
about how you engage with the scene and find new 
angles to shoot from to get a range of perspectives. 
Look for lead-in lines or points of interest to fill the 
frame, such as rock formations, buildings or trees. 
You can even follow some compositional guidelines 
like the rule of thirds, which ensures the horizon sits 
a third of the way up the frame and creates a more 
balanced landscape shot.

1. Composition

 Shoot kneeling down for a more 
interesting foreground
Our second shot of the same scene was taken 
crouching down and brings in some foreground 
elements for interest and adds a sense of depth 
through to the back of the image. This makes the 
shot instantly more dynamic. We’ve taken the same scene standing 

up, crouching down and lying on the 
ground for three different results

Try to pick out some 
interesting foreground elements 
like flowers or rock formations

 Point-and-shoot 
gives you a dull,  
flat shot
The shot above was taken 
standing up and lacks any 
real point of interest or 
foreground to draw the 
viewer into the image. Most 
new photographers will 
shoot like this.
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Newer cameras – including compact system cameras, compacts and 
cameraphones – now offer a range of smart settings, from intelligent 
Auto to experimental and advanced manual modes. Easy-to-use Auto and 
scene modes are great for those still mastering the art of composition as 
the camera makes all of the technical exposure decisions for you. But with 
a fantastic range of in-camera effects now available you can also get more 
impressive  and expressive landscape shots  with features such as HDR 
modes and Vivid filters. 

Manual modes, on the other hand, are better suited to more advanced 
users, as they give you complete creative control over the camera’s 
settings. Don’t be afraid to experiment with your camera settings to fine 
out what suits the scene and your own style best. 

Make the most of 
camera modes
Get creative in camera and experiment 
using a range of different settings

2. Settings

 Get really low down for a 
creative and unique angle
Our final shot was taken lying down and 
gives a lot more foreground, almost blurring 
the background out of focus. Try shooting in 
portrait orientation to get another result in 
your landscape portfolio.

Landscape errors
3 of the most common…

 Wonky horizon
Always make sure 
that your horizon is 
straight – shoot using 
a tripod if you need 
to. There is nothing 
more distracting than 
a wonky horizon

 Lens flare
The camera is tilted 
towards the sun, 
which has created 
a rather ugly lens 
flare. Tilt the camera 
down to avoid this 
happening again

 Too little or too much sky/foreground
This sky is dull with no cloud interest, so why 
include so much? Compose to include more 
land instead of sky

HDR and 
creative filters
HDR and creative 
filters are available 
in most cameras and 
cameraphones. Filters 
such as Vivid are great 
for more creative 
images, while HDR 
modes capture shots 
that look true to life. 

Does your camera do it?
 DSLR

  Compact system 

camera

 Compact camera

 Cameraphone

Auto and 
scene modes
Great for mastering 
composition, Auto 
mode enables you 
to point, frame and 
shoot while the 
camera automatically 
selects the right 
settings in order to 
suit the scene.

Does your camera do it?
 DSLR

  Compact system 

camera

 Compact camera

 Cameraphone

Manual 
settings
Manual P, A, S, M 
modes are more 
complicated to use 
and are popular with 
more advanced users. 
They give you control 
over your camera’s 
settings, like shutter 
speed and aperture.

Does your camera do it?
 DSLR

  Compact system 

camera

 Compact camera

 Cameraphone
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Time, season and weather changes
Knowing when to shoot can transform your images

Your landscapes can change dramatically 
depending on the weather, season and time of 
day that you shoot. Unpredictable conditions 
can make shooting landscapes a challenge, but 
revisiting a scene throughout the day can be 
a great way to ensure you get the right shot. 
Shooting your scene after waiting for that 
dramatic cloud formation to move into the 

frame can turn your photograph from mundane 
to inspirational. Shoot in the early hours to get 
the mystical soft light effect or wait until late 
afternoon and sunset for the warmer, richer 
colours and contrast. Ensure you plan ahead and 
have done your research before setting off – you 
should be prepared and know when the sun is 
due to rise or set. 

3. Timing

Make it a masterpiece

Processing your shots in photo-editing software such 
as Adobe Photoshop is a great way to make corrections 
and enhance the quality of your landscapes. You can 
use it to straighten your horizons or improve the colour 
and contrast in your captures – it gives you complete 
creative control over the final image aesthetic. Simply 
upload your images onto your computer and begin 
getting to grips with the essential Photoshop tools. 
Your photos will go from drab to fab, and you’ll soon be 
creating finished landscapes that could pass as a pro’s. 

Use photo software to correct and 
enhance the quality of your landscapes

4. Editing

1  Crop the photo 
Select the Crop tool from 

the tools palette and click on 
the top-left-hand corner of 
the frame. Drag the cursor 
down diagonally to the 
bottom-right of the frame to 
make a whole selection. While 
holding the Shift key, slowly 
bring up one of the edges 
until you’re happy.

 Before
There’s a distracting house on the right 
and marks in the sky we need to get rid of

 Shooting on a 
winter’s evening
The cold blue sky can be 
visually appealing when 
the sun is just starting to 
set on a winter’s evening. 
The pink clouds are a 
nice contrast against 
the crisp sky here. Most 
cameras now come with 
a Snow scene mode, 
so experiment in really 
wintery conditions too.

 After 
The sky is bluer and any distractions and 
blemishes have been corrected
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4 
Boost contrast Add 
contrast to your shot 

to bring out the detail in 
the highlights and shadows. 
Use either the Brightness 
and Contrast tool or 
Shadows/Highlights (Image> 
Adjustments>Shadow/
Highlights). You can make 
more contrasted adjustments 
using the midtone slider. 

2 Straighten it
 The horizon line may be 

wonky. Before you click OK 
on your crop selection, place 
the cursor over one of the 
corners until a curved arrow 
appears. Now click down and 
rotate the frame. Try to level 
the horizon line up to the 
straight edge at the top of the 
box. When happy, select OK. 

3  Enhance colours
Enhance colours using 

the colour balance tool 
(Image>Adjustments>Color 
Balance). Using the cursors, 
slowly make adjustments to 
the colour tones, working 
through highlights, midtones 
and shadows. Select Preview 
to see how the adjustments 
affect your final image.

  A summer day
Some summery scenes can look a bit flat – 

with no detail in clear blue skies. Try summer 
sunrises, which are always beautiful and 

most modern cameras have scene modes 
dedicated to bringing out those vibrant hues.

 A stormy day
Clouds make a much more interesting sky than clear blue, so take your camera out on 
grey days too. Protect your camera in a simple carrier bag in case it starts to rain.

Improve 
your 
landscapes

5 ways to…

Instantly take better 
pictures with our top 
five things to consider

2  Composition  
Consider what you are 

leaving in the photo and what you 
want to leave out. Compose your 
scene so the most interesting 
point is around a third into the 
scene (ie a third down and a third 
from one edge) and crop out any 
distracting elements.

3  Settings  
Your camera will do a fine job 

if left on Automatic, but if you’d 
like to take a little more control, 
switch to your Landscape mode. 
This will bring out the blues and 
greens in your image.

4 Timing  
Although a well-composed 

shot will be good, the same 
scene at sunset may be better. If 
spending the day in one location, 
revisit your scene a few times to 
see which works best.

5 Editing  
A little editing can go a long 

way. While the step-by-step 
on this page will help get you 
started, check out this book’s 
Editing section starting on page 
180 to take this skill even further.

1 Inspiration  
Take a shot whenever you 

see something that excites 
you. Try taking the same shot 
standing up and lying down to 
see how perspective changes 
the end result. Experiment and 
have fun!

Picture-perfect landscapes
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Compact system 
camera 

 Can manually adjust 
shutter speed and buy 
some filters

 You need to check your 
chosen filters come in the 
right lens mount sizes

Compact camera 
 Some do offer  

scene modes for  
long exposures

 Most do not have 
mounts for an  
external filter for  
creative shots

Cameraphone 
 Plenty of apps are 

available for different slow 
shutter techniques

 No external filters are 
available and you  
cannot manually adjust 
shutter speed

W ater is a huge subject to 
photograph, and it’s one 
that can be found in many 

different contexts. When you think of 
water, it’s easy to simply focus on vast 
open stretches of rivers and coastlines. 
However, there are lots of different 
subjects and a variety of shooting 
techniques that are great for water 
photography and will see you getting 
great shots each time.  

Water is a simple commodity that’s 
available to all of us. If you’re lucky 
enough to live on the coastline or near a 
large expanse of water then you will have 
even more opportunities and techniques 
to try out. You can try visiting the water 

at different times of day to experiment 
with reflections, sunsets and different 
wildlife. Or you could try getting 
creative with your shutter speed and a 
filter to get a slow-moving misty water 
effect that always looks good. 

It doesn’t matter where you live 
– your location shouldn’t stop you 
embracing water as a subject to shoot. 
Water can overlap other subjects, 
or it could simply be a prop in your 
photographs. Try using water as a 
macro subject, experimenting with 
shooting in the rain, or simply using it 
to reflect your main subject. We’ll show 
you how to do all this and more over the 
course of our feature.

Shoot water
Make the most of your water shots and 
experiment with new techniques

Over the next few pages: We show you lots of great  
ways to use water in your photography

 Full manual controls 
are available and a range 
of filters can be used

 Expensive system and 
different-sized lenses 
will mean you need 
different filters 

DSLR
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 “Try using water as a macro subject, 
experimenting with shooting in the rain, or 
simply using it to reflect your main subject”



2sec F22

Great water shots
5 steps to…

Water photos aren’t limited to specific 
subjects and can be captured with a 
variety of photographic techniques

Get inspired 
01  Water is a vast 

subject that can 
be used in a number 
of ways, and it doesn’t 
always have to be the 
main point of focus to 
add to the scene.

Soft water 
eff ect 
02  Slowing down 

your shutter 
speed will allow you to 
capture the movement 
of the water and give it 
a soft and misty effect. 

Settings 
03You need 

to pay great 
attention to the settings 
you use when shooting 
water. This is especially 
true when using certain 
advanced techniques. 

Setting up 
04 Preparing for 

a shoot is a 
good way of ensuring 
that you get the most 
out of it. Try setting up 
your own water shot 
at home. 

Editing 
05 As with all 

shots, there are 
times when things don’t 
go as planned. You can 
always fake it, as we 
show you how to create 
misty water post-shoot!
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Go from this dull static shot...

To this dramatic soft water effect!



Jargon buster
Long exposure

Exposure refers to the 
amount of light captured 
on the sensor. A balanced 
exposure means having a 
good mix of shadows and 

highlights, while a long 
or short exposure refers 

to the amount of time for 
which the shutter was left 
open and gathering light.

Why not experiment with the diff erent 
types of water available to you?
You’ll be surprised at the scope of water photography and how 
diff erent subjects can be used in creative ways 

1. Get inspired 

If you’re thinking about shooting water, don’t be fooled into 
thinking it has to be the main subject – there are many ways 
to incorporate water into every photo. 

Macro photography is a great technique for water, 
and requires very little to get great results. Simply 
photographing the morning dew or water droplets running 
down the outside of your window panes at home will open 
up a new world for your water shots, and best of all, you 
don’t need any special kit to achieve great results. 

Water can also be used to accompany other main subjects, 
such as shooting a portrait in the rain. Try spritzing water 
on everyday items like coloured pencils to give them a new 
lease of life. You could also include water in your landscapes 
and try to capture the reflection of the main subject. 

Although water is most commonly associated with 
seascapes or waterfalls, there are plenty of ways to make 
captures of these subjects more interesting, such as by 
using long exposures. 

Ways to 
capture water

2 of the best…

Refl ections
Refl ections are a 
good way to add 

creativity to your shot. Try trees 
and sky in a perfectly still pond 
or a portrait in a puddle.

Water drops
Water drops make 
great macro shots 

and also add extra detail to 
other subjects. Look for them 
in nature or create your own.
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Learn how to create a 
misty water effect
Slow down the motion of water by using 
filters and some simple techniques
The movement of water is not something that can be 
captured easily. A normal photo will simply freeze the 
water in place. However, slowing down your shutter 
speed manually will allow you to get the effect you want. 

By slowing down your shutter speed the camera will let 
in more light and overexpose the image. It is important 
to prevent this by using a neutral density (ND) filter. 
This tinted piece of glass prevents too much light from 
entering the lens, allowing you to take a slower shot. 

You’ll need to be using a DSLR or a camera with a filter 
thread on the lens. Place your ND filter over your lens, 
and position the graduated section to blend in with your 
horizon. Bear in mind that ND filters come in a variety of 
strengths. We’re using an 8 here. 

2. Soft water effect

Incorrectly placed filter  
When an ND grad filter is fitted 
horizontally, the effect will darken one 
half of the scene. To avoid the error 
below, the filter should be placed 
vertically with the graduated section 
along the horizon.

 Capturing slow-
moving water
After using a neutral density 
filter and slowing the shutter 
speed down to around five 
seconds you can see the 
motion of the water. 
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You can get square or round 
filters that fit on your lens face

 Correctly  
placed filter
By using the filter correctly, 
the water can be slowed 
down, while the rest of the 
scene remains bright and 
colourful. Experiment by 
placing the darker section 
over sky or water.

Jargon buster
Neutral density filter

Neutral density (ND) 
filters block out a certain 

level of light from your 
lens. They come in a 
variety of strengths 

(the higher the number, 
the stronger the filter), 

allowing you to take shots 
in bright conditions or use 

different settings to get 
the effect you want.

1/5th F22



Think about the effect 
you want to apply
Changing settings will have a dramatic 
effect on the overall look of the photo

3. Settings 

For some water shots it’s as easy as choosing a scene 
mode and firing away. For example, a close-up shot of 
a water droplet requires the macro setting, and epic 
seascapes look great with the landscape scene mode. 

For a slow shutter shot there are other things that 
need to be considered. Settings such as the shutter 
speed need particular attention, and can completely 
change the final look of the photograph. To achieve 
correct exposure, your shutter speed, aperture and 
ISO all need to work together. If you’re working on 
a DSLR or CSC, choose the Shutter Priority mode (S 
on the mode dial). This enables you to choose the 
shutter speed while the camera chooses all the other 
settings. If you’re using a filter, choose your settings 
and focus before putting the filter on.

Filters for long 
exposures

3 of the best…

Cokin filter kit
This kit uses a square 
filter holder, meaning 

a number of filters can be 
stacked for different effects. 

Polaroid Variable ND
This filter has an 
adjustable density 

level. One filter can be set to 
different strengths, making it 
versatile for many situations.

Lee Big Stopper
A ten-stop ND 
filter used by 

professionals. It’s perfect for 
long exposures no matter how 
bright the conditions are. 

1   A tripod is essential. A slow shutter 
speed will keep the shutter open, so 

movement will be recorded onto the final 
shot. Keeping the camera steady is key. 

2  Select settings via Shutter Priority 
or Manual mode. Shutter speed 

depends on the water’s speed. We used a 
2sec exposure with a small aperture of f18.  

3  ISO dictates the camera’s sensitivity to 
light. Its lowest setting will make it the 

least sensitive to it, so you can use a longer 
shutter speed without overexposing.  

4  With a very dark filter, the camera 
struggles to focus on the subject. 

Focus on the subject, then go to manual 
before placing the filter on the lens. 

 This image is  
overexposed 
While it is possible to 
change the settings, the 
shot will simply come out 
overexposed like this if 
you don’t use an ND filter.
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With a fast shutter speed 
this image looks static & dull



1 Duplicate the layer 
When working on any photo, 

use a new layer, as this won’t 
damage the original. We want 
to duplicate the original 
background layer, as we’ll be 
working with the water in the 
shot. Right-click the current 
layer; select Duplicate Layer. 

Get creative with 
water at home
Capture a great water shot 
with minimal kit and without 
having to leave your home

Getting a great water photo doesn’t have to 
mean heading to the coast, or even finding a 
local river or lake. There are endless 
opportunities to get stuck in to without 
having to leave your home. 

Here we took some typical flower photos 
and improved them by spritzing them with 
water droplets. This gives the flowers a new 
look and creates more interest in the photo. 
Spritz the water lightly over the flowers, as 
the individual drops enhance the light and 
reflections in the scene. Don’t go overboard 
with the droplets! 

You don’t need a DSLR to create shots like 
these. We used a compact system camera 
but try a compact or cameraphone. Set the 
camera to Macro mode and get close enough 
to the subject to fill the frame. Rest your 
elbows on a flat surface to avoid camera 
shake. We used glycerin instead of water, as 
the thicker consistency makes it better for 
still life photography. 1/320th F7.1

5. Editing
Add a motion  
blur in Elements
Didn’t get the shot you 
wanted? Learn how to fake 
movement in the water
Sometimes it’s not always possible to get a slow-
moving water effect in your shot. It may be due to 
limited equipment, or even limited time. You may also 
want to add the effect to an old shot. 

Follow this simple tutorial, which will show you the 
basics of adding a motion blur and demonstrate what 
can be achieved with some light editing. 

4. Setting up
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All you need to create this setup 
is glycerin and an atomiser – both 
available from your local pharmacist

Jargon buster
UV filter

Most photographers will own a UV filter. 
These inexpensive pieces of kit are ultraviolet 

filters that help enhance the hues in your 
images, as well as protect your lens. After all, 
it’s much cheaper to replace a scratched UV 

filter than buy a whole new lens!

Before



If you really want to embrace water 
photography, buy a waterproof camera. While 
you can often buy waterproof cases for your 
original camera that perform very well, a 
dedicated compact that works under the waves 

is a great option to ensure your equipment 
remains protected. With this kit you can 

capture some fantastic underwater 
images. The Fujifilm FinePix XP30 
(pictured) is a great example for just  
£179.99/$239.95.

2  Motion blur filter 
In Photoshop Elements, 

and other editing programs, 
there is a preset filter for this. 
Go to Filter>Blur> Motion 
Blur. Adjust the direction of 
the motion blur to go with the 
flow of the water, as well as its 
strength to best suit the shot. 

 Using water to 
enhance images
By adding the water drops to the 
fl ower, you create extra interest 
and focal points. The water 
doesn’t have to be the main point 
of focus, but it can subtly enhance 
the overall look of the shot. 

 Creating macro 
water drops
The water drops can be placed on 
a subject, but by getting closer it 
remains the main point of focus. 
The fl ower petal provides a more 
interesting background to the 
macro water droplet.

3 Change the opacity 
Once motion blur has 

been applied, it’ll add the 
eff ect to the entire image. We 
only want it on the water. 
When removing parts of the 
new layer, the original must be 
visible. Adjust the layer’s 
opacity so you can see both.

4  Select the areas 
Remove unwanted blur 

from the new layer. Simply 
use the Lasso tool, draw 
around the unwanted areas 
and remove them with 
the eraser. If you have a 
complicated shot like this one, 
it may take some time. 

5  Remove and finish 
The Eraser tool removes 

unwanted blurred sections. 
You may have to switch 
the opacity back and forth 
to ensure all sections are 
removed. Return the Opacity 
setting to the desired amount 
and merge your layers.

Tips for macro 
water drops

3 of the best…

Spray it on
For a more natural look to your shot, 
use an atomiser to spray the water 

onto the subject then spread the water evenly. 

Shine a light
If you’re not getting the lighting you 
want in the water drops, shine a desk 

light from an angle for some great reflections. 

Focus points
If your camera allows it, set your 
focus point on the most prominent 

water droplet for a nice, sharp image. 
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      Technical tip

We used glycerin 
rather than water for a 
denser liquid feel. Test a 
small patch first as it will 
destroy your flowers.

This shot was taken on Auto!

Why not try…
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1/160th F5.6

Learn about some of the most common 
mistakes in wildlife photography

Capture great wildlife shots no matter 
what camera you shoot with
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Compact system camera 
 High image quality,  

and the ability to use 
manual settings

 Different lenses are 
required for different 
shooting situations 

 Compact camera 
 Dedicated wildlife 

shooting modes, and it’s 
easy to keep about you 

 A lack of manual 
control may mean you 
miss the ideal shot

Cameraphone 
 It’s always within easy 

reach, so it’s perfect for 
any unexpected situations

 Image quality is not 
brilliant, and you may not 
have a sufficient zoom

W ildlife is a great subject to 
photograph as it can be done 
in almost any location. Wildlife 

is essentially all around us, wherever we 
are, and is a fascinating subject that offers 
an incredible number of possibilities for 
taking images. 

Despite what many people may think, 
wildlife shots do not need to be left to 
the safari, zoo visits or other more exotic 
locations. Wildlife is all around us, often as 
close as our own back gardens, so there is 
no reason why everyone can’t take some 
great photographs.

Thanks to the incredibly wide range 
of subjects involved, wildlife shots can 

be taken using any kind of camera. It is 
also a subject that does not necessarily 
require a certain lens or specific setting to 
capture a great shot. 

No matter what animals you’re 
shooting, one thing you need to 
remember when photographing wildlife 
is to try to keep your distance. Leaving 
plenty of room between you and your 
subject will not only give you much more 
natural photos, but will also ensure that 
the wildlife is not disturbed. It is therefore 
useful to have a degree of zoom on your 
camera so you can get some closer shots; 
however, places like zoos will make this 
less of a problem. 

Capture wildlife
Learn how to take great wildlife shots by 
following these simple steps

Over the next few pages: Some great, inspirational 
wildlife shots and a tutorial to try at home

Taken on a… 

DSLR 
 The ability to use different 

lenses means it is great for 
all types of wildlife shots

 Switching lenses and 
settings takes time so you 
can lose the shot 



Bring the wildlife to you and set up a 
simple bird photograph

1. At home

03 
Switch the shutter speed 
Switch the camera over to 

Shutter Priority mode. This will allow 
you to adjust the shutter speed and let 
the camera adjust the other settings. 
Use a fast shutter speed (eg 1/1000sec) 
to freeze the subject, and avoid any risk 
of a blurred image.  

Set up a bird feeder Using a feeder will invite the birds into your shot

01 Position the bird feeder 
Place the bird feeder where 

you can see it clearly. Use this as an 
opportunity to frame your shot, as the 
feeder will determine where the birds 
will be. Avoid placing it where there 
are any distractions, as these could 
ruin the fi nal shot.  

02 Use a tripod 
Using a tripod means that you 

are able to leave the camera pointed at 
the bird feeder, allowing you to keep all 
of the settings ready for when the 
subjects come along. It will also reduce 
any risk of blurring image due to 
inevitable camera movement. 
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 Out of focus
This shot is too far away and not 
focused correctly on the subject, 
resulting in one blurred bird

Find a secluded spot in the corner 
of your garden and stay quiet!

Make sure you switch 
to autofocus first!

Your settings 
should look 
something like this!

Practise in your 
own back garden

It is not always easy to go out and take the best wildlife 
shots. Many of the great wildlife photos are of exotic 
animals in remote locations. However, this is not 
possible for the majority of us, and we have to deal with 
what is within our reach. With this in mind, we decided 
to try shooting wildlife in our back gardens. 

The most common creatures that visit our gardens 
are birds. They’re plentiful and come in all shapes, sizes 
and colours. The main problem with shooting wildlife is 
that it is often unpredictable. However, there’s nothing 
wrong with bringing the wildlife to you, stacking the 
odds in your favour of achieving an excellent shot. 

      Technical tip
Try to stay focused on 

one part of the scene, 
such as the bird feeder, 
and wait for the subject to 
come into view. 



 Fence in shot
When taking 
photos 
through a 
cage or at a 
zoo, ensure 
the focus is 
on the animal 

and that the fencing does not come into 
the shot.  

 Out of focus
Animals move 
very quickly, 
making it easy 
to get out-of-
focus shots. 
Try using 
continuous 

autofocus and high-speed continuous 
shooting to combat this.  

 Reflections
A common 
error when 
shooting 
through an 
enclosure is 
that your own 
reflection will 

turn up on the glass. Watch out for this in 
bright, sunny conditions. 

 Bad timing
Keep an 
eye on the 
composition 
of your 
shot, as well 
as animal 
movement. 

Try picking a spot and waiting for the 
animal, or pan your camera with them. 

2. Watch out
Common errors  
to look out for
Four things to avoid when 
shooting wildlife

1/800th F5.6

04 Set the ISO 
Even though you are shooting 

outside in the daytime, boost your ISO 
up to around 800. This will ensure the 
camera will get enough light and that 
the image will remain sharp, even if the 
weather takes a turn and the scene 
becomes darker. 

05 Continuous shooting 
Most cameras have a high-

speed shooting option, which enables 
a number of shots to be taken in 
succession. Taking several shots very 
quickly will give you a better chance of 
getting a good photo, and will ensure 
you don’t miss that perfect picture.  
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  Zoom into 
your subject
This shot is nice 
and close, and 
the bird has been 
isolated from 
the background 
by using a wide 
aperture (low 
f-number).

Jargon buster
High Speed Continuous

Many cameras have the ability to take a number of shots in 
quick succession without you needing to lift off of the shutter 
release. The speed at which this can be done depends on the 

camera, but is incredibly useful for moving subjects. 
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1 Straighten 
A common error is taking 

a shot that’s not straight – an 
easy mistake, as we’re often 
distracted by the animal’s 
movement. Select the 
Straighten tool and draw along 
one of the lines to automatically 
level out your photo. You will 
need to crop it afterwards.

Get great shots 
at a wildlife park
Head out to your local zoo and try 
getting some natural wildlife shots
Shooting wildlife while out in the animal’s 
habitat will give you the most natural photos. 
However, these shots will be a lot harder to 
achieve. Using a wildlife sanctuary or zoo 
is an excellent way of getting up close and 
personal with the animals. They also provide 
the opportunity to see more exotic animals that 
otherwise wouldn’t be possible.

There are some animals that are naturally 
inquisitive, and as such will be interested in you. 
They may even come to investigate you and get 
close enough for you to get some great photos. 
However, the majority of animals will be aware 
of your presence and will be on edge because of 
it. Shooting in this situation requires a different 
approach to taking set-up shots at home. 1/200th F5.6

4. Editing

Use some simple editing 
techniques to rescue a ruined 
wildlife photograph
It’s very easy to take a great shot but have something 
small ruin it. While out shooting in a wildlife park, fences 
and enclosures can make it difficult to get the shot you 
want and you may find your best shot has a fence or 
wire running through it, like our example above. 

Follow our tutorial to find out how to quickly and 
easily remove an unwanted fence from a photo.

3. Setting up

      Technical tip
Check on the feeding times 

for the different animals, as 
this is likely to be when they 
are at their most active. 

Remove a fence 
in Elements

Before

Jargon buster
Focus point

Sometimes it is not 
always best to focus 
on the middle of the 

frame, and focusing on 
a subject to the side 

of the frame will give 
the best final shot, 

while keeping the same 
composition. If your 

camera allows it, select 
the main animal’s face 

as the focus point.
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2 Crop 
It is difficult to get the 

correct composition first 
time. It is also very hard 
to get close enough to the 
subject, especially when using 
a smaller camera. Carry out a 
simple crop to cut down on 
any unwanted space, or to get 
closer to the subject. 

 With a 
superzoom
A superzoom will allow 
you to shoot through 
obstacles and from 
distances. However, 
at full zoom the 
camera will be hard to 
stabilise, so try using 
something like a fence 
to rest the camera on.1/223rd F5.9

3 Clone tool
Cloning takes a part of 

the image and duplicates it 
over a selected area. Once 
you have chosen the Clone 
Stamp tool, select a source for 
the duplication and start to 
draw over the fence. Choose 
a cloning selection similar to 
what is being replaced.

4 Healing tool 
The Healing Brush tool 

acts similarly to the Clone 
Stamp, but will do a lot of work 
for you. Once selected, use 
the brush to cover the area 
that requires further blending. 
It will then automatically blend 
the area to the rest of the 
image as best as possible. 

5 Colour curves 
Once the fence has been 

removed, boost the look of the 
photo to reduce the visibility 
of the cloned areas. Bring up 
the Colour Curves window 
and boost the brightness and 
contrast. This will improve the 
photo and detract attention 
from the cloned sections. 

Better wildlife 
photos

5 steps to…

1  Inspiration
Wildlife is not a subject that is restricted to 

safaris and zoos, so don’t be afraid to get out 
and there and see what you can find. 

2 Stay hidden
Try not to get too close to animals in the 

wild, and don’t disturb their habitat. This will 
help you get more natural photos as well as 
protect them. 

3 Patience
Animals are often very afraid of us, but 

if you remain in one position for long enough 
they will become much more comfortable with 
your presence. 

4 Be ready
Many animals are fast and don’t stick 

around waiting for you to get a good shot, so 
make sure you and your camera are prepared. 

5 Settings
Research the best settings for the chosen 

subject to avoid having to play with them too 
much when out shooting. 

 With a compact
Be aware that a compact generally has less of a zoom, so shooting through 
a fence won’t give great results. Try shooting over the top of fences or use 
editing software to combat the problem. 
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Compact system 
camera 

Dedicated lenses, high 
image quality and many 
manual shooting modes

 Dedicated macro lenses 
are usually expensive

Compact camera 
 Dedicated macro mode 

brings the focus distance 
right down

 Using the LCD to get 
focusing correct can be 
quite difficult

Cameraphone 
 Always on hand for quick 

photos, and an abundance of 
apps make editing a breeze

 Focusing distance may be 
far away, and low megapixels 
make it difficult to crop

M acro photography generally 
refers to close-up images, and 
you’d be forgiven for thinking 

it’s just for insects and flowers. These 
are certainly the main interests, as macro 
photography produces photos where the 
subject is greater than life size, enabling 
us to view details that we would not 
normally see.

However, macro photography can take 
many forms, and is not limited to specific 
subjects or styles. Almost any subject can 
be used in a macro image, and this genre 
thrives under creativity. 

True macro photography means using 
a lens capable of reproduction ratios 
greater than 1:1. However, to achieve 

this you need to use a camera with 
interchangeable lenses along with a 
dedicated macro lens. 

However, most interchangeable lens 
cameras, compacts and cameraphones 
now come with a dedicated macro 
function. This function changes many of 
the in-camera settings to allow macro 
photographs. For example, it reduces the 
focusing distance of the lens, enabling 
you to get closer to the subject while 
retaining focus. 

Macro photography is one of the great 
subjects in photography that can be 
experimented with, especially in your 
own home. Subjects are endless, and 
techniques are easy to master. 

Master macro
Improve your macro shots by  
following these essential lessons

Over the next few pages: We supply you with lots of 
inspirational macro shots and a step-by-step tutorial

DSLR 
 Dedicated macro lens 

allows for true 1:1 shots, 
giving more close-up detail

 Expensive camera and 
lens combination; the macro 
lenses can be difficult to use
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Get up close and personal with your subject to get 
your best macro shots

1/320th F7.1
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Jargon buster
Focusing distance

The focusing distance of a 
camera or lens determines 

the distance from the subject 
at which the camera is able to 

gain focus. Using a macro 
setting within your camera or 

a different lens can reduce 
this distance, allowing you to 

get close to the subject. 

0302

01

1 Shallow depth 
of field

Flowers are a favourite of macro 
photographers. A shallow depth 
of field completely isolates this 
flower from the background, 
making it stand out. 

2   Keep it simple
Macro does not have to be 

restricted to super close-up 
photographs, and simple 
subjects can be converted into 
excellent macro shots.  

3 Abstract
This abstract shot of a pair 

of binoculars shows the 
intricate detail of the water 
drops, proving that macro shots 
can be taken of anything. 

4 Flower
By getting very close to 

your subject you are able to 
show the detail that would 
otherwise be invisible in a 
normal shot. 

5 Pencils
Macro photographs can be 

taken using everyday items. 
These pencils have some great 
colour and texture and make 
excellent subjects for a simple 
macro shot.

6 Insects
Insects are a popular 

choice for macro shots, but are 
notoriously hard to capture 
correctly, as they don’t tend to 
hang around for long.

1. Inspiration

Shooting skills

Follow our five top tips to mastering macro
Take macro photos
Learn how to…
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1/125th F10

04

05

06

Things to think about  
before you start shooting
Taking macro shots can be simple, but follow these dos 
and don’ts of macro photography to get the best results 

2. Dos and don’ts

 A great   
macro image
It is in focus, and 
the subject has 
been frozen. This 
can be done using 
a faster shutter 
speed or by  
placing the camera 
on a tripod. 

 Macro 
snapshot
This shot is out of 
focus, so the subject 
is slightly blurred. 
This can be due to 
camera shake, or 
because the subject 
is moving.  

Be creative
Don’t always stick to the common 
macro subjects – be creative and 
take close-up shots of anything that 
looks interesting. 

Use Macro mode
Settings can be vastly different with 
each subject, but simply placing your 
camera on Macro mode can make a 
huge difference. 

Check your background
Check the background of your shot 
because this can heavily affect the 
outcome. If it is distracting, then try 
a shallow depth of field in order to 
blur it out completely. 

Crop your final shot
A little crop is perfectly fine, but 
cropping in heavily because you 
were too far away will lose all the 
detail in the image. 

Block the light
Your own body position can greatly 
change the outcome of the final 
shot, so consider your shadows and 
a comfortable shooting position.

Rush your shot
Subject movement is a big problem 
in macro photography. Take your 
time and consider wind direction, as 
the slightest breeze can push 
subjects out of focus. 
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Shoot your 
best macros
Getting your settings right is key to 
excellent macro photographs
Choosing the right settings for your macro shots is 
very important. This can be particularly hard to 
master, as all subjects require diff erent approaches. 

The main issue with macro images is focusing. As 
you’re so close to the subject, there is a narrow 
plane of focus. It’s therefore easy to take a shot 
that’s only slightly out of focus, but it’ll really show 
up on a computer. Using a tripod or a faster shutter 
speed will reduce the risk of any movement that 
would put the subject out of focus.  

Isolating the subject from the background works 
well. With insects and other small subjects you want 
the attention to be on a specifi c part of the image, 
so use a wide aperture (low f-number) to give the 
image this look. 

3. Settings

Macro errors
3 of the most common…

 Movement blur
Moving subjects, or simply ones subjected to wind, 
can be very difficult to photograph using macro. 
Using a faster shutter speed will combat this 

Bad composition
Think about the 
composition of the 
photo before taking it. 
We don’t want to cut 
half of the subject out 
or include anything that 
may be distracting 

Out of focus
Due to shooting so close, 
it is very easy take the 
photo slightly out of focus. 
When reviewing your 
shots, be sure to zoom in 
to the subject to ensure 
everything is crisp

      Technical tip
Create your own 

subject or develop 
more interest by 
sprinkling some water 
drops on the flowers.

If your camera is finding it hard to focus 
quick enough, try switching over to manual 
focus for more control 

Switching to Macro mode will change 
settings for you and can easily improve 
your shots

Use a fast shutter speed
Using a fast shutter speed enables you to 
freeze your subject in place. It also helps to get 
a shot that is in focus without using a tripod. 

1/320th F7.1
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Depth of fi eld refers to the distance between the 
nearest and farthest objects in a shot that are in 
focus and sharp. Therefore, the area within the 
depth of fi eld is crisp, and anything in front or 
behind this focused area will appear blurred. 
Essentially, the larger the aperture (low f-number), 
the shallower the depth of fi eld.

Using depth of fi eld in any image can create a 
great eff ect. It is sometimes desirable to have the 
entire shot in focus, and therefore have a large 
depth of fi eld. This is often seen in landscape 
shots where the entire scene is the subject. 
However, for many subjects, such as portraits and 
macro shots, it is desirable to have a shallow 
depth of fi eld. This isolates the subject from the 
rest of the photo, and draws the attention of the 
viewer to what you want. 

Depth of field explained
Use depth of field for maximum impact in your macro shots

Compacts 
for macro

Why not try…

Look for a camera with a 
focus distance of around 
1cm and a reasonable sized 
zoom. Focus distance and 
zoom are important 
factors to consider for 
macro photographers.
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Jargon buster
Bokeh

Bokeh is a Japanese 
photography term that refers 

to the blur or out-of-focus 
areas of an image. If an 

out-of-focus area is smooth 
and non-distracting, yet the 
photograph still has a some 
aesthetic quality, then it is 
said to have good bokeh.

The wider 
depth of field 
puts the entire 
scene in focus

The narrow depth 
of field gives a blurred 
background and draws 
attention to the flower

Create a 
shallow depth 
of field
Using a larger 
aperture (low 
f-number) has put 
the main subject in 
sharp focus, while 
keeping the rest of 
the image blurred 
and non-distracting.

1/1250th F4



4. Setting up

1 Set up
We used a common desk 

lamp and a thin sheet of glass 
placed over the top. We could 
place the fruit on top of the 
glass and have the light shine 
through, bringing out the 
colours and details. Be careful 
when setting up, as the hot 
lamp and sheet of glass can 
be dangerous. 

2 Fruit 
We wanted to get this 

shot with the fruit backlit. We 
sliced it up thin, so the light 
would easily pass through it. 
We covered the surface with 
fruit. Even if each individual 
slice won’t appear in your shot, 
any blank space will be subject 
to harsh light from below, 
which could ruin the shot. 

Prepare a great 
macro shot
Stay at home and create 
some interesting macro 
photos with fruit
Macro photography can be very diverse 
in its subject matter. It is often used 
while out and about due to what you 
can achieve, especially with wildlife. 
However, there is nothing stopping you 
from experimenting with everyday items 
in your own home to get your best 
macro shots yet. 

Simple items around your house can 
be very interesting and allow you to 
keep the creative juices flowing, even if 
you’re stuck inside. Common items such 
as pieces of fruit can be very interesting 
for macro shots. The range of colours 
and textures you get from them 
provides endless photo opportunities 
for close-ups, and setting them up for 
macro shots is very simple. 
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Taking a shot from a different angle will 
bring out different details

1/50th F13

      Technical tip
Carefully cut the fruit into thin slices 

using a sharp knife to ensure nice, 
clean edges. Have a spare on hand too.
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Editing tools
Crop Cropping can be 
necessary if you can’t 
get close to your 

subject. However, it can lose the 
detail and quality of an image. 

Sharpen Sharpening 
macro shots can 
fi ne-tune the focusing, 

bringing out detail and making 
your close-ups look extra crisp. 

Levels Adjusting the 
levels enables you to 
brighten diff erent 

aspects of your image, which 
can help rescue any lost detail. 

Essential 
editing

Editing is sometimes necessary 
to get the macro image you 
want. Simple adjustments can 
make a huge diff erence with 
small and intricate subjects. 

Edits can turn a good 
shot into a great one!

5. Editing

3 Camera and tripod 
We attached the camera 

to the tripod, ensuring it was 
secure, so it could hang over 
the subject. We positioned 
the tripod so the camera was 
directly over the fruit, then 
adjusted the tripod head so it 
tilted the camera down, facing 
the fruit. Ensure everything is 
tight to avoid camera shake.

Before
This shot’s 
captured the 
subject 

perfectly, but it is a little small 
within the frame

 With light By placing the light behind the fruit, we are able to 
give the photo a completely new look. The tone of the image is 
warmer, and a lot more detail can be seen through the subject. Try 
diff erent fruit for diff erent eff ects.

1/13th F6.3

4 Settings
The settings will vary 

depending on the lighting of 
the room, and the intensity of 
the light under the fruit. We 
wanted a very shallow depth 
of fi eld and focus on the top 
fruit. Using a wide aperture 
we were able to separate the 
top subject from the other 
pieces of fruit.

5 Focusing 
For close-up photos it is 

often diffi  cult to focus on the 
correct part of the subject due 
to the shallow plane of focus. 
We were shining an intense 
light through the subject and 
this confused the camera. 
Switching to manual focus can 
help fi ne-tune the focusing and 
improve the outcome. 

 After
By cropping, we were able to 
get closer to the subject 
without reducing image quality

1/200th F5.6

1/500th F2

3 of the best…

Without light This shot is of sliced limes stacked up, but 
without any extra lighting. The image shows some good detail in the 
fruit and demonstrates a more realistic colour, but it lacks as an 
interesting and impressive shot.  
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S porting events are often unique 
moments that may never happen 
again. Getting the most out of these 

photo opportunities can therefore be very 
important, and if you get tickets to future 
events, such as Olympics, Wimbledon or 
other sporting occasions, you may need 
to brush up on some of your photography 
skills in order to capture those once-in-a-
lifetime moments.

Sports photography may seem like a 
very specialist subject, and one that is 
best left to the pros. However, there are 
lots of opportunities to capture the action 
in a number of different situations, from 
big sporting events to school sports days.

The best thing about capturing sports 
or action shots is that getting great 
photos from any event doesn’t have to 

rely on having the latest and greatest bits 
of kit, and many easy techniques can be 
achieved with the simplest of cameras.

However, getting your best action 
shots can be very difficult, especially as 
you’re likely to have absolutely no control 
over your fast-moving subjects. But 
mastering simple techniques can ensure 
that you are able to capture great shots in 
a number of ways, preserving the action 
that is unfolding right in front of you as 
well as letting you take some of your best 
photographs yet.

So, regardless of whether you’re 
heading out to a high-profile international 
sports event or simply watching your 
children run about in your back garden, 
grab your camera and let us show you 
how to get the most out of the action.

Sports 
photography
Master your camera for any sports event 
and capture some stunning shots 

Beginner’s guide to

Learn how 
to freeze 
movement with 
shutter speeds

Take control 
of your camera’s 
settings for better 
sports shots
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DSLR
 Lenses for DSLRs can 

be found in a range of 
focal lengths, often 
off ering excellent image 
quality to match

 Longer zoom lenses 
can be very large and 
heavy, and are often 
very expensive 

Cameraphone
 Quick and easy to 

zoom in, and specialist 
lenses can give good 
magnifi cation

 It is all digital 
zoom, so image 
quality will decrease 
when using longer 
focal lengths

Compact camera
Many compacts and 

superzooms are now 
able to outreach most 
DSLR lenses

 You’ll notice that 
image quality can 
often deteriorate 
when using longer 
focal lengths 

Compact system 
camera

 Lots of zoom lenses 
are available, and some 
are compatible with 
DSLR lenses

 Like DSLRs, CSC 
lenses can be very 
expensive and too large 
to carry around all day 

Over the next few pages: We show you how to 
capture all the action with some great tips and techniques 
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 “Whether you’re shooting a 
Sunday morning football league or 
pro-athletes at the Olympics, these 
tips will help you get started”



1. Focal lengths

Whether you are using a DSLR, a simple compact camera, or 
even your smartphone, chances are you’ll be able to zoom in 
on the action. For sports photography, this can be very useful. 

Capturing what is going on sometimes means getting in 
close. Zoom in fully (the telephoto end of the zoom) to shoot 
close-up details or action that’s happening far away from 
where you are positioned.   

However, although a long and powerful zoom on your 
camera can ensure you can get up close wherever you’re 
shooting from, capturing the wide-angle shots by not 
zooming in can often be a great way of putting the action into 
context with the entire event. 

Use your zoom to 
capture the action
Learn how to set your focal lengths of  
your camera to get the best results

Wide angle

Mid-length

Telephoto

Shooting skills
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Whether it’s 
with a zoom or 
by utilising your 
particular position, 
to shoot those 
dynamic images 
it’s absolutely 
essential that you 
get in close to  
the action

Jargon buster
Scene Modes

The scene modes of 
your camera are ready- 
made shooting modes 

that are designed 
for specific shooting 
situations. Setting a 

scene mode will tell the 
camera exactly what 

you are going to be 
photographing, leaving 
it to decide on the best 

possible settings for 
your subject. 

The zoom on a compact camera will 
usually be a lever on top of the camera. 
Use two fingers to zoom in if you’re 
shooting with an iPhone



Prepare any camera for 
shooting movement
Master the settings on your camera to help 
it keep up with your subject’s activity
Capturing dynamic sports photos, freezing the 
action, and portraying the event doesn’t have to 
rely on expensive equipment and professional 
techniques. Mastering the settings on your camera, 
and using them effectively will ensure you get the 
best shots every time. 

Most cameras come with a host of dedicated 
settings that are ideal for getting great action shots. 
A common scene mode within any camera is the 
sports setting, which speeds everything up to keep 
up with your subjects. 
Team this up with 
continuous autofocus 
and a high-speed burst 
mode and you’ll be able 
to freeze your subjects 
with ease. 

2. Sports settings
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Shooting from 
different angles 
can give a new 
perspective on an 
otherwise dull shot 

A monopod is ideal for 
sports photography as it’s 
more mobile than a tripod 

 Bad example
If you have manual controls 
on your camera, increase 
the shutter speed to avoid 
blurred shots like this

 Good example
Using the perfect shutter 
speed can keep the subject 
in focus while maintaining 
the sensation of movement

      Technical tip
Using burst mode may see your 

memory card struggle, so try reducing 
your picture size so it can handle the load.

Many cameras have a ‘burst 
mode’ which takes several 
shots in quick succession, 
ideal for freezing 
action. Look for an 
icon like this...

If you’re shooting on a 
compact camera, for best 
results look out for this 
icon which indicates 
‘Sports mode’



Bad example
 Although the background 

has some great movement, 
the subject is too blurry due to 
unwanted camera shake, which 
unfortunately ruins an otherwise 
great photo opportunity

4. Master panning

There are two different ways to deal with motion in 
sports: one is to freeze it, portraying an exact moment in 
time, while the other is to keep a bit of that movement in 
your shot through motion blur. Simply freezing the action 
in the shot is not always enough to display the effort and 
sense of competition, and blurring the movement and 
presenting a sense of speed in your shots is an excellent 
technique for sports photography. Making use of the 
methods for freezing and blurring we show you over 
these pages can be all that’s needed to turn basic images 
into sports shots to be proud of.  

Take control of 
advanced settings 
for better shots
Capture sports using different techniques 
for more dynamic action shots

3. Freeze and blur action

1 Shutter speed 
You’ll need to use a fast 

shutter speed to keep the 
subject sharp, but you’ll also 
need to keep it slow enough 
to allow for time to pan. 
Start with a speed of around 
1/50sec and experiment 
depending on your subject.

Convey some motion
Move with your subject to give a sense of 
movement while keeping them sharp
Panning is a great way of portraying the action in your shots.  
It allows you to keep the main subject perfectly in focus and 
well exposed, while the background is washed away in a 
blur of motion. 

Panning is a simple technique that relies on you mastering 
your own movement. You’ll need a steady hand, or a 
monopod, and it may take a little bit of practice to get the 
technique right, but the results are worth it. Follow our 
tutorial and begin panning with perfection. 

1/125sec F7.1   

Shooting skills
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 Good 
example
Using the correct 
technique will 
keep the subject 
in focus, with 
the background 
having lots of 
movement blur

 Good 
example 
By using a fast 
shutter speed the 
subject has been 
frozen perfectly in 
place, stopping the 
action at just the 
right moment 

To freeze motion, 
you’ll need to set 
your camera to 
Shutter Priority and 
use a fast speed 
such as 1/125

Be aware of other spectators at 
an event – shoot through the gaps so 
they don’t spoil your shots

Freeze motion



 Bad example
In this shot the white of the subject has 
a colour cast, and the shot is too dark 

Set a high ISO to compensate for the 
lack of a flash for indoor shots 

If you don’t set the correct White 
Balance you’ll end up with a colour cast 
like the one below

3 Continuous burst 
Although you will be 

panning with your subject, 
you will be taking more than 
one shot as they move across 
the frame. Using a continuous 
burst mode will allow you 
to take several shots as your 
subject flies past. 

2 AF mode 
To keep the subject in 

focus while you are moving 
the camera, it is important to 
use a continuous auto-focus 
mode. If your camera has it, 
turn on focus tracking, which 
will track your subject as it 
moves across the frame.

4 Stabilisation
To get the best results 

when panning you may need 
to find a way of keeping your 
camera still. Using a monopod 
will allow you to move your 
body and camera along with 
the subject, tracking them as 
they move past. 

5 Action
Once you’re ready, keep 

an eye on your subject as they 
enter the frame. As you begin 
to take your shots, gently 
sweep the camera along with 
the subject, being sure to 
keep a steady pace with them 
as they go past.

1/40sec F11
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 Good 
example
By using the right 
shutter speed, the 
movement of the 
scene has been 
captured while 
the main subject is 
frozen in place

Blur motion

In order to blur motion, 
you’ll need to slow the 
shutter speed down to about 
1/40sec but you’ll need to 
hold the camera very still or 
use a tripod

 Bad example
Although there is movement 
in this shot, you can see there 
is a lot of unwanted blur in the 
main subject 

Sports photography
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5. Editing

Getting the right look of motion in your 
images can be a difficult technique 
to master. Fast-moving subjects 
are difficult to capture, and being 
prepared for the opportune moment 
can prove to be quite tricky. 

You can easily give your action shots 
the panning effect. Simple editing 
techniques can be used to apply 
motion blur to the background of your 
shot, allowing you to instil a sense of 
movement in the image.

Fake a motion blur in 
Photoshop Elements
Follow these simple steps to create 
a sense of movement in your shot

 “Teaching yourself 
to keep an eye on 
the action through 
the camera will save 
precious seconds”

1 Duplicate the layer 
Duplicate your layer to 

apply effects and edit the shot 
without affecting the original. 
This gives a simpler way of 
applying motion blur too. Right 
click the background layer and 
select Duplicate Layer. 

2 Motion Blur 
Go Filter>Blur>Motion 

Blur. Choose the intensity of 
the blur, and change the 
direction. Align the motion 
with the subject’s direction of 
travel and choose a distance 
to match the subject’s speed. 

3 Quick Selection 
The main subject must 

be perfectly sharp. Reduce 
opacity on the top layer and 
use the Quick Selection tool 
to draw around the subject. A 
dotted line will appear around 
the edge to show the area 
selected. 

4 Erase and finish With 
the subject selected, 

simply delete the selected 
area. This will remove the 
subject from the motion blur 
layer, putting it back in sharp 
focus. Merging the two layers 
together will give you your 
finished motion-blur shot. 

To get a sharp motion shot 
like this, you’ll need to use a 
fast shutter speed

From this…

…to this!
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1 Shutter speed 
Think about the effect you want. 

A slow shutter speed will help to 
create a sense of movement with blur, 
whereas a fast shutter speed will give 
a pin-sharp, crisp shot. 

2 Depth of field
 Assess whether the background 

will be a distraction. Use a large 
aperture of f5.6 or less to blur out  
the background, or to keep it sharp 
use a narrow aperture setting of 
around f22.

3 Research your subject
It is a very good idea to research 

and understand the sports which  
you photograph, so that you can 
predict when the action is about to 
take place.

4 Plan your photo shoots
Prepare in advance. Grab a 

notepad and plan the photos you 
want to take. Think about angles and 
check the weather!

5 Move with  
the subject 

Don’t be afraid to follow the action. 
When photographing surfers, for 
instance, they zip quickly across the 
beach, so move with them or else 
you’ll miss the shot.

6 Autofocus vs  
manual focus

Autofocus can be great, but often 
you’ll need to set your focus manually 
on one point, then take the shot when 
the subject enters this ‘focus zone’.

7 Watch the action through 
the camera itself

Teaching yourself to keep an eye on 
the action through your camera and 
instinctively hitting the shutter at the 
right time will save precious seconds.

8 Be patient 
Sports photography requires a 

lot of patience. You’ll often find that 
you’re hanging around waiting for a 
long time. Just try to be patient and 
use the time to learn more about the 
sport which you’re shooting.

9 Go prepared 
Sometimes when photographing 

sports, it can be an all-day event. 
Take some food, drink and suitable 
clothing.

10 Tripods are optional 
You will need a tripod for 

a large (and heavy) lens, however, 
smaller lenses are no bad thing 
because they allow you to get up 
close as well as move freely with  
the action. 

6. Top 10 tips

Sports photography covers a huge area, with lots of techniques to capture a 
wide range of subjects. A lot of these principles can be applied to most action 
shots, but getting the best out of each opportunity takes time and patience.

We spoke to professional sports photographer Jordan Weeks to get his top 
ten tips on how to get your best action photos. He explains it is as much your 
ability to control your camera as it is to consider your subject in order to capture 
stunning shots. For more of Jordan’s images, head to www.jordanweeks.com.

Follow these tricks for 
better action photos
Professional photographer Jordan Weeks shares  
his advice for great sports shots

Surfers tend to move from 
one end of the beach to another 
– be prepared to move with them 
otherwise you’ll miss the shot!

Get down low and shoot up to 
create interesting shots like this one
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You’ll need a tripod if 
you’re using manual modes!
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Low-light shooting

Over the next few pages: We give you some great tips 
on how to deal with low light in any situation 

Low-light photography can be 
applied to a broad range of 
subjects, and deserves a good deal 

of attention. It can encompass anything 
from sunrise and night time landscapes, 
all the way through to indoor group 
photos and simple snaps at home. It is 
therefore something that photographers 
of all abilities will come across, and 
something that most of us will have 
struggled with. 

Photography in general very much 
depends on the available light, as it is 
the light that completely alters the way a 
shot will look. There are always specific 
times of day for the optimum shot in 

Low-light 
shooting

natural light. However, much of the time 
we cannot control what time we shoot at, 
and there will always be situations when 
we’re taking photos indoors.

It is particularly difficult to capture a 
great shot in much darker conditions. 
Even if you are using the most 
advanced cameras and the different 
lighting systems available, taking your 
best photographs in low light can be 
somewhat of a challenge.  

However, taking control of your 
camera, altering the settings accordingly 
and making use of what light there 
is available will help you to get some 
excellent photos in difficult conditions.

Learn how to take your best low-light 
shots with our simple guide

Cameraphone 
 By using an app with 

different scene modes we 
were able to get very  
good colours

 The detail in the brighter 
areas has been blown out, 
losing some of the detail 

Compact camera 
 Varying scene modes 

allowed us to interchange 
and experiment

 We couldn’t take 
control of the shutter 
speed, so the colours 
weren’t as rich

Compact system camera 
 Using a longer shutter 

speed meant we could 
capture the intense colours

 Limited filters; a 
graduated filter would  
have given far more 
foreground detail 

DSLR 
 A long shutter speed 

coupled with a graduated 
filter allowed for rich 
colours here

 Few dedicated scene 
modes meant it was difficult 
to quickly get a good shot 
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Better low-light 
shots

5 steps to…

Use these tips to make better 
use of low-light situations

Go from this 
underexposed shot...

112
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Jargon buster
ISO

The ISO setting determines the camera’s 
sensitivity to light. A higher ISO value (eg 
1600) will enable the camera to produce 

a brighter image in darker conditions. 
This can, however, give the shot a grainy 

and unpleasant texture.

...To this candle-lit portrait!
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01 Get inspired
Low light can be 

a hindrance to some 
shots, but it inspires a 
whole photography 
subject at the same time. 
There are plenty of 
opportunities to get 
creative with whatever 
light is available. 

02 Sunrise & 
sunset

Dawn and dusk are 
popular times at which to 
shoot. Sunrises and 
sunsets are two of the 
most common types of 
low-light photographs, 
but can present a variety 
of problems. 

03 Settings
A large number 

of problems that occur 
when shooting in low 
light can be overcome 
with better use of 
different settings. Take 
control of your camera 
and get the most out of 
low-light situations.   

04 Interiors
Low-light 

interior images are also 
very common, and they 
can pose many problems. 
However, there are some 
easy tips that you can 
follow that will help with 
any shot. 

05 Editing
For those times 

when your shot didn’t 
quite come out how you 
had hoped, we’re sharing 
some quick fixes for 
common errors that 
occur when shooting in 
low light. 

Evenings, night times, and even 
indoor events can put us off taking our 
cameras out. They are notoriously hard 
to capture, and often leave us with a 
host of blurry and unpleasant photos. 
However, there is no reason why you 
can’t take control of your camera to get 
the shot you want, as well as use the 
darker surroundings to your advantage. 

There are plenty of quick fixes for low 
light, most notably automatic scene 
modes. You can also take full control of 
your camera and discover creative ways 
to shoot in low light, as well as ways to 
deal with the tricky conditions to get 
the shot you want. 

Don’t neglect the evenings, late 
nights, or even indoor functions. By 
stretching your camera’s capabilities, 
as well as using the light available to 
you, there are endless possibilities for 
stunning shots.

1. Get inspired
Learn how to get creative with 
your low-light photography
You may think there is nothing to photograph in low light, but 
there are many subjects and creative options to get involved with

Mistakes for 
indoor shots

3 of the most common…

Always using flash
When shooting in low light, it’s 
easy to switch on the flash to 
light up the scene. However, 
this can create harsh shadows. 

Focusing problems
A camera can struggle to focus 
in low light. Ensure the focus is 
set correctly, so it exposes for 
the correct part of the photo. 

Auto ISO
Leaving your camera on auto 
ISO can mean it’s overused, 
producing bright but grainy 
images. Use in moderation. 

1/50
sec

F5.6
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2. Sunrise & sunset
Learn how to 
capture a 
stunning sky
Sunrises and sunsets can be 
hard to capture, but getting 
them right is very rewarding
Many factors can affect the type of 
sunrise or sunset you capture, but 
location, weather conditions and time are 
the biggest problems to overcome.

Sunsets are accessible, especially 
around winter. Earlier evenings mean 
you’re more likely to be outside at the 
right time. Sunrises can be difficult to 
capture, as they may clash with your lie-
in, but it’s worth getting up early to take 
advantage of the great morning light. 

Landscape errors
3 of the most common…

Wonky horizon
The wonky horizon can detract from the 
image. Make sure you use a tripod or spirit 
level to ensure your landscape shots are 
straight.

Too much foreground
This shot has too much 
foreground, resulting 
in dead space with no 
real focal point.

Overexposed
Focusing on the 
foreground in Auto 
mode will often result 
in an overexposed sky.

You’ll need a long exposure (around 
5sec) to capture enough light

  Using 
lead-in lines
Some foreground 
interest and a lead-in 
line guides the eyes 
through the scene and 
onto the sunrise.

Capture sunset on a compact Utilise the built-in scene modes for a great shot

Tripod
01 Even using a compact camera 

can require a tripod. They are 
essential bits of kit for landscape and low-
light shots. Smaller tripods are ideal for 
compacts as they are easy to transport.

Shooting mode
02 It is tempting to leave a compact 

camera on Auto. However, due 
to the many colours of the sky and the 
fast-changing light, this is often not 
suitable for sunrises and sunsets.

Scene selection
03 Most compacts come with scene 

modes. Many have dedicated 
shooting modes for sunrises and sunsets, 
but a night time or even landscape scene 
mode will improve your shot.

Shooting skills
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Low-light shooting

 Technical tip
Set a low ISO and use a 

high f-number to ensure 
very little noise with 
everything in focus. This 
requires a tripod.

1/320
sec

F11

Taking the shot
04 Make sure you have set 

up your tripod securely 
for a straight shot. Test out different 
angles and play with the scene modes 
to get the best out of the situation.

Some smartphones, such as this 
Nokia N8, now include scene modes

Most newer cameras, including the more 
advanced compact system cameras, 
now come with built-in automatic scene 
modes. These are designed to suit any 
situation and provide the best settings for 
the shot. These are excellent if you simply 
want to focus on the subject and fine-
tune your composition. 

However, if you would like to take more 
control of how your shot comes out, you 

3. Settings
Use the best settings to 
achieve the best results
Make sure you know which camera settings to use and 
when to use them

will need to shy away from the 
automatic modes and get to grips with 
manual shooting. It is worth noting, 
though, that various settings will require 
other considerations. 

A shot like the one below will require 
a slower shutter speed and a high 
f-number, which will keep everything in 
focus, but it will also require you to use a 
tripod to keep the image sharp.

Does your camera do it?
 DSLR

 Compact system camera

 Compact camera

 Cameraphone

Does your camera do it?
 DSLR

 Compact system camera

 Compact camera

 Cameraphone

Does your camera do it?
 DSLR

 Compact system camera

 Compact camera

 Cameraphone

Automatic
settings 
Creative art fi lters and full 
auto modes can produce 
perfectly good shots. 
However, the camera will 
not know what subject you 
are photographing, so it 
will be unable to optimise 
the settings.

Sunset 
scene modes 
An automatic scene mode 
tells the camera to apply 
the ideal settings for the 
scene. With a sunrise or 
sunset it boosts the 
saturation, making 
the sky more colourful 
and striking. 

Manual 
settings 
Manual modes are more 
diffi  cult to use and only 
come on advanced 
cameras. They give you 
more control over how the 
shot turns out, so you can 
bring out the detail where 
you want it. 

  Using a focal point
By using a main focal point, 
reflections of the water and a 
correctly exposed sky we have 
created a great sunrise shot
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Although there are many ways to deal with low-light 
situations, there are always times when your shot 
doesn’t come out how you wanted it and you can’t 
retake it. Shooting in RAW format will allow you to 
rescue your images quite easily; however, there are 
lots of quick and easy ways to bring an image back to 
life in Photoshop Elements.

5. Editing
Quick fixes for 
low-light problems
If your photo doesn’t turn out how you’d 
like, these tips will help rescue your shot

Before

Shadows and Highlights
01 This shot has come out too dark, 

with darker areas accentuated 
by the brighter candles. Shadows and 
Highlights will boost the lighting in the 
shadows, while reducing the intensity 
of the brighter candles. Don’t boost too 
much, though. 

4. Interiors
Master 
low-light 
interior shots
Capture some great 
interior shots, even in 
difficult conditions

Interiors of buildings are notoriously 
difficult to photograph well for a 
number of reasons. They are usually 
badly lit and have lots of dark areas, 
while the lighting that is there is 
artificial, making it very hard to 
expose correctly. 

Some simple settings changes 
on your camera can make a huge 
difference to the final shot. Boosting 
your ISO and adjusting the white 
balance to the correct setting will 
help you to capture the shot, as will 
using a wide aperture and a slower 
shutter speed. 

Using your flash correctly can be a 
quick fix when shooting interiors, but 
in some situations it will simply light 
up the foreground subject, and is 
therefore not always ideal. 

Shooting skills

1/20
sec

F5

Jargon buster
White balance 

Each digital camera will have a variety of 
white balance settings, all designed for 

different shooting conditions. The correct 
white balance will adjust how the camera 
sees the whites in the scene and then it’ll 

change the colours of the scene accordingly.
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Low-light shooting

Brightness and Contrast
02 Now open up Brightness and 

Contrast to further adjust the 
look of the photo. This enables you 
to raise the lighting of the image as a 
whole. Using the contrast will also help 
to restore any darker detail lost through 
raising the light levels. 

Noise reduction
03 Once happy with the look, open 

up the noise reduction feature. 
A low-light shot will contain lots of grainy 
noise, which will become more visible as 
you brighten it. Using noise reduction will 
help remove some of the grain and bring 
back the detail of the photo. 

Crop
04 Cropping is simple but very 

useful, especially for low-light 
shots. This image contains a large amount 
of dark space, which surrounds the main 
subjects. By cropping out this unwanted 
darkness, the image looks brighter and 
the composition is stronger.

1  Open Flickr
 Open the Flickr app 

on your iPhone and make 
sure you’re logged in. Tap 
the top-right-hand button 
to upload.

2  Take photo
If you’ve yet to take 

your shot, hit ‘Take photo 
or video’ and snap away. 
Otherwise select  ‘Upload 
from library’.

3  Add details
The Flickr app allows 

you to add information 
such as a title and 
description. When ready, 
hit ‘Upload’.

4  Upload
It should only take 

a few seconds to upload 
your photograph, but 
it will depend on your 
internet connection.

Upload shots to Flickr 
from your iPhone

  Use your fl ash 
to avoid blur
Flash is very helpful for indoor 
shots as it will reduce noise and 
blur, but be careful as it can 
bleach out areas of your image. 
If you wish to shoot without it 
you can slow the shutter speed 
or boost the ISO.

  Candlelit portraits
This is a prime example of a low-light situation, but one that would 
be ruined with a flash. Try to adjust your settings to keep the subject 
bright, but the flames correctly exposed.

No flash means this image 
is noisy and slightly blurred
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Shooting skills

Cameraphone 
There are plenty of apps 

to play with to enhance the 
character of the building

The lens isn’t as wide-angle 
as some camera lenses, so 
composition is limited

Compact camera 
Pocketable and 

portable for outdoor, 
architectural shooting

Low light architectural 
shots can suffer from 
noise with smaller sensors

Compact system camera 
Some have flexible 

LCD screens for capturing 
dramatic angles

 Lack of optical viewfinder 
so you will have to rely on  
the screen

DSLR 
A range of manual 

modes, lenses and filters 
available

 Different lenses mean 
different sized filters, 
which can be expensive

A rchitecture is a broad subject, 
spanning castles and grand 
estates, to office blocks and 

churches. It is so easily accessible that it’s 
unsurprisingly one of the most popular 
genres of photography. Like any subject, 
however, there are some rather helpful 
techniques that apply to any type of 
building in order to make your shots all the 
more impressive.

The fact that the subject is stationary 
is an advantage, but being at the mercy 
of changing light and weather conditions 
can confuse matters. Try heading out with 
your camera early in the morning when 
places tend to be less busy and when 
the lighting is at its best. Architectural 

photography isn’t just about the surface 
details so venture inside and practise 
capturing images indoors. This might 
mean switching the flash off if you are 
inside a church or cathedral, and you 
might need to consider taking a tripod 
with you. 

Lighting is the key to all good 
photography; it sets the mood and brings 
inanimate objects to life. There really is 
no time frame for shooting architecture, 
because you’ll find that buildings come 
alive after dark with neon signs and street 
lamps. This feature will help you get to 
grips with this rewarding genre that’s 
accessible to everyone, no matter where 
they live.

Shoot 
architecture 
Develop an eye for architecture, making everyday 
buildings look extraordinary

Over the next few pages: Get inspired and learn all about 
composition, settings, cityscapes and editing your images



1/320th F7.1

Shoot architecture
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Shooting skills

Improve 
your 
architecture 
shots

5 ways to…

The best settings and 
compositions that 
will capture amazing 
architectural shots

2 Composition 
Lie on the floor or climb 

up high to capture exciting 
angles. Zoom in really close 
and pick out interesting details 
or patterns for some striking 
abstract images.

3 Settings 
Practise using your 

camera’s manual modes on the 
local area, or even your own 
house, before venturing out to 
your chosen location.

4 Architecture in 
the city 

Cities are packed full of visually 
interesting buildings, both old 
and new. Modern architecture 
makes for fantastic close-ups, so 
get out there and check it out.

5 Editing 
Make buildings appear 

miniature by using a tilt-shift lens, 
or fake this popular effect for free 
using editing software; we show 
you what to do post-shoot.

1 Get inspired 
All buildings are different, 

so inject some personality into 
each one by using different 
techniques. Think about shots 
creatively – you don’t even 
need to have the building as 
the main focus.

01

02

Don’t limit yourself 
to buildings; bridges 
and gates count, too. 
Come back at sunset 
for dramatic shadows

Scout out the 
building to find 
out what its most 
interesting features 
are, and try to 
capture these
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Fantastic architecture is all 
around us – learn to see it
Take a closer look at the buildings around you 
for photographs with personality

1. Inspiration

 Over exposed
This shot is blown out (over 
exposed), and a faster 
shutter speed and a higher 
f-number is needed here.

Next time you notice a building that captures your eye, really examine 
it for what makes it special. Is it the way the light is falling across it, 
illuminating the colours of the brick and adding texture to the nooks and 
crannies? Do the windows create patterns, or are there curious details like 
gargoyles that leap off the building’s façade? 

Find out what you admire about the structure, and compose your shot 
in order to highlight it. This might mean zooming in close to a specific 
detail, or pulling right back to include the surrounding area. Remember 
that architecture photography is not just about buildings. Nearby water 
can create beautiful reflections, and winding paths will help to guide the 
viewer’s eyes to the main point of interest. Try visiting the location at 
different times of the day, especially at sunset where the shadows are long 
and artificial lights play with the appearance of the architecture. 

03

04

05

 Get the  
right exposure
With the right settings, 
the exposure is 
balanced. Here we’ve 
used a high f number to 
keep every part of the 
image in focus.

Shoot architecture



Learn how to 
compose your  
shots effectively
Add drama to your images by playing  
with angles and distances
Take one interesting-looking construction and try capturing it 
from at least five different angles. This will help you to realise 
the different effects you can create, and you’ll find the images 
have more impact as a result.

When you peer up at a tall structure, you’ll notice that 
the vertical walls start to meet each other. This is a natural 
distortion and it’s not something to fear. Towers, for example, 
look imposing and strong when captured this way, creating 
drama in your shot. However, if you’d rather avoid this, try 
taking the photo from a distance. You can use the camera’s 
zoom to bring the building closer, or you could crop post-shoot. 

2. Composition

Architecture errors

 Over exposed
This shot is over-exposed and 
needs a smaller aperture to let less 
light through. Try f5.6 or higher.

  Horizon
Try and get the 
horizon line 
straight in-
camera because 
you lose detail 
when correcting 
in Photoshop.

 Framing
Think about your subject’s 
position within the frame. This 
picture feels off-balance.

Shooting skills
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Add context to your shot by zooming 
right out and including the foreground

Capture the smaller 
details of a building for 
some really stunning 
abstract shots

3 of the most common…

      Technical tip
When composing your 

shot, ensure the horizon 
line is straight. Press your 
camera’s Display button 
to call up guiding lines to 
help you.
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Shoot architecture

Optimum settings 
for architecture

Twist the mode dial to Aperture Priority and select a high f-number (narrow 
aperture). This will ensure that objects in the foreground, middle ground and 
distance are in focus. Then select Auto white balance so that you don’t need to worry 
about this. Set the ISO no higher than 400 to maintain image quality and make sure 
the shutter speed is faster than 1/250sec for handheld shooting. Use your lens at its 
widest angle (such as 18mm) to try to fit in as much of the building as possible, or 
zoom in to focus on details. The diagram below shows what elements of our building 
we can see at different focal lengths.

Shoot the perfect architecture picture by using these very 
straightforward tips on exposure, white balance and focal length

3. Settings

Focal length

200mm

50mm

18mm

Taking the shots

 Angles
Kneel or lie on the 
floor in order to 
get a low angle. 
This can result 
in the building 
looking grand and 
rather imposing.

 Aperture 
Priority
Set your camera to 
Aperture Priority if 
possible, and use 
a high f-number in 
order to keep all 
details in focus.

Shutter 
speed
A high shutter 
speed will help 
to keep shots 
sharp when 
hand holding 
the camera.

Keep it 
steady
A wall or fence 
to lean on will 
keep your arms 
steady and help 
to keep shots 
pin-sharp.

Venture inside the building and practise 
your low-light shooting skills. Cathedrals 
make great subject matter, inside and out
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4. In the city

1 Open your image 
Open your image in 

Photoshop. Try to shoot 
from 45-degrees above, as it 
enhances the appearance of 
looking down on a miniature 
model. Ours was taken at a 
distance and is just as effective.

2 Quickmask mode 
Press Q on the keyboard 

for Quickmask, and G for 
the Gradient tool. Select 
Reflected Gradient and draw a 
line from the area you want to 
be in focus across to the area 
you want to appear blurry. 

Get creative in 
the city centre
Admire the mix of old and new, and 
start shooting stunning cityscapes

In the city, there is usually a healthy mix of grand, 
long-standing structures and modern elements, so 
there will be plenty of photo opportunities. You can 
afford to be more experimental with newer creations 
by cropping in close to show off the unusual design. 
Use natural frames such as over-hanging branches 
and iron gates to highlight your subject, and use 
staircases and roads as leading lines that naturally 
recede towards your main subject. 

City centres are designed to look exciting at night. 
Buildings are illuminated with vibrant coloured lights 
and cast interesting shadows. For low-light shooting, 
use a tripod to prevent camera shake and set the ISO 
to a higher setting, such as 400 or above. 

Add a tilt-shift effect
Tilt-shift lenses are pricey, but you can create the effect simply 
and cheaply using your editing software. The effect is known 
as Miniature mode, Toy Town effect, and Diorama mode, and 
some cameras have it as a Creative Scene mode. If not, it’s easy 
to achieve in Photoshop by using the lens blur filter. The finished 
effect makes the objects in the scene look tiny, emphasised by 
the blur that surrounds the edges. These steps will show you how 
to achieve this fun and creative effect. 

Create a toy town look by following these steps 

5. Editing

Shooting skills

A tilt-shift effect has been added, 
creating a soft blur around the edges
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3  Exit Quickmask 
To exit Quickmask 

mode Hit Q and make 
the mask a selection. Go 
to Filters>Blur>Lens Blur 
and play with the settings. 
Increasing the Radius will 
increase the blur effect.

4 View the selection
 Get rid of the selection 

areas by pressing Ctrl + D. If 
you’re not satisfied, go to 
Edit> Undo the effect, and go 
back to step 2, but place the 
line in a different part of the 
image this time.

5  Colour pop 
Boost colours and 

enhance the toy-town look by 
clicking Image>Adjustments> 
Curves, and plot a curvy 
S-shape on the graph. Use the 
preview screen to check the 
effects then click ‘OK’. 

Close-ups of contemporary 
architecture pack a visual 
punch; zoom in on the parts 
that catch your eye

Shoot both portrait and 
landscape orientation to see 
which works best

Experiment with angles and 
break the rules; this modern 
building looks abstract and 
striking with a wonky horizon

Shoot architecture

      Technical tip
To minimise camera shake 

without a tripod, lean your 
elbows against a wall or post 
to give you some additional 
support, or tuck in your arms. 



126

Shooting skills

Cameraphone 
There are lots of apps 

designed to shoot in and 
convert to black and white

Due to the smaller sensor, 
the image loses a lot of 
quality during conversion 

Compact camera 
Most compacts come 

with specific black-and-
white scene modes

 The sensor can lack good 
detail and colour range, 
compromising the quality 

Compact system camera 
Most CSCs have art 

filters that give B&W shots a 
dramatic look

 Some filters can 
negatively affect the quality 
of the shot

DSLR 
Dedicated B&W modes; 

the large sensor helps to 
retain the detail of the shot

 We still needed to convert 
the RAW image in editing 
software for the best results 

B lack-and-white photography can 
look really stunning. It can work 
in all weather conditions, indoors 

or outside, and with lots of different 
subjects. This is because images without 
any colour rely on the light and contrast 
to produce the depth and interest in the 
shot. Subjects with a vast contrast range 
work especially well, and this means 
looking for any subject with a large 
variation of tones from pure white to pitch 
black, and everything in between.

Considering the available sunlight or 
enhancing it with your flash can be a great 
way of boosting the contrast for black-
and-white photos. Think about adding in 

a harsh side light for portraits or shooting 
on an overcast day for landscapes so you 
have lots of white, grey and dark tones in 
the sky to later enhance.

Creating black-and-white photos can be 
very simple, and there are now a variety 
of ways in which it can be done. Using 
a preset camera mode is the easiest, 
because it enables you to see the final 
shot straight away. 

However, even with black-and-white 
photos, the colour range still affects how 
the final shot looks. Therefore simply 
taking a colour image and using editing 
software to remove and edit the colour 
tones can often give you the best results.

Black and white
You’ll discover new opportunities when you look 
through black-and-white eyes

Over the next few pages: Learn what to look for and how 
to shoot amazing monochrome photos
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The original, coloured shot looks less appealing, with a flat colour 
range and an uninteresting sky  
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Great black-
and-white 
shots

5 steps to…

Follow these steps to 
improve your black- 
and-white photos

1 Inspiration 
Black-and-white 

photography can work well with 
many subjects, and you can 
improve the overall look of many 
shots by removing all of the 
colour from the scene. 

2 Landscapes 
Landscapes are very 

popular in black-and-white 
photography because the  
many different tones and  
colours in the scene can be 
enhanced when converted to 
black and white. 

3 Settings 
There are many specific 

shooting modes available for 
black and white, and, depending 
on the camera, there are creative 
art filters that can enhance the 
look even further. 

4 Portraits 
Removing the colour 

from a portrait can remove any 
distractions from the shot, as 
well as draw attention to the 
expression and details of the 
subject’s face. 

5 Editing 
Some of the greatest  

black-and-white photographs  
are created by removing the 
colour in an image-editing 
program post-shoot. We show 
you the best techniques for 
creative conversions. 

Go from this simple coloured shot 
to this unusual but excellent black-
and-white photo
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Black and white

1/60sec F16

Uses for black and white
3 of the most common…

Landscapes
Landscapes often hold a 
vast tonal and contrast 
range, and are therefore 
suited to black-and-white 
conversions. 

Portraits
Portraits are excellent 
for black and white, as 
removing colour from the 
shot can create softer and 
more flattering skin tones. 

Abstract
Abstract photos can vary 
in subject matter, but 
removing colour can draw 
attention to the intricate 
details of the object. 

Use black-and-white 
photography to your advantage
There are lots of subjects that lend themselves to being shot in 
black and white, with the lack of colour enhancing the shot
Black-and-white photography may seem like an easy technique to master; however, it is 
not suited to every subject, and can often be used in the wrong context, leading to flat 
and dull images. Many photographs will lack the colour and contrast range suitable for 
effectively converting to black and white. 

Photographs with a large amount of textural detail are also great for black and white, 
as the conversion will bring out the details in all areas of the shot, from the main focal 
point of the image, right through to any background interest. 

Black and white can also be used to enhance a photo, removing the colour as a 
distraction from the main subject and bringing all the focus to where it is intended. This 
works well in shots that have an uncontrolled and potentially distracting background.  

1. Inspiration
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Use black and 
white to enhance 
a landscape
Weather given you a dull sky? Discover 
how black and white can rescue your shot
Landscapes are great for black-and-white photography, 
mainly due to their large tonal range. Converting 
landscapes to black and white will also enhance the 
details of the scene, and can often be used as a tool for 
rescuing unflattering skies. 

The sky in any shot is important, but even more so 
when shooting black and white. A plain, boring sky 
will convert into a dull, white sky, which can leave an 
image looking flat. Overcast skies with a lot of cloud 
formations will contain a large amount of contrast; 
perfect for black and white, as we show here…

2. Landscapes

 Lack of  contrast
This image lacks tonal contrast when shot in black and 
white – the sheep blend into the background. This 
results in a flat and rather uninteresting image.

Use an app such as B+W 
Camera or Instagram

Set your camera to Creative or Art 
mode to find a black & white filter

1/60sec F8

      Technical tip
With black-and-white photos, 

the lighting is everything. Try 
using the sunlight to add depth 
and detail to your shot. 

130
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Black and white

There are two main ways to create black-and-white images – in-camera art 
filters or post-shoot image editing. Many digital cameras now come with a 
host of dedicated scene modes and art filters, including black-and-white. 
These modes seek to remove the colour and boost the contrast of the 
shot. Sepia mode is a popular one and seeks to recreate an old Sepia film 
effect whilst many cameras also offer Grainy Film mode that convert to 
mono and add a noise grain, like old film photos.

However, many photographers still choose to ignore these automatic 
modes and convert their colour shots to black and white using image-
editing software post shoot. 

We find out whether in-camera effects or image editing gives the best 
results below.

Utilise the settings 
available to get the  
best results
Experiment with the different filters as well as 
converting to see which produces the best shot

3. Settings

 Find some foreground
Using foreground interest will add more depth 
to your scene. A tree silhouetted against the 
sky will provide some sharp contrast.

Black & white 
errors

3 of the most common…

 No focal point
There is no main  
point of interest 
to this scene. 

 Tonally flat
With only 2 blocks of colour, 
this shot is tonally flat and 
not ideal for black and white. 

 No detail
Lack of detail isn’t great for shooting black and 
white. Avoid cloudless or overcast days and go 
out when there are a few clouds in the sky. 

Sepia mode
Sepia mode is a 
creative filter found 
on a large number of 
cameras. It gives the 
photo a retro effect, 
replicating the look  
of old film photos 
using a distinctive 
brown-tinted 
monochrome colour. 

Does your  
camera do it?

 DSLR

  Compact system 

camera

 Compact camera

 Cameraphone

Film Grain 
mode
Film Grain mode 
removes the colour 
from the shot while 
boosting the blacks. It 
replicates the look of 
an old film, adding in a 
grainy look as well as 
boosting the contrast 
to enhance the shot. 

Does your  
camera do it?

 DSLR

  Compact system 

camera

 Compact camera

 Cameraphone

Converted  
from colour
Converting the image 
from colour is a 
common technique. It 
enables you to control 
the different colour 
levels, boosting areas 
to enhance the photo. 
However, this process 
is time consuming. 

Does your  
camera do it?

 DSLR

  Compact system 

camera

 Compact camera

 Cameraphone

1/10sec F14
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Use black-and-white 
conversions creatively

Selective colouring is the process of converting an 
image to black and white, while choosing a specific part 
of it to retain its colour.

This technique highlights the coloured object as the 
focal point of the photo. This leaves the rest of the 
photo without colour to frame and draws particular 
attention to the chosen subject. Experiment to see 
what works!

Add a touch of colour in Elements with 
our selective colouring tutorial

5. Editing

Shooting skills

Shoot portraits 
for black 
and white
With the right lighting, any 
portrait can look excellent 
in black and white   
Portraits are very popular in black-
and-white photography. Converting a 
portrait to black and white can soften 
and enhance the skin tones, as well 
as enhance the details in the facial 
expression. Babies and older people can 
work particularly well with wrinkles and 
skin textures being enhanced, but any 
subject can work as we will show you.

Removing the colour from the photo 
will help to achieve more flattering 
lighting, as well as help to remove any 
distractions from the background. It can 
also draw attention to the main focal 
point of the image – the subject’s eyes. 

Portrait photos can also benefit from 
the use of different shooting effects, 
such as high and low-key lighting, which 
adjusts the direction and strength of the 
lighting of the scene, and can be achieved 
using in-camera modes or using lighting 
like flash effects.

4. Portraits

1/30sec F5

Before After
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Black and white

4 
Erase 
Now, using the Eraser 

tool, erase the black-and-
white areas that you would 
like to restore colour 
to. Next, simply return 
opacity of the black-and-
white layer to normal and 
then merge both of the 
layers together.  

2 
Convert 
Select the new layer. Go 

to Enhance>Convert to black 
and white to open a dialog 
box to adjust the colour 
channels. Use the sliders to 
experiment with different 
lighting tones, and ensure 
your image is set correctly 
before proceeding. 

1 Duplicate layer 
Duplicate the background 

layer to create a black-and-
white layer and carry out 
adjustments on this second 
layer, thus not altering the 
original. It also means you 
can erase the unwanted 
black-and-white areas of the 
second shot.  

3 
Reduce opacity 
With the new layer still 

selected, use the Opacity tool 
to adjust how much of the 
new layer can be seen. You’ll 
be able to view the colours 
of the original image more 
easily, and also see which 
parts of the new layer you are 
removing.  

 High key
Using a high-key scene mode, 
we were able to slightly 
overexpose the highlights of this 
scene, bringing out the details in 
the lighter tones, while boosting 
the effect of the ambient light 
on the subject. 

 Low key
By facing the 

subject towards the 
light and using the 

low-key shooting 
mode, we were able 

to underexpose 
the background, 

losing some of the 
detail but drawing 
all attention to the 

subject’s face.  
High-key and low-key scene modes 

work well for black-and-white portraits
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Shooting skills

L ighting is a key element in photography 
and is responsible for almost all of your 
good and bad shots. Encompassing all 

photographic genres, it can affect the outcome 
of every photograph that you take. To ensure 
you get great shots every time you shoot, we 
have put together all you need to know about 
working with available light in this simple guide 
to lighting. 

Whether you photograph landscapes, portraits 
or still life, we have outlined some of the most 
important lighting tips and techniques over 
the following eight pages. With some fantastic 

hands-on advice, you will soon master shooting 
indoors and out, as we cover all the need-
to-know lighting basics. Learn how to use a 
reflector and discover when it’s best to work 
with flash. We will also share some great still-life 
lighting advice and show you how to enhance 
your final shots in Photoshop.

It’s time to start paying attention to the light, 
and uncover new and creative ways to shoot in-
camera. You can now follow our simple setups at 
home and achieve the same professional results 
that we have, regardless of what camera system 
you find yourself using. 

Learn to use light effectively and get great 
shots with our lighting guide

Perfect lighting

Over the next few pages: Get inspired and learn how to light portraits 
and still life, as well as how to fill in with flash, and quick lighting fixes

Cameraphone Compact camera Compact system camera
There are great editing apps 

that help enhance the lighting 
contrast in your captures

 Due to the small sensor, 
image quality is poor and you 
can lose out on capturing 
lighting detail

  With built-in shooting 
modes you can achieve great 
creative results in-camera

 With a fixed camera flash 
you are unable to adjust the 
direction or strength of the 
flash light 

 Most of these have 
speedlight accessories for the 
hotshoe, for low-light shots 
and fill-in flash

 Unlikely to offer as many 
accurate light-metering 
modes as a DSLR camera

DSLR 
 Its large sensor means it 

can produce fantastically 
detailed photographs

 This is an expensive 
system for beginners who 
do not quite understand 
how manual modes work yet
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Perfect lighting

Try and make 
use of natural light 
by placing your 
subject by a 
window or any 
other well-lit area. 
No flash was used 
here, because  
the light was 
strong enough.

1/125th F5.6
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Use light creatively
Waiting patiently for the streams of sunlight to break through the clouds has 
turned a potentially dull shot into a stunning landscape photograph.

Speedlight
A detachable speedlight such as this 
Metz 54 AF-1 fl ash unit (www.
metzfl ash.co.uk) is a great investment 
for portrait photographers, and will 
enable you to get better exposure 
results in low-light shooting situations. 

Refl ector
A collapsible refl ector, such as this one 
from Lastolite (www.lastolite.com). is an 
ideal camera-kit 
accessory. 
Portable, it can be 
used on location 
or indoors to 
bounce light back 
into the shadows 
of your shot.  

Improve 
your lighting

5 ways to…

Follow these five quick lighting tips 
for better photographs

1 Get inspired
Look for the light and get creative with what’s 

available. Always aim to enhance and illuminate 
the main subject in your shot. 

2 Perfect portrait lighting
Balance out the light, and bring detail back in 

the shadows by repositioning your model and also 
by using a reflector. 

3 Fill in with flash
Take control of your speedlight or on-camera 

flash’s direction, and discover how you can fill in 
with flash light. 

4 Lighting a still life
Shoot some stunning still-life shots at home 

by simply using directional and diffused ambient 
light from a lamp. 

5 Editing
It doesn’t matter if you don’t capture it in-

camera, there are some simple editing steps you 
can follow in Photoshop to enhance your lighting. 

3 of the best…

Shooting skills

 No directional sunlight
Shot on an overcast day, this image 
appears flat without any directional 
sunlight to add depth and contrast. 

Tripod
A key piece of kit 
for landscape 
photographers, a 
tripod such as this 
Manfrotto 458B 
Neotec Pro Photo 
Tripod (www.
manfrotto.co.uk) 
will enable you to 
set longer shutter 
speeds for 
exposures that 
capture more light.  

Accessories for improving 
the light in your photographs



Perfect lighting

Light is what transforms your photograph from a dull snapshot into a 
stunning work of art. When shooting, it is important to pay attention 
to how light falls and reflects within your frame. You can then set 
your camera accordingly to pick up on the light regardless of whether 
you’re working in manual or automatic modes. 

Get creative and don’t be afraid to experiment with your camera 
settings. Try shooting in optional scene modes or add a creative 
camera filter to see first hand how you can transform the light in your 
photographs. Even try switching over to shooting in manual modes 
and set longer exposures for more creative light captures. 

Whether you’re shooting a landscape, portrait or still life, get 
inspired by the available light and remember that when taking a 
photo, it takes time and patience to achieve professional results.

Get inspired by lighting
Look for the light and get creative

1. Inspiration
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 Use light creatively
Using fairy lights, or another light source, you can create a pleasing 
‘bokeh’ photo like this, with blurred-out light. Experiment with light 
for some creative results.

 Head outside
The sun can make for perfect lighting on 
a bright day, so make use of this natural 
light-source for some well-lit images.
sunlight to add depth and contrast. 
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Shooting skills

Portraits are one of the most popular subjects to 
shoot, but they are not always the easiest to get right. 
Lighting plays a big part in how successful your portrait 
photographs are, based on how flatteringly the light falls 
on the model’s face.

Whether you are working with ambient light or flash, 
ensure you pay particular attention to how you position 
your model in relation to the light. You want to accentuate 
their most flattering features and avoid creating harsh 
and distracting shadows across the face. To overcome 
this, always try to use a reflector or fill-in flash, which can 
balance out the shadows and bring light back into the 
model’s most important features: the eyes.

Master lighting for 
perfect portraits
Learn how to light your portraits 
following these simple steps

2. Portraits

 Bad Composition
Badly composed, a distracting 
shadow has fallen across the model’s 
face in this picture, and the strong 
direct sunlight has made her squint.   

 Incorrect light direction
Sitting side-on to directional light 
creates shadows across one side of 
the face. Reposition the model or 
use a reflector to fill in shadows.

 No reflector 
The background light 
creates a halo highlight 
in the model’s hair, 
but without light 
reflecting on her face, 
it’s difficult to see the 
model’s features. 

This backlit 
shot has been 

improved 
by using the 

on-camera 
flash to fill in 

light on the 
model’s face

Lighting errors
3 of the most common…



139

Perfect lighting

Face-on fl ash
1 The flash brightens 

the middle of the face, 
but the light graduates 
out quickly and creates 
strong shadows in the 

background. Direct camera flash like this 
is ideal for filling in light on predominantly 
backlit shots, creating a balance between 
the foreground and background.

Bounced off  ceiling 
2  Bouncing the flash 

off the ceiling first 
will diffuse the light and 
let it land more naturally 
onto your subject. With 

high ceilings, increase the power of the 
flash to ensure that enough light falls back 
down onto your subject.

Bounced fl ash off  wall
3 By rotating 

the flash head 
sideways at a 
45-degree angle, you 
are able to effectively 

bounce the flash off the side wall first, 
therefore replicating a professional and 
flattering side light across the model’s 
face, as in this picture.

MODEL

MODEL

CAMERA WITH FLASHSTRAIGHT-ON 
SHOT

FLASH LIGHTFLASH LIGHT

MODEL

BOUNCED 
OFF WALL

CAMERA WITH FLASH

CAMERA WITH FLASH

BOUNCED 
OFF 
CEILING

Most on-camera flashes will fire 
automatically when low light is 
detected, but this won’t always result in 
better image outcomes. A basic pop-up 
flash is provided with almost all camera 
systems, and is capable of flashing 
straight on, but results aren’t always as 
artistic as you may have hoped, with 
highlights often blown out and strong 
contrast shadows appearing in the 
background. Some advanced cameras 
work around this by offering different 
flash strengths, allowing you to alter the 

settings, or add a speedlight accessory 
via the hotshoe. 

Ideal for filling in the shadows or 
illuminating faces in low light, when 
used correctly, speedlight flash can 
creatively enhance your captures. 
With a rotatable head you can adjust 
the direction and strength of the flash 
before it reaches your model. Below we 
have outlined a few basic flash-head 
adjustments to show you just how easy 
it is to transform your photographs into 
professionally lit portraits at home.

Fill in the shot with flash light
Discover how changing the direction of flash can 
significantly affect how your photo looks

3. Flash

Using a white piece of card as a 
reflector, the natural light in this backlit 
shot has been bounced back into the 
model’s face, illuminating her features 
and adding highlights in her eyes  

Sometimes facing 
the model in the 
direction of sunlight 
can create striking 
results, but avoid 
taking too long to 
shoot, as the model 
will begin squinting 
before long 
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Shooting skills

Fix the light at  
a later stage
You may not always get the shot you 
had wanted in-camera, which is where 
Photoshop steps in. Correcting what you 
may have missed, there are some fantastic 
editing tools and techniques that are ideal 
for enhancing light.

Open your RAW image file in Adobe 
Photoshop and follow these five simple 
steps in order to improve the contrast in 
your captures.  

Quick lighting fixes in Photoshop

5. Editing

1 Create a new layer  
Upload captures onto your 

computer and then select 
one that you want to edit 
in Photoshop. Once loaded, 
create a new layer via Layer> 
Duplicate Layer. Rename your 
new layer ‘Edit’ and click OK. 
Select your new layer in order 
to activate it and go to Image> 
Adjustments>Levels.  

Lighting  
a still life
Learn how to light 
and shoot a stunning 
still life at home
Still-life photos need not be 
taken in the studio with flash. 
You can create the same 
professional-looking shots 
at home using ambient light 
in a controlled way. Set up a 
simple still-life shoot at home 
with a bowl of fruit and a desk 
lamp. An ideal light source for 
this type of shot, it will give 
you control over the direction 
and strength of the light. 
Look closely at how the light 
falls on your subject, and aim 
to accentuate the shape of 
the fruit. Remember when 
shooting with warm  
ambient light like this to 
set your white balance 
accordingly in order to 
prevent colour casts 
appearing in your captures.

4. Still life

Before

After
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Perfect lighting

4 Use the Burn tool Use 
the Burn tool to darken 

areas in the frame. Select a 
wide, soft-edged brush with 
the range set to shadows. Set 
exposure to 6% for gradual 
build up. Begin brushing areas 
that need more contrast and 
depth. Burn around the edges 
of the frame to draw the eye 
into the centre subject.

5 Brighten and save   
Switch to the Dodge tool 

to lighten areas. Select a good 
size soft-edge brush with the 
range set on either midtones 
or highlights and the exposure 
up at 20%. You can now add 
brighter highlights to your 
image. Flatten the layers via 
Layers>Flatten Image, and save 
your shot as a JPEG.

2  Use the histogram  
The histogram is bunched 

to the left, meaning there are 
no highlights and the shot 
is dull in midtones. Select 
the highlights slider at the 
bottom-right of the histogram 
and drag it up to where the 
mountainous range begins. 
Tick the Preview button, to see 
how this will affect the shot.

3 Adjust the midtone
To add in more midtone 

contrast, select the midtone 
slider and slowly adjust it 
towards the highlights slider. 
When you are sure you’re 
pleased with the results, just 
click OK. You can now select 
the Burn tool from the Tools 
palette, which is on the left-
hand side of the screen. 

Lighting from the side can help to add depth to an image by creating contrasting shadows. Remember that 
the closer the light source is to your subject, the stronger it will be, which can create blown-out, distracting 
highlights, as seen in this image

Holding greaseproof paper over the 
light has helped to soften its intensity, 
and has nicely dulled the highlights 
while still accentuating the shape of the 
oranges here

A flat 
snapshot
Lit using an 
overhead 
ambient light, 
this image 
appears flat  
and lacks any 
depth making it 
more reminiscent 
of a snapshot 
than a composed 
still life.
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W hen you’re starting out in photography, 
the most important thing you can do is 
practise. It may seem really obvious, but 

getting out with your camera and experimenting 
is the quickest way to learn techniques and master 
your new kit. Rather than let yourself get bored 
shooting the same old things day after day, though, 
we have some great ideas here to inspire you. We’ve 
got plenty of fun projects that you can do in your 
home on a rainy day, such as creating art out of 
incense and some really interesting macro shots. If 
you’d rather get outside with your camera, we’ve got 
plenty to suit you too, from creating a HDR landscape 
to playing with shadows.

With these simple projects, you will learn just what 
your camera is capable of while practising essential 
skills you can apply to other genres. And what’s 
more, you’ll get some truly standout images along 

the way to show off to friends and family. Why not 
display your endeavours from these projects in your 
very own calendar – we even show you how to craft 
your own from scratch for a truly personal way to 
share your snaps. 

Have fun with these great, creative projects  
and why not post your results up on  
www.photoforbeginners.com or share them on the 
PFBMag Facebook page. Try out your own creative 
ideas too, and let your imagination run wild. 

Practise your skills using these ideas for amazing photos

Consider framing
Try various angles and reposition 
the subject to get the strongest 
shot. Consider whether it looks 
best in portrait or landscape.

Top tips for creative photography

Light the shot
Lighting is fundamental for any 
photo. Position subjects near 
natural light, or use a flash or a 
reflector to fill in harsh shadows. 

Think about colour 
Using a vibrant subject can help 
add impact to your shot, but don't 
overuse colour – stick to three 
colour tones for the best impact. 

Select a backdrop
Ensure the background isn’t 
distracting. Attention should be 
on your subject, so use coloured 
card or even a bed sheet hung up.

Add creative filters
Most cameras come with filters 
like fish-eye, miniature, sepia or 
cross-process. Use these effects 
to make your shot stand out.

Tweak your shots
Apply creative effects as  
well as edits. Get some great 
ideas from tutorials on  
www.photoforbeginners.com.

“We’ve got plenty of 
fun projects that you 
can do on a rainy day”
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Perfect exposure
You may have to set a lower 

f-number when using a fast shutter 
speed to let in enough light

Freeze motion by using a fast shutter speed

Keep on trying!
High-speed shots are often trial 

and error, so keep experimenting 
until you get the right positioning

Use flash
 Firing your flash can help 

to freeze movement in 
shots like this. Try putting 
a piece of tracing paper in 
front of it if it’s too harsh

Freeze it
Use a fast shutter speed 

(over 1/200sec) to freeze the 
action. Slow it down if you want 
to show some movement blur

Shoot quickly
 Burst mode lets you 

take a series of images 
quickly, improving your 
odds of getting the dice at 
the height you want them

Keep it sharp
Using Continuous AF mode 

will help to keep the moving 
subject as sharp as possible

01 Action images

Creative projects to try today
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Fun shadows 
Bright, sunny skies offer plenty 
of great photo opportunities. 
Get creative with the sunlight 
by shooting the shadows it 
casts. You can create unique 
shadow shots like this using 
a brightly coloured prop such 
as an umbrella. You’ll need to 
position your model to face 
the direction of the sun and 
then shade them using the 

umbrella. Ask your model to 
pose so that the shadow has 
a clearer definition. To ensure 
you can fit the scene within 
the frame, shoot in landscape 
orientation. You’ll need to 
focus on the umbrella and set 
a narrow aperture (around f11) 
and fast shutter speed (over 
1/125sec) to prevent the image 
from overexposing.

Capture shadow shots on sunny days 

03

04  Great macro 

Use props to take unique people pics
To capture this creative portrait, set your camera on a tripod 
at eye-level with your model. Using string or colourful ribbon, 
attach an empty frame to a nearby branch and lower it down so 
that you can see through it to your subject. Be sure that there is 
enough light so you can shoot without flash, as flash will blow 
the detail of the frame. Set your camera to Aperture Priority and 
f8, zoom in so that the frame fills the edge of your view, then set 
your focus on the model and not the background or frame.

Set your camera on a tripod and place a glass vase on a 
piece of white paper. Set up a background with coloured 
card or even a colourful scarf. Fill the vase with tonic 
water (for bubbles) and place in a cherry. Use a desk 
lamp from a safe distance or an external flashgun, 
slightly raised (try placing it on a stack of 
books) but lighting the cherry. Make sure 
your focus is on the cherry rather than 
the glass and use a wide aperture 
(low f-number) to throw the 
background out of focus. Macro 
mode or a macro lens will help 
you to get in even closer to 
your subject. 

Take a rare look at macro subjects

02
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To paint with light, you must either shoot 
outside at night or in a dark room. Set your 
tripod up and attach your camera. Make 
sure it’s secure and set it to Timer mode, 
so you can be in the right place at the right 

time. Now set your camera to Shutter 
Priority and lower the shutter speed to at 
least 10sec and make sure your ISO is low 
to avoid noise appearing. Now press the 
shutter to start the timer, jump into place 

and start ‘drawing’ your picture with the 
torch, being sure to keep moving so you 
don’t appear in the frame. It is often easier 
to draw around people or objects as a 
guide, like we have here. 

The easiest way to convey movement is to use a long 
exposure. This means using a long shutter speed to blur 
the subject, but keeping everything else in focus by using a 
tripod. By keeping the camera steady, you can ensure that 
stationary elements are sharp. 

Switch to Shutter Priority on the mode dial and set it to 
around 5sec, steadily increasing the time until you are happy 
with the results. You might need to use an ND filter in order 
to reduce the amount of light coming into the lens and help 
avoid overexposure. 

Perspectives

It can be fun to play with perspective. For effective results, you’ll 
need to work in a wide, open space. If you’re placing a model in 
the frame, get them to stand as far back as possible to give the 
illusion that they’re a smaller size. You can then introduce objects 
or hands around the side of the image at a closer proximity to 
the lens, so that they will appear larger when compared to the 
model. Give your model clear instructions to pose so that it 
appears as though they are interacting with the object or hands.

Get fun images by  
changing perspective

06 
Motion blur

Use shutter speed for special effects

Creative projects to try today
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Light painting 05
Paint pictures in low light using a torch, tripod and your camera 

07



Drain the colour
Open your image then save it under 

another name. Go to Layers>Duplicate 
Layer, then select Desaturate from the 
Colors menu.0

Add a layer mask
Go to Layer>Mask>Add Layer Mask 

and opt for White (full opacity). Select the 
mask thumbnail and paint with a black 
brush to reveal colour.

Flatten the image
Finally, select Image>Flatten Image to 

merge all the layers into one. Then save 
the image (File>Save) and export it with 
File>Export.

How to make your subject stand 
out from the scene

Selective colouring
08

Using layer masks

A zoom burst adds focus to a central point, blurring the outside in a 
creative way. Select a brightly coloured subject that is stationary. Switch 
your camera to Shutter Priority mode and set a shutter speed of around 
1sec. This should give you just enough time to zoom out while the shutter 
is open to capture the effect. Frame the subject by zooming in so that it 
fills the image. Now focus the camera on the centre. Position your hand 
on the lens around the zoom ring and once you’re ready, release the 
shutter. As soon as the shutter opens, rotate the zoom ring anti-clockwise 
to zoom out and capture an effective zoom burst result.

The selective colour technique is a clever way of drawing 
the eye to a particular part of a picture. It works by 
converting the image to black and white, then restoring 
colour to the subject so that it leaps off the frame. Some 
cameras offer this as a creative filter, and although this is 
the easiest way of achieving the effect, the results can be 
much more accurate when you do it yourself. For the best 
results, choose a photograph with a colourful focal point, 
such as a bunch of  flowers. We’ve used  some fruit and 
free editing software GIMP to create the effect.
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09 Zoom burst
Use zoom for vibrant still-life shots

A guide to selectively colouring shots in GIMP



Themed portraits
Take a creative approach 
to portraiture
There are plenty of great ways to get creative with portraits. 
Using a theme will not only give you a brief to work towards, but it 
will also enable you to include more elements within the frame in 
the way of props and styling. Selecting a character from a book or 
a favourite film is a great way to start. You’ll need to get hands-
on with posing your model using props for this, and consider 
the location of the shoot carefully as it will be dependant on the 
character you’re photographing. You can also ask your subject to 
change their expressions to convey different emotions.

Create an old-fashioned photo

Place your cup on a small 
table, about two metres from 
the wall behind it. Light it 
with a desk lamp or external 
flash gun positioned about 
a metre to the left of the 
camera and above it. 
Hang black cloth on the wall 
and suspend fairy lights from 
the top. Put your camera on 
a tripod and manually focus 
on the cup. Using a wide 
aperture (low f-number), the 
background lights should 
be blown out of focus to 
create this lovely effect. 
Then position the cup so it 
looks like the lights are steam 
coming from it!

Blur light for fun images

Vintage is currently on trend, and not just in regards to clothing; 
it’s made a comeback in photography too, with vintage-inspired 
camera designs and filter effects that will transform your shots 
into old-fashioned works of art. To create your own vintage 
image, check your camera’s shooting modes. Some may offer 
a sepia or specialist filter effect that you can apply instantly. 
Alternatively, use tools in Photoshop such as Hue/Saturation 
and the Add Noise filter for effective results. Reduce saturation 
first and then increase the yellow hue for a sepia effect.

11 Bokeh

Creative projects to try today
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If you look at a sunrise or sunset scene, 
you’ll see a full range of tones, including 
detail in the darkest parts of the land and 
the brightest parts of the sky. However, 
camera sensors are unable to record the 

same range of tones, so will under or 
overexpose certain areas. The solution is 
to take three (or more) identically-framed 
pictures at different exposures: at, under 
and below the camera’s metered exposure. 

This is known as ‘bracketing’. Many cameras 
have an auto-bracketing facility. You then 
use software like Photoshop Elements or 
Photomatix to merge the pictures into one 
image that contains the full range of tones. 

Learn to get perfect results in tricky lighting

Choose your settings
Set Aperture Priority and pick a high 

f-number. Set Exposure Bracketing in the 
menu and move the dial until the lines are 
under the 1.

Use a tripod
Keep the camera steady, as change 

between shots causes ‘ghosting’. Take 
three shots (the camera will take three 
different exposures).

Merge the shots 
Open the shots in your software and 

find the ‘Merge to HDR’ option, which 
combines them. Use sliders to adjust 
contrast and highlights.

150

Starter projects

HDR from start to finish How to set up, shoot and edit HDR

13 HDR vistas

Without using HDR, detail is lost in the 
shadow areas. If we were to expose for the 
shadows instead, the sky would be blown out

Before



Capture striking abstract images 
A great project to try at home is shooting smoke trails. It’s easy 
to do, and all you really need is some incense sticks and some 
black card. It can take a bit of trial and error, but you’ll have a 
lot of fun experimenting. Here’s how it’s done… 

Set up the project
Place an incense stick on a table in front of a piece of black card 
so that any smoke will be easily visible (with a bit of distance in 
between). Set up in front of a bright window so the light hits 
the smoke from behind.

Choose your settings
Ideal settings are a low ISO, fast shutter speed, such as 
1/250sec, and high f-number, but experiment. Turn off your 
flash and use Burst mode for the best chance of a great shot. 

Get started
It is important to keep your camera steady on a tripod or hard 
surface such as another table. Manually focus on the end of 
the incense, light it, turn off the lights and start shooting! Use 
your hands to fan the smoke.  

Edit the shots
Open your best shot in editing software and crop out the 
incense stick or clone it out. Open the Levels tool and move 
the sliders in towards the edge of the graph. Play around with 
the Hue slider to change the colour.

Photo presents are a great way of sharing your favourite 
moments with people you know and love. What’s more, 
since it’s a calendar we’re making, your homemade gift 
is both useful and beautiful. Bonus!

Before we begin, you’ll need a selection of 
photographs to work with. Print them out using your 
home printer, or order a batch from a professional 
printing service. The size of the photos will ultimately 
depend on how big you’d like the finished piece to be. 
We wanted an A5 calendar, so we opted for mini prints 
to ensure we had a nice selection of shots on offer. 

Creative projects to try today
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Make unique gifts for your 
friends and family to enjoy

Smoke art

15

14

Custom calendar

A simple 
setup in your 
home can 
produce some 
striking images 
that look great  
as a canvas



Take group 
portraits 

Essential tips for taking 
perfect group shots

Think about the colours in 
the scene. Try to get your 

subjects to coordinate their 
clothing and make sure that 

the  backdrop doesn’t
clash either

Match 
colours for 

a perfect shot

Starter projects
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Position your subjects 
01  Find a suitable location, 

considering your backdrop, and 
then get everyone into position. Try 
getting your subjects to sit or stand at 
different levels to avoid a dull shot with 
everyone in a straight line. 

Control your aperture 
02 Set your camera to Aperture 

Priority mode and choose f8. 
This should be narrow enough to keep 
everyone in focus, but wide enough to 
create some background blur. Keep the 
ISO low to avoid noise.

Use the zoom  
04 To ensure everyone is in the 

frame, you may need to zoom 
your lens out. This may also capture some 
of the scenery to add context. If you can, 
though, take a few steps back and zoom in 
to avoid distortion.

Light the shot 
05 Try to make use of natural light 

by shooting outside or by a 
bright window. If you can’t or any of your 
subjects’ faces are in shadow, fire your 
flash to fill in these areas, or use a reflector 
to bounce light back in.

G etting the whole family or an entire group of friends 
together is a great excuse to practise your group 
portrait skills, and is particularly important for 

preserving precious memories if these occasions are rare. 
Group portraits can be trickier to get right than single portrait 
shots, because you need to pay attention to several subjects 
instead of just one. This can increase the chances of mistakes, 
such as people blinking or looking away from the camera in  
your photos.

Luckily, there are some foolproof tricks that you can use to 
guarantee great photos quickly and easily, which is very useful 
when trying to keep the attention of small children. Using blink 
detection or Burst mode will help you to get a photo where 
everyone is looking at the camera, and some cameras even have 
a smile detection function. It is also important to make your 
shoot fun for everyone, so you could try out whacky poses and 
introduce humorous props to keep everyone entertained. This 

will also help you to evoke natural smiles and facial expressions 
that convey your subject’s personality instead of forced and 
cheesy grins. You could even give your shot a theme, maybe 
getting everyone to wear festive jumpers to give the shot a 
winter feel. 

In the first part of our guide, we will show you how to set up 
your group portrait shot and get yourself in the picture too. 
Then discover how to edit your photo for flattering results, 
learning how to whiten teeth, remove blemishes and smooth 
problem skin. You can then find out how to turn your photo into 
a great card to send to your loved ones and give your message a 
personal touch.

Alternatively, you could turn your shot into a canvas print 
to place above the mantelpiece or simply print it out for your 
photo album. So whether you are shooting a family portrait in 
the living room, or photographing your best mates at the local 
park, follow our step-by-step guide to producing fantastic shots.  

Shoot Get everyone together for a group portrait 

Get into the frame 

06 If you want to be part of the 
shot, set the camera up on a 

tripod or sturdy surface and then switch 
on the self-timer. Once you press the 
shutter, quickly get into position before 
the shot is taken. 

Use Burst mode
03 If your camera has a blink 

detection function, use this to 
prevent the risk of blinking eyes in your 
shot. Alternatively, use Burst mode to 
take a series of shots and increase your 
chances of getting a good one.

Take group portraits
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Items of kit
for portraits 

Camera with 
articulated LCD
If you want to get yourself in 
the shot, a camera with an 
LCD that fl ips out or tilts up is 
great for framing. If your 
camera doesn’t have this 
feature, set it up on a tripod 
and use the self-timer.

Flashgun 
Sometimes the fl ash on your 
camera can be a little bit 
harsh. External fl ashguns 
usually have tilting heads that 
are perfect for bouncing the 
light off  of the ceiling, for 
softer results.

Refl ector 
Fill in any unfl attering shadows 
in your shot by bouncing the 
light back into the dark areas 
with a refl ector. Diff erent 
colours create diff erent eff ects 
– gold, for example, will cast a 
warm light.

Bring out the detail 
08 To sharpen it, go to Enhance>

Unsharp Mask. Increase the 
Amount slider to sharpen, the Radius slider 
to determine the area and the Threshold 
slider to set the amount of contrast. 

Edit Perfect portraits with Photoshop Elements 

Brighten it up
07 Go to Enhance>Adjust Lighting>

Brightness/Contrast and boost 
the Brightness slider. Tweak the exposure 
further by going to Enhance>Adjust Color>
Adjust Color Curves.

Whiten the teeth
10 Select the Dodge tool and set 

the Range to Midtones. Set the 
Exposure value to 50% and brush over 
the teeth. The longer you hold down the 
cursor, the whiter they will get. 

Remove imperfections
09 To remove blemishes or stray 

hairs, select the Spot Healing 
Brush tool. The Content Aware option 
must be on. Adjust brush size then click/
drag the cursor over the problem area.

Smooth the skin
12 To smooth out areas of skin, select 

the Blur tool. Set Mode to Normal 
and Strength to around 40% (it depends 
on how smooth you want to go). Brush 
over the skin to get it looking perfect. 

Brighten the eyes
11  You can use the same technique to 

brighten the whites of the eyes. Just 
make sure that you use a small brush size 
to avoid brightening the iris and pupils of 
the eye too for an unnatural effect. 

3 of the best…

Starter projects
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Upload your photo  

14 Click the Upload button, create 
an album to upload your photo 

into and pick an upload speed. Tick the 
automatic photo correction box if you 
want Snapfish to make basic edits. 

Share Create a card with Snapfi sh 

Choose a template 

13 Go to www.snapfish.co.uk, click 
the Cards tab and choose a style – 

we chose Greeting Cards. Select the card 
template. We went with Full Photo. Select 
an orientation then click Create Card.

Add some text
16 Click the Text button and position 

the text box where you want it. 
Select the Edit Text icon and type your 
message, choosing the font, size, colour 
and alignment of the text. Click Done. 

Position your shot
15 After you have uploaded your 

photo, click on the Front tab and 
drag and drop the photo onto the front of 
your card. Click in the centre of your photo 
to drag it into a position you’re happy with.

Order your card
17 Select the Inside and Back tabs to 

edit the rest of your card. You can 
add more photos inside. Go to the Review 
tab and choose where you want your card 
to be posted, then click Add To Cart.

Extra space 
Make sure you 
leave enough 
room for the 
message on your 
card when you 
take the shot

Natural 
smiles
Interact with your 
subjects to help 
them relax and get 
natural smiles

Simple 
backdrop
Find a simple yet 
colourful backdrop 
to complement your 
group of subjects

Get together 
Make sure 
everyone is close 
together to close 
up any gaps and 
create an 
intimate photo

Take group portraits

155

Shoot from a high angle 
or at eye level for the 

most flattering results. 
A low angle accentuates 

chins and noses.

Consider 
your shooting 

angle
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Discover how to capture incredible floral close-ups

Create a stunning 
macro masterpiece
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Create a stunning macro masterpiece

M acro is arguably one of the 
most intriguing types of digital 
photography, as it allows you 

to peer into a microscopic world that is 
otherwise missed by the naked eye. Once 
under magnification, even the most simple 
of household items can be transformed 
into a detailed utopia, which makes 
for some truly stunning photographs. 
Flowers are a common choice in macro 
photography, as their bright colours and 
intricate textures translate well when 
under magnification. 

In order to photograph close up and 
personal with a subject, your camera is 
going to need to be able to focus much 

closer than normal. Unfortunately, most 
standard lenses have a limit as to how 
close they’re able to get to a subject before 
they’re unable to lock on and achieve sharp 
focus. Macro lenses have been specially 
built so that they can focus much closer to 
subjects, and are available for most makes 
of DSLR and CSC. Most macro lenses will 
have the word ‘Macro’ written on the side 
of the lens, though the magnification they 
offer will ultimately vary between different 
makes and models, so it’s always best to 
check to see what the lens’s enlargement 
ratio is – this is also usually found 
somewhere on the lens barrel. ‘True’ macro 
images are taken at a ratio of 1:1, while 

lenses with a smaller ratio (ie 1:2) will only 
offer half the amount of magnification. 

If you don’t own a macro lens, there are 
other cheaper alternatives to gaining close-
up pictures, including close-up filters that 
screw onto the front of a regular lens to 
increase its minimum focusing distance, as 
well as extension tubes that sit in between 
the camera and lens to let it focus closer. 
If you don’t own an interchangeable lens 
camera at all, some compact cameras 
feature a built-in macro mode. When 
activated, this allows the camera to 
take photos much closer than normally 
possible, so there are plenty of ways to join 
in with the macro fun!

02 Set up your subject 
Sit your flower in a vase and 

place it next to a brightly lit window (or go 
outside if the weather is nice). Placing a 
piece of coloured paper behind the flower 
will create a clutter-free backdrop.

01 Use a tripod 
When shooting under 

magnification using a macro lens, even 
small movements will be exaggerated, so 
setting your camera on a tripod should 
avoid knocking the shot out of focus. 

04 Set your aperture 
Switch the camera to Aperture 

Priority mode (A or Av on the mode dial) 
and set an aperture of f8. When focusing 
close up, even using an aperture of f8 will 
only create a very small in-focus area.

03 Add the drops 
Dissolve two teaspoons of 

sugar in a small cup of water to help the 
droplets stay in place. Using the head of 
a pin, or the tip of a pencil, carefully blot 
small drops of water onto the flower. 

06 Take the shot 
While looking at the rear 

screen, turn the focus ring on the lens 
until the drop of water is pin-sharp. Fully 
depress the shutter button to take the 
shot. Be careful not to knock the camera. 

05 Use Live View to focus 
When taking photos close up, it 

can be hard to get the focus where you 
want it using autofocus. Switch to manual 
focus and activate the camera’s Live View 
function to help get sharp focus. 

Shoot Set up and start shooting your subject
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Ways to add 
contrast to 
your macro

Adjust the Levels
Head up to Image>
Adjustments>Levels. In the 
window, move the Black point 
slider to the right to darken the 
shadows, then move the White 
point slider to the left to 
brighten the highlights.

Increase Brightness/Contrast
Go to Image>Adjustments>
Brightness/Contrast and move 
the Contrast slider right to add 
contrast. This is the quickest and 
easiest way, but off ers less 
control than the methods below.

Experiment with Curves
Go to Image>Adjustments>
Curves. In the window, click 
and drag on the curves diagram 
in order to adapt it into an 
S-curve. This will darken 
shadows and brighten 
highlights to boost contrast.  

02 Add contrast 
Head up to Image>Adjustments> 

Brightness/Contrast. In the window that 
appears, drag the Contrast slider to a 
maximum value of 100 to give your image a 
real boost of contrast. Click OK to apply.

01 Crop the image 
Open your image in Photoshop and 

grab the Crop tool from the toolbox. Make a 
tight crop around your subject while holding 
Shift on the keyboard to keep the crop in 
proportion. Hit Enter once you’re happy. 

04 Remove blemishes 
Grab the Spot Healing Brush (J) 

with a brush size of around 20px. Make sure 
that the Content-Aware option is ticked at 
the top, then paint over any imperfections 
on the fl ower to quickly remove them.  

03 Boost saturation 
Go to Image>Adjustments>Hue/

Saturation. We want to boost the 
background, so click where it says Master 
and choose the correct colour (Cyans here). 
Increase the Saturation to +75 and click OK. 

06 Add a vignette 
Go to Filter>Lens Correction. Click 

the Custom tab and locate the Vignette 
options. Move the Amount slider to the left 
to around -30, then move the Midpoint 
slider right to around +70. Click OK. 

05 Sharpen your shot 
Go to Filter>Sharpen>Unsharp 

Mask. In the window that appears, set the 
Amount to 50, then move the Radius to a 
value of 2. Leave the Threshold set to the 
default value of 0 and click OK to confi rm. 

Edit Use Photoshop to enhance your fl oral shot
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Create a stunning macro masterpiece

02 Upload your image 
Click the Upload Photo button at 

the top of the list and, in the window that 
appears, locate your image. Click on it to 
select it, then click the Open button. Wait 
while your image uploads. 

01 Visit HelloCanvas 
Enter www.hellocanvas.co.uk into 

the web address bar. Once you are at the 
website, click on the orange Order Here 
button in the middle to get started making 
your canvas print. 

04 Additional features 
On this screen you can adjust the 

number of prints you’d like to order, add 
creative eff ects such as sepia toning or black 
and white, or add a wooden frame to your 
canvas. Once you’re fi nished, click Next. 

03 Adjust the canvas 
Select the size of canvas you would 

like to order, then decide whether it should 
be portrait or landscape. You can also 
determine the edge style using the options 
lower down the page. Click the Next button.

05 Place your order 
You’ll be given a rundown of your 

order. To make adjustments to this, simply 
hit Previous to go back a step. Otherwise, 
click Next to complete your order by 
entering your payment and postage details. 

Pleasing 
backdrop
Keep it plain 
and clutter-
free for a 
professional 
studio look

Stay sharp
Making sure 
your water 
droplet stays 
pin-sharp is 
the key to a 
great shot

Bright colours
Make your 
image really 
pop with 
eye-catching, 
vibrant colours

Refraction
Angle your 
camera so you 
can see the 
fl ower’s centre 
in the droplets

Share  Turn your image into wall art with HelloCanvas

      Technical tip
A macro lens is able to focus 

much closer to objects than a 
standard lens and is vital if you 
want to capture close- up images.



“Even minor 
editing can turn 
mundane shots into 
something special”

Editing

162 Creative editing  
 effects in an instant
 Unleash your artistic side

168 Fix exposures with   
 traditional skills
 Edit with adjustment layers

172 Repair old prints
 Work miracles on tattered shots

174 Fix unwanted  
 colour casts
 Take control of terrible hues

176 Add impact to black- 
 and-white conversions
 Turn shots monochrome

Improve 
your images 
with these 
post-shoot 
edits
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162
Creative 
editing

168
Fix bad 

exposure
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172
Restore old 

photos

174
Fix colour 

casts

176
Convert from 

colour
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Unleash your artistic side with our easy-to-follow guides to 
applying fun effects in Photoshop Elements

Toolbar 
Find all the tools here. 
Choose colours at the 
bottom. The front 
box shows 
foreground colour, 
while the back square 
shows background 
colour. To alternate, 
double-click on one

Menu bar
Explore what is hidden 
within these drop-
down menus in this 
top bar. We’ll use the 
Filter and Enhance 
menus over the next 
few pages, but you 
can also save, print 
and more from here

Tool Options bar 
Whenever you click on 
a tool in the Toolbar, 
further options will 
appear at the bottom 
of the interface. You 
can choose to alter the 
opacity, tool setups, 
brush type, strength 
and much more

Layers panel 
Choose to mask, 
duplicate, change 
opacity and blend 
modes, add adjustment 
layers, delete and much 
more in this side panel. 
All layer eff ects and 
multiple layers can be 
found here

Creative editing 
effects in an instant

      Technical tip
 Always duplicate your 

Background layer before 
you start a project. This 
way, any edits made to your 
photo will not be permanent 
if you hit Save. You will 
always have an original, 
untouched copy of your 
photo saved to go back to.

What you’ll need…
  A selection of 
suitable start 
photos
 Photoshop 
Elements

We used…
  Photoshop 
Elements 12

You could try…
  Older versions of 
Photoshop 
Elements or the 
full suite. 
Techniques will 
diff er, though

What you’ll learn…
How to add fun 
eff ects to your 
images in     
post-production

162
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Creative editing effects in an instant

4 Add a layer blend 
In the Tool Options bar choose Pin 

Light, 50% Opacity, Linear Gradient. The 
top layer in Layers must be selected. Draw 
a line on the canvas from the bottom-left 
towards the centre. In the Layers panel, 
change the blend mode to Pin Light.

5 Duplicate a layer 
Click on the Background layer, then 

the top-right drop-down icon and select 
Duplicate Layer. Press the eye icon next 
to the bottom layer to hide it. Click the 
new duplicate layer, go to Filter in the top 
bar, then go to Render>Lens Flare.

6 Lens fl are and levels
In the preview window, you can move 

the eff ect and alter the Brightness. When 
happy, hit OK. Go to Enhance in the top 
bar, select Adjust Lighting>Levels, then 
move the middle and right stoppers left 
on the graph to lighten the whole image.

2 Choose the Gradient tool
The new layer will sit above the 

Background layer. Click on the Gradient 
tool, then the Foreground colour square 
and select orange. Go to the Tool Options 
bar and click on the coloured gradient 
thumbnail to bring up the Gradient Editor. 

3 Set up your gradient
Click the Foreground to Transparent 

blend. Click under the coloured line in the 
dialog box to add another colour stop. 
Double-click this new stopper and select a 
new colour from the dialog box. The 
gradient now has two colours. Hit OK.

Retro fi lm eff ect Transform photos with vintage light techniques

After

Before

1 Add a new layer
To open an image go to File>Open> 

Select your chosen start photo. To fi ll your 
screen with your photo, choose View>Full 
Screen. Go to the Layers panel (right of 
your screen) and click on Create a New 
Layer at the top of the panel.
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3 Select and crop 
Select the Crop tool (C) and draw 

over your image, selecting the area to 
keep. Move the pointers and hover 
over the edges to rotate more if 
needed. When happy, press Enter.

Transform and 
crop your image

1 Activate Free Transform 
Open the start photo. Go to the 

Layers panel and double-click on the 
Background layer. Go to Image> 
Transform>Free Transform (Cmd/
Ctrl+T). Corner pointers will appear.

Split toning Colour eff ects made simple

2 Add a Gradient Map layer 
Click on the visible top layer and go to 

Enhance>Adjust Color>Remove Color, 
transforming it to monochrome. Go to the 
Layers panel, click Create new fi ll or 
adjustment layer and pick Gradient Map.

1 Duplicate for safety 
Open your photo in Elements. Go to 

the Layers panel, click on the top-right 
menu icon and select Duplicate Layer. 
Press the eye icon next to the bottom 
Background layer, hiding it from view.

4 Finishing off 
Double-click the other stopper and 

choose a pale yellow. Click on the 'Create 
new fi ll or adjustment layer' icon, choose 
Levels, and move the sliders to enhance the 
shadows and highlights. 

3 Choose a blend and colour 
Click the coloured box in the Gradient 

Map dialog box, bringing up the Gradient 
Editor. Ensure Foreground to Background 
option is selected. Double-click the black 
stopper and select a dark blue.

2 Rotate to suit  
Hover over a corner and a rotate 

icon will appear. Rotate the image, 
placing it at an angle. To alter the 
image size, hold down Shift to keep 
perspective, then move a corner 
pointer. Hit Enter.

Before

After
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Creative editing effects in an instant

4 Add a mask to the top layer
Click on the mask thumbnail. Select 

the Brush tool. In the Tool Options panel 
select a large, soft-edged brush at 40% 
Opacity. Foreground/background colours 
in the Toolbar must be set to black/white.

5 Mask and reveal 
Paint away some of the top layer so 

the face is clearer. To paint back in an 
area, switch the foreground/background 
colours to white/black by pressing the 
arrow next to the coloured squares.

6 Opacity and levels to fi nish 
For a subtle eff ect, lower the top 

layer's opacity. Click 'Create new fi ll or 
adjustment layer' on the Layers panel 
and select Levels. Move the right white 
arrow left to enhance highlights.

2 Transform to size 
Click the second image on top of the 

other in the Layers panel, go to Image>
Transform>Free Transform. Hold down 
Shift and drag a corner pointer out to 
increase its size, matching the layer below.

1 Drag and drop to merge 
Open the images and press Photo Bin, 

showing all open images. Double-click the 
base-photo image. Drag the thumbnail of 
the other photo from the Photo Bin onto 
the other open image canvas.

3 Choose a blend mode
Return to the Layers panel, click on 

the Blend Mode drop-down menu and 
experiment with the options. The results 
vary depending on the photos and their 
colour make-up. We’ve chosen Screen.

Double exposure Merge images to create striking compositions

Before After
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3 Apply the eff ect
Cmd/Ctrl-click on the top layer in 

the Layers panel to create an active 
selection, go to Filter>Distort> Spherize, 
move the slider to 100% and press OK . 
The eff ect will be applied.

Create a funky
fi sh-eye eff ect

1 Set up the Selection tool
Open your image and duplicate your 

Background layer as a backup. Select 
the Elliptical Marquee tool (if not visible 
select Rectangular Marquee and 
choose it from the Tool Options bar).

Tilt shift Miniaturise with creative blurring

2 Add a mask 
Set blur radius to 20 pixels and press 

OK. Add a mask to the newly blurred 
layer located at the top of the Layers 
panel. In the Toolbar, set the foreground/
background colours to white/black. 

1 Duplicate and blur
With your photo open, go to the Layers 

panel, click on the top-right drop-down 
menu and select Duplicate Layer, keeping 
both layers visible. Click on the top layer 
and go to Filter>Blur>Gaussian Blur.

4 Create a gradual blend
If the area doesn’t mask away, switch 

the order of the foreground/background 
colours. The feather should create a 
gradual blend. If it’s too harsh, switch to 
the Brush and manually mask away.

3 Erase your selection 
Go to the Rectangular Marquee tool, 

and in the Tool Options bar select 
Elliptical. Set the Feather to 100 pixels. 
Draw an ellipse over the area of the image 
you wish to be sharp and press Delete. 

2 Create a new layer 
Holding down Shift to keep 

perspective, draw a circle over the 
central part of your image. With the 
selection active, press Cmd/Ctrl+J to lift 
the selection onto its own layer.

Before

After
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Creative editing effects in an instant

Zoom burst Use the Radial Blur to add motion

2 Add radial blur
Click Filter in the top menu bar and 

select Blur>Radial Blur. In this dialog box, 
check the Zoom option. Good quality is 
fi ne. The Amount slider is what you move 
to control the impact of the zoom eff ect. 

1 Duplicate and hide
Duplicate your Background layer, as 

this blur eff ect will be applied to your 
photo layer. Hide the base layer and click 
on the newly duplicated top layer in the 
Layers panel.

4 Undo and repeat
Go to Edit>Undo Radial Blur (Cmd/

Ctrl+ Z) and repeat the process until 
happy. If you want to experiment further, 
add on a mask like shown in the tilt shift 
step-by-step for a gradual blur eff ect.

3 Trial and error 
There isn’t a preview mode in this 

dialog box, so the end result can be trial 
and error. Start off  with an Amount of 50, 
press OK and see the eff ect applied. If 
you want to alter the level you can.

Add motion blur 
speed eff ects

3 Mask away to fi nish 
Select Brush tool. Set foreground/

background to black/white. In the Tool 
Options bar, set Opacity to 30% and 
pick a large, soft brush. Paint on your 
photo, masking away some blur. 

1 Duplicate fi rst layer 
With your start photo open, go to 

the Layers panel. Click on the top-
right menu button and select 
Duplicate Layer. Click the top layer in 
the Layers panel, highlighting it blue.

2 Add your blur 
In the top options bar, click Filter> 

Blur>Motion Blur. Experiment with 
the Angle and Distance and hit OK. Go 
to the Layers panel, click Add a Mask 
icon and click on the mask thumbnail.

Before

After
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Use adjustment layers to emulate the traditional practice of dodging and burning

Fix exposure with 
traditional skills

By using the Dodge and 
Burn tools the image has 
more colour and detail

This image is rather dark and 
lacks detail and punch

Before

168
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Fix exposure with traditional skills

Add a Burn layer 
02  Add a second Curves layer, but 

pull the Curve down hard with 
a single point for your burn effect. Invert 
the layer mask. Rename Burn. Add a third 
adjustment layer for Hue/Saturation.

Zoom in 
05  Use Cmd/Ctrl and ‘+’ to zoom in to 

dark areas. Hold down Space and 
click and drag to move around. Resize the 
Brush tool with ‘[‘ and ‘]’ and press 3 to set 
the brush Opacity to 30%.

Layers and layers We begin by creating lots of layers

Add a Dodge layer
01 Add Curves adjustment layer using 

bottom button on the Layers 
palette. Push Curve up hard with a single 
point. Invert layer mask using Cmd/Ctrl+I. 
Double-click layer text. Rename Dodge.

Set up the Brush tool 
04 Press ‘D’ to reset colour palette to 

white and black; ‘B’ for Brush tool. 
Set it to 0% Hardness. We’ll use Dodge to 
bring out detail in the darker areas. Click 
Dodge layer mask to make active.

Saturation layers 
03 Push Saturation to +35. Invert the 

mask. Double-click layer text and 
rename ‘Sat Increase’. Add Hue/Saturation 
layer and pull the Saturation slider down 
to -35. Invert and rename it ‘Sat Decrease’.

Dodge to balance tones 
06 Brush over the dark areas as 

many times as necessary to 
lighten them to match similar tones. In our 
image, the stone wall on the left needed 
balancing to match the right one.

D odge, Burn and Sponge are three 
tools packaged within Photoshop 
that should spend most of their 

time locked in the cupboard under the 
stairs. They’re destructive, meaning that 
if you use them directly on a pixel-based 
layer, you’ve only got the Undo command 
should you decide that you’ve made a 
proper mess or aren’t happy. And this 
means undoing everything else you’ve 
done in the process. 

A better, non-destructive method is to 
use adjustment layers and their masks. 
Separate Curves layers can be used 
instead of Dodge and Burn, and separate 
Hue/Saturation layers can be used as an 
alternative for Sponge. The layer mask 

allows you to apply these edits to specific 
parts of the image just as you would with 
those naughty Dodge, Burn and Sponge 
tools, but this time all of your work is 
recorded on the layer mask and undone 
at any time by simply brushing with black 
instead of white. 

But why should you dodge, burn and 
alter saturation in the first place? Well, 
quite often the lighting or tones that nature 
provides aren’t always the most beautiful. 
Dodging can draw attention to pivotal 
details, while burning is great for knocking 
back elements that are better hidden. 
Saturation is great for focusing the eye to 
the centre of the frame, and used together 
they’re a formidable image-editing team.

What you’ll need…
 Digital photo

Image-editing software or app

We used…
 Photoshop

You could try…
 Elements

 iPhoto

 GIMP

 PhotoPlus

Own brand software

What you’ll learn…
How to use Dodge and Burn

How to use adjustment layers

How to use the Brush tool
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Simple ways to 
improve exposure

Brightness/Contrast
This handy tool is again found 
in the Adjustments menu. This 
two-slider tool allows you to 
alter both the brightness and 
the contrast in your photo. 
Make sure you have checked 
the Preview box so that you 
can see what effect you’re 
having on your image. Don’t 
push it too far.

Shadows/Highlights
Head to Shadows/Highlights in 
the Adjustments menu to alter 
exposure. Let the computer 
work out settings for you or 
play with the two sliders. Work 
on an adjustments layer to 
make edits non-destructive.

Curves
Add a Curves adjustment layer 
and create a gently sloping ‘S’ 
shape to create the perfect 
balance of shadows and 
highlights in your photo.

Dodge the details 
08  Work around the rest of the 

image, picking out areas to 
lighten. We chose to lighten the flowers 
in the foreground and the chairs in the 
centre of the shot. We also worked over 
the spot lamps along the top.

Let’s get dodging… …and burning

Dodge people 
07 Elsewhere the tones are pretty 

symmetrical, so we’ll use Dodge 
to draw attention to important areas. The 
people and the stall are good starting 
points for us; zoom in close and brush 
over important parts in your image.

Burn windows 
10  Press 0 for 100% Brush Opacity, 

size the brush very small and 
zoom in on areas that need lightening. We 
worked on detail in the window without 
touching the walls in between, which 
would become too dark at 100% Opacity. 

Burn corners 
09 Click the layer mask on the Burn 

layer. We’re going to use a very 
large brush at 30% to darken the top-right 
and top-left corners to focus attention 
towards the middle of the shot. Brush 
twice over each corner – don’t overdo it.

Brush the colour in
12 We worked over the people, pews, 

the foreground foliage and any 
areas with orange light, as well as the back 
wall, including the stained-glass windows. 
You can alter the Saturation slider if you 
want to increase or decrease the effect.

Sat increase
11 Saturation increases bring out 

colour in important areas. Click the 
Sat Increase layer mask. Stay at 100% 
Brush Opacity to increase the colour in our 
chosen areas by the same initial setting of 
+35 as we did with our burn.

3 of the best…
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Fix exposure with traditional skills

Quick Photoshop tips
Dodge and burn in colour
Traditionally, dodging and burning were 
used on monochrome images. The 
process of removing colour already 
affords a sense of unreality so 
adjustments to tonality rarely bother the 
viewer. Colour imagery provides greater 
expectations of reality, as it’s viewed as 
being that much closer to an authentic 
reproduction of the world. This means 
dodging and burning tend to have a 
much stronger impact on the eye, 
appearing to drive a scene more towards 
a cartoony mood. If you’re trying to 
maintain a semblance of reality, you’ll 
need to be conservative with your 
adjustments and focus them on larger 
areas rather than details.

Converging verticals
When shooting large structures, you’re 
going to have to point your camera 
upwards, and this means that the verticals 
are going to lean inwards. Correct this  
by running Edit > Transform > 
Perspective on a duplicate of 
the Background layer.

Burning for the corners
If you’re using dodge or burn layers to correct large areas 

rather than small details, you need to use a very large 
brush for a more graduated effect. Zoom far out and pull 
the edges of the window to reveal an area outside of the 

canvas, then work with the brush edge for subtlety.

Brush the colour out 
14 Resize the brush to suit and 

carefully brush the adjustment 
into the areas in your image that need the 
colour knocking back a bit. Pulling out the 
colour in our image also made the orange-
lit areas look more impressive.

Sat decrease 
13 To reduce saturation in certain 

areas, click the Sat Decrease 
adjustment layer mask. Work at 100% 
here as -35 is a good setting. The stone 
work has a green tinge, so we can use this 
layer to pull some of that colour out.

Sharpen to finish 
15 Run the Unsharp Mask filter on a 

duplicate of your Background layer 
(use Cmd/Ctrl+J to duplicate). A Radius of 
0.5 pixels with 300% Amount is great for 
a full-res image, though you may need to 
go as low as 80% for some photos.
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D ig out old photographs and load them into 
Photoshop Elements 12 to restore them 
back to their former glory in just a few 

clicks. Follow our steps for using the Restore Old 
Photo guided edit, and see how it can work miracles 
on tattered, scratched and torn images.

Over time, photos can deteriorate in quality for 
a number of reasons. These include fading and 
discolouration, caused by too much exposure to 
sunlight, or bent corners and scratches from being 
stored loose in a box. These, along with other 
factors, can destroy photographs that could reveal 
clues to our past.

If you have images that have suffered from a 
tear here, or a crease there, scan them in to your 
computer and the new Restore Old Photo feature in 
the latest version of Photoshop Elements offers the 
right tools for undergoing some serious restoration. 
From the Spot Healing tool for dealing with those 

small, indiscriminate blemishes, to the Clone Stamp 
tool for gradually weeding out larger areas such as 
tea stains or faded corners, you’re sure to find what 
you need.

Once all of the blemishes have been cleaned 
up, converting your image to black and white 
will remove any discolouration or sepia toning. 
Sharpening and Dust Removal also form part of 
this new guided edit, but they are not necessarily 
required for every restoration project. As a guided 
edit, Elements makes it very easy for anyone of any 
ability to follow along, but working knowledge of 
the tools is still required for making the very best 
results possible. 

When you’re happy with the final restoration, we 
even show you how to really bring the image to life 
by adding colour. The end result is a transformation 
worthy of framing on the wall or showcasing in the 
family tree.

Use Elements 12’s Restore Old Photo guided edit
Repair old prints

Before After

What you’ll need…
     Editing software
An old photo

We used…
   Photoshop 

Elements 12

You could try…
   GIMP

What you’ll learn…
  How to repair 
tears and stains 
and restore 
colour using 
the Restore 
Old Photo 
guided edit



173

Repair old prints

New view mode
01 Open an old photo in Elements 

12 and click on the Guided tab. 
Pick the Restore Old Photo option from 
the list of edits down the right. From the 
top-left, set the View mode to Before & 
After – Horizontal. 

Spot the marks
02 Crop the image by clicking on 

the first option. Look to remove 
raggedy edges and to straighten the 
image. Click on the Spot Healing tool and 
draw over small specks and white marks 
to remove them. 

Heal pixels
03 Use the Healing Brush on 

medium-sized specks and 
crease lines. Hold Opt/Alt to sample 

‘good’ areas and then paint over the ‘bad’ 
pixels. Use the Clone Stamp in a similar 
way to fix the largest areas.

Complete coverage 

04 Using the Spot Healing, 
Healing Brush and Clone 

Stamp tools, go over your image in order 
to heal the remaining problem areas. Be 
sure to sample areas of similar pixels so 
that the results look clean.

Restore shots  Give a new lease of life

Restore colour
05 Finally, 

click on 
Convert to Black & 
White to remove 
the sepia colour. 
Using Auto Levels 
and Contrast will 
adjust the exposure 
to normal. Go back 
over the image with 
the Blur tool to hide                  
any imperfections.

Colourise black and 
white images

Brush setup 
Change the layer’s blend mode to 
Color. Select the Brush tool (B) and 
in the Tool Options choose a soft, 
round, 100px brush. Click the 
Foreground colour box and set its 
colour to a fl eshy tone.

Expert mode
After restoring the image to black 
and white, you can add colour using 
Brushes. After hitting OK in the 
Guided Edit, click on the Expert tab. 
Click on Create a New Layer at the 
top of the Layers panel. 

Apply colour
Brush over the skin and watch how 
your old image suddenly comes to 
life. Select a dark brown for the hair, 
and light red for the lips. Add new 
layers for each colour, setting blend 
modes to Color. 



Goodbye blues! 
No longer is this image suffering 
from a poor colour cast – a few 
tweaks and the strong, bluish 
tint can be reduced
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W hite balance, or colour 
temperature, is usually 
taken care of by the camera 

automatically at the moment an image 
is captured, but it’s not always accurate. 
Auto white balance settings can struggle 
in strong or mixed lighting conditions, 
which will result in unwanted colour casts. 
When an image has the wrong colour 
balance, it will appear to have an obvious 
tint of either blue or red. The strength of 
this tinting can, in some cases, damage 
colour in your image beyond repair. 

To help you sort out your white 
balance woes, we have picked out three 
applications that can correct colour casts 
quickly and accurately.

1 Once you've brought an image 
into PhotoPlus, adjusting 

colour can be done with an 
adjustment layer. To add one, go to the 
Layers menu along the top and down to 
New Adjustment Layer>Color Balance. 

Fix unwanted 
colour casts
Take control of terrible hues and learn to  
balance colour for better images 1 One way to correct colour in 

Elements 12 is to go into the 
Quick mode using the top 

buttons, and then click on Balance. Use 
the slider to offset the cast, moving it to 
the right to reduce a blue cast. 

1 Open the app and tap the 
middle button along the 

bottom (picture with a plus 
symbol in the corner). Pick the Gallery 
option to load an image from your stored 
photos. Tap it to go straight into the app.

Photoshop Elements 12
Available on: Mac/PC Price: £78/$100

Photoshop Touch for phone
Available on: iOS/Android Price: £2.99/$4.99  

Serif PhotoPlus X6
Available on: PC Price: £71/$90

What you’ll need…
  Photo with a colour cast
 Editing software

We used…
  Photoshop Elements 12
  Serif PhotoPlus X6
   Photoshop Touch

You could try…
 Lightroom 
  Photoshop CS or above
 GIMP

What you’ll learn…
Use auto commands
Add colour adjustments
Balance colour in images
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Fix unwanted colour casts

2 The adjustment will load as a new 
layer inside the panel. If you don't see 

it load, double-click the Color Balance 
thumbnail in the panel. As this image is 
predominantly blue, start off by sliding 
the Yellow/Blue pointer to show 0, 0, -31.

3 Notice how there's still a hint of a 
green cast in the shadow regions. To 

correct this, slide the Magenta/Green 
adjustment to -10 (the figures should read 
0, -10, -31). That's the midtone areas fixed. 
Now click on the option for highlights.

4 Colour can even be tweaked by going 
to Layer>New Adjustment Layer> 

Photo Filter. Apply a Warming Filter (81), 
at 50-60% Density, with Preserve 
Luminosity ticked. This will offset the blue 
cast. Use a Cooling Filter for red casts.

2 Inside, tap on the Adjustments button 
at the top. A menu containing a 

number of image fixes appears. Try Auto 
Fix first to see what kind of results this 
gives. If it is not to your liking, press the 
back arrow in the top-right to undo.

3 Go back into Adjustments and choose 
the Temperature option. This is much 

easier to use than the Color Balance 
adjustment. Temperature has one slider 
that controls the amount of blue and red, 
to cool down or warm up the image.

4 To reduce a strong, blue cast, slide up 
the adjustment until it reads around 

45-50%. Tap the tick button to confirm 
the changes, and then tap Done in the 
top-left of the Photoshop Touch interface 
to save the image to your device.

2 If the first method doesn't fix the colour 
cast, try going into Expert mode instead. 

In the Enhance menu along the top of the 
Elements interface, click on Auto Color 
Correction. This is an instant way to fix a 
subtle colour cast. 

3  Another method for removing a 
colour cast is to go to Enhance>Adjust 

Color>Remove Color Cast. Use the 
eyedropper to click on parts of the image 
that should be either black, white or grey, 
until you see normal colours return.

4 There's still a slight hint of blue in the 
white areas of the image. Slide the 

Yellow/Blue down to -15 to colour balance 
the highlight regions. View a before and 
after of the corrected image by clicking on 
the eye symbol on the layer. 
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E arlier in the book we showed you some 
top tricks for shooting in black and 
white, including five tips on how to make 

monochrome masterpieces in camera. So now 
you have got some cracking shots, you will need 
to know how to convert them to black and white 
in Photoshop! 

There are many ways to do this, one of the 
easiest being to move the saturation slider all 
the way down to strip away the colour, but these 
quick methods can often lead to flat and dull 
tones. If you spend just a little more time and use 
some simple tools effectively, you can really make 
your tones leap out.

If you shot your images in RAW, you’ll be able 
to take a lot more control over your shots. Open 
them in a program that supports RAW files such 
as GIMP. If you’re using Adobe Camera Raw, click 

on the HSL/Grayscale tab and click Convert to 
Grayscale, then use the sliders to control the 
tones. You may also want to use the Tone Curve 
and Fill Light slider to adjust the tones even more. 
If you’re using a RAW file, you can then open it in 
Photoshop and skip step 1 of the below tutorial. 

If you’re using JPEGs, though, you can get stuck 
in from step 1 and we’ll show you how to make 
your black and white tones really pop! All it takes 
is some blend modes and a contrast adjustment 
layer – it’s easy to do and really effective. We even 
show you how to do the same effects in GIMP 
over in our boxout. After this tutorial is complete, 
you may want to explore other editing options 
such as sharpening (Enhance>Unsharp Mask in 
Elements) and Shadows/Highlights to really finish 
off your shot. Let’s get started converting better 
black and whites!

We show you a great way to convert from 
colour using Photoshop Elements and GIMP

Add impact to black-
and-white conversions 

Before After

What you’ll need…
     Colour photo
Editing software

We used…
   Photoshop 
Elements 11

You could try…
   Photoshop CS
   Other Photoshop 
Elements versions

    GIMP

What you’ll learn…
  How to make 
your conversions 
really pop
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Add impact to black-and-white conversions

Duplicate and convert 
01 Open up your image then 

duplicate it (Layer>Duplicate 
Layer). Now go to Enhance>Convert to 
Black and White, pick a default and adjust 
the red, green and blue sliders until the 
tones look their best.

Duplicate the new layer 
02 There are ways to make tones 

pop more. Duplicate this black 
and white layer twice, either by going to 
Layer>Duplicate Layer, or dragging the 
layer to the ‘Create a New Layer’ icon in 
the Layers palette.

Set to Color Burn
03 Rename the layers by clicking 

on the text and changing it 
to something memorable. For the first 
duplicate black and white layer, set the 
blend mode to Color Burn, at an Opacity 
between 5 and 15%. 

Set to Soft Light
04 For the second duplicate layer, 

set the blend mode to Soft 
Light and Opacity between 5 and 15%. 
The tones should now have more depth. 
Turn off the layer to see the effect it’s had 
by clicking the eye symbol.

Go monochrome  
Add depth to your conversions

Increase 
contrast
05 Go to 

Layer>New 
Adjustment Layer> 
Brightness/Contrast or 
click on the adjustment 
layer symbol in the 
Layers palette. Now 
increase the sliders 
until you get the 
effect you want. Go to 
Layer>Flatten.

Convert in 
free editing 
program GIMP

Set blend modes 
Duplicate this black and white layer 
three times (labelling them as you 
go) and set the blending mode of 
one to Burn with a 5-15% Opacity, 
and the second to Soft Light (also 
5-15% Opacity). 

Convert to monochrome
Open the image in GIMP then 
duplicate the image (Layer>
Duplicate Layer). Now go to Colors> 
Components>Channel Mixer, tick 
Monochrome and adjust the sliders 
to get the tones you want.

Increase contrast
With the third duplicate layer we will 
increase the contrast. Go to 
Colors>Brightness-Contrast, adjust 
the sliders, then click OK. Finally, 
select Image>Flatten image then 
you can save it.



Sharing

180 Upload your photos on   
 Twitter and Flickr
 Create a gallery and share it

182 Upload your photos 
 to Facebook
 Share via Facebook

184 Collaborate on an online  
 photo album
 Be part of the community

186 Back up using iCloud 
 and Photo Stream
 Sync between devices

188 Make a slideshow 
 with iMovie for Mac
 Put images in a slideshow

Give your 
friends and 
family the 
chance to see 
all your shots
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180
Use Twitter 

and Flickr

188
Make a 

sideshow
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Stream
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Share your photos  
on Twitter and Flickr
Learn how to invite your Twitter followers to view your best images on Flickr

B rowsing through photo albums online is now 
the norm for many. It’s easy, convenient and 
more suited to everyone’s busy lifestyles. As 

such, sharing your shots through sites like Facebook 
has become a fuss-free click of a button.

Like Facebook, the micro-blogging site Twitter 
offers photo sharing as part of its service, but only 
one image at a time. There are also plenty of third-
party image-hosting websites out there that’ll link to 
your account safely and securely. 

For this tutorial we’ll be using Flickr, a photo-
sharing site with added Facebook and Twitter 
functionality. Flickr is a reputable site that enables 
you to upload full albums, individual pictures and 
short video clips. This free service enables you to 

store and organise the photographs however you 
wish, using different names, categories and so on. 

When you join the site, you’re joining a 
community. Aside from being home to billions of 
images, Flickr features groups you can join and a 
search function for you to browse for inspiration. 
But you won’t have to share with anyone you don’t 
want to – there’s the option to tweak security and 
privacy settings on your own photos.

Once you’ve uploaded your images to your Flickr 
account, it’ll generate a shortened web address 
that transports your audience directly to the album 
or picture you’d like to publicise. Simply add this to 
your Tweet and your followers will have access to 
your snaps in no time.

Display your best images 
online for the world to see  
via sites like Flickr

Sharing

Twitter is a great way to 
share holiday snaps with 
friends and family easily

What you’ll need…
     Photos
Twitter account

We used…
   Flickr

You could try…
   Twitpic
 yFrog
   TwitrPix

What you’ll learn…
  How to integrate 
Twitter with Flickr
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Share your photos on Twitter and Flickr 

Finishing touches 
4 The pink progress bar under the list 

of filenames indicates how long the 
upload process will be. When completed, 
click on your images to change the names 
and add descriptions and additional 
comments. Make sure you click Save.

Authorise sharing 

5 Click on the Share icon (a box with an 
arrow) in the top right of the screen 

to see a list of sharing options, including 
Facebook and Tumblr. We want to share 
on Twitter, so click the Twitter icon and 
then ‘Authorize app’  to authorise sharing.

Post on Twitter 
6 Once the two accounts are linked, 

you will be able to post on Twitter 
directly from the Flickr page. A pop-up 
Twitter window will appear containing a 
short description and a link to your Flickr 
photostream. You can edit these details. 

Other ways to share 
7 When happy to proceed click on Post 

and the link will be posted to Twitter. 
You can also link and post to other 
accounts from the share menu, or click on 
Grab The Link to copy the link and share it 
manually to your other networks. 

Create a Flickr account
1 Go to www.Flickr.com and click Sign 

up. Flickr is owned by Yahoo!, and 
creating a Flickr account will also create 
a new Yahoo! account. If you have an 
existing Yahoo! account, click Sign in to 
access Flickr with your Yahoo! details. 

Choose your snaps 
2 To upload photos, go to Upload on 

the top bar and click on the pink 
‘Choose photos and videos’ bar. A pop-up 
box will appear, listing the items you have 
on your computer. Locate you images, 
pick your pictures and press Open.

Upload the photos
3 You’ll now see your shots in a grid. 

To get rid of one, just highlight it 
and click on the cross. You can also add 
descriptions, change the privacy settings 
and make basic edits. When happy, click 
the blue upload button in the corner.

Social-network sharing Show off your best shots

Nicholas Samaras  
(@NSUWP)

Nicholas is a great underwater 
photographer and most of his 
Tweets tend to point you to his 
latest work.

Todd McLellan  
(@Todd_McLellan)

Todd’s portfolio is varied and 
enjoyable to browse through. Of 
particular interest is his very cool 
‘Disassembly Project’.

David Bailey  
(@BaileyQuotes)

The official Twitter feed from 
photographer David Bailey – his 
Tweets are short and sweet, but 
worth a gander.

Daniel Berehulak  
(@berehulak) 

Daniel is a staff photojournalist for 
Getty Images based in New Delhi. 
His work is both poignant and 
rather impressive.

Photographers to 
follow on Twitter

4 of the best…
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Upload your photos  
to Facebook
Discover how to publish your pictures through this social-networking site

L ove it or hate it, Facebook is one of the 
most popular and influential websites ever 
created. It’s also made the world a smaller 

place, reuniting long-lost family members and 
acting as a powerful tool of communication and 
socialisation for the many people that use it. 

If you’ve not done it before, setting up an 
account (also known as a profile) with Facebook 
is free and easy to do. Once you’ve created this 
profile, there’s plenty of scope for personalising 
your page, and sharing your photos through the 
site is one way in which to do this. 

Publishing photographs to Facebook is a great 
way to update friends and relatives on your latest 
antics and activities. From family gatherings 

to birthday parties or trips to the park, sharing 
photos  through Facebook offers others a chance 
to indulge in the event – whether it’s to relive the 
occasion or to take a look at what they missed. 

As for the photos themselves, it’s often a good 
idea to group them into themes or categories to 
make it easier for people browsing through. This 
is especially relevant if you plan to upload a lot of 
photos to your profile page. For example, creating 
folders titled ‘Holiday snaps’, ‘Dave & Cara’s 
wedding’ and ‘Our new house’ on your computer 
will help organise them all when you transfer 
them to your account. You can then edit the 
details, giving them the same filenames, on your 
Facebook ‘Photos’ section of your profile.

What you’ll need…
     Photos to share
An email account
An internet 
connection

We used…
   Facebook

You could try…
   Twitpic
 iPhoto

What you’ll learn…
  How to share 
photos on Facebook

To save time, you 
can even edit your 
album information 
while its contents  
are uploading

Once you’ve signed 
up, it’s easy to upload 
your photos

Find the friends 
you want to show 
your photos to
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Upload your photos to Facebook

Publish images to Facebook Upload and share photos

Who can see
4 Before clicking Post Photos to add 

images to Facebook, select who can 
see them by tapping the arrow next to 
the Post Photos button. You can choose 
between Public and Friends, or custom 
enables you to select certain people.

Add information and Post
5 Underneath each photo are three 

buttons, which you can tap to add 
more information about the image. The 
person tags people in your picture, the 
clock adds a time, while the pointer adds 
a location. Click Post photos when done.

Tag friends
6 Facebook is equipped with facial 

recognition software, so if any shots 
have people in them, you can ‘tag’ them. 
If they are on Facebook it emails them 
with a notification. It may automatically 
recognise when a face needs tagging.

Add contributors
7 When images are uploaded, you 

can allow friends and family to add 
photos to your album. Click Make Shared 
Album then add names of the people 
you’d like to contribute into the text field. 
Click Save when you’re done.

Create an account
1  To register, go to www.facebook.

com and fill in the details requested 
in the Sign Up panel. Once you’ve done 
this, click Sign Up. If you already have a 
Facebook account set up, log into it in the 
usual manner and go to step 2.

Personalise your page
2 Once you’re on your profile page, 

click on the Photos tab along the 
top bar. Now you’ll see the Create Album 
button. Click on this and give your album 
a name, then click on the Add Photos 
button in the middle of the screen.

Pick your pics
3 You will now be invited to upload 

images. Navigate to where your 
images are kept and select the files you 
would like to upload. Once selected, click 
Open. Select as many images as you wish. 
The images will then begin to upload.

Getty Images
Getty Images’ Facebook 

page is a great source of 
inspiration. It is updated  
frequently with photos on a  
variety of subjects.

Abduzeedo 
Abduzeedo is a design 

inspiration website, so its Facebook 
page publicises the latest content 
to be uploaded there.

Flickr
Flickr’s Facebook page is 

home to an excellent photographic 
community. Its Newsfeed contains 
plenty of helpful info.

Photography For 
Beginners

Check out Photography for 
Beginners magazine’s Facebook 
page for photos and tips that’ll help 
while you’re out and about.

Photographers  
& organisations  
on Facebook

4 of the best…
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Collaborate on an 
online photo album 
Use Photobucket Stories with friends and family

P hotobucket Stories are a recently-added 
feature to the Photobucket image-
hosting service. It allows multiple users to 

collaborate on the creation of a ‘story’ by uploading 
images, videos and text. 

The software’s editing and sharing features are 
simple to understand and allow you to choose your 
individual levels of privacy. You can also connect 
your devices with the Photobucket app from iTunes 
and Google Play. 

This sort of story-telling format is great for 
occasions when a lot of people, who are not 

geographically close, get together for special 
occasions. Weddings, birthdays and holidays are all 
perfect opportunities for a Photobucket Story. The 
great thing about having many contributors is that 
even if you missed the perfect shot, someone else 
may have bagged it. With Photobucket Stories you 
can add it in with the rest of your pictures. 

You can link your Photobucket account and 
stories to Facebook, Twitter, Pinterest etc after you 
have created your story. We’ll show you how to 
get started and to create an album that family and 
friends can share. 

Multiple users are 
able to collaborate 
on the creation of a 
‘story’ by 
uploading images, 
videos and text

Link your 
Photobucket account 
and stories to 
Facebook, Twitter, 
Pinterest etc after you 
have created your story

What you’ll need…
     A Mac or PC
Start images

We used…
   photobucket.com

You could try…
   Photobucket app

What you’ll learn…
  How to set up, 
create and share 
a collaborative 
Photobucket 
Story
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Collaborate on an online photo album

Create a Photobucket Story  Share your story online

Upload to Photobucket 
3 You’ll be offered different ways of 

uploading pictures: either drag and 
drop the files from your desktop, use the 
app, or add from Facebook. The uploader 
allows you to add several files at once by 
holding Shift as you scroll and select.

Set up an account 
1 Head to photobucket.com and set up 

an account. You get 2GB of storage 
for free or you can upgrade later. To save 
setting up and remembering another 
set of details you can sign in using your 
Facebook or Twitter account.

Go to your account
2 You’ll be presented with options 

about connecting your devices – you 
can either browse them or just click the X 
in the top right-hand corner and you’ll be 
through to your blank account. Now click 
on the Choose Photos & Videos button.

Start your story 
5 Any images you’ve already uploaded 

will be offered to you to add straight 
away, but you can browse other albums 
or upload again. Click your images to 
select and add the chosen few by clicking 
the Add button in the bottom-right.

Create a story 
4 The Create Story button is on the 

left-hand of your Photo Bucket 
homepage. There is a video tour available 
to show you what a finished story could 
look like and it is useful to see how text 
and video elements can be incorporated.

Personalise your story 
6 Tailor your story before you invite 

others to collaborate. Hover over 
each photo for a drop-down menu, which 
enables you to edit and resize the image. 
You can also add backgrounds, text  and 
other media via the bottom menu.

Share your story 
7 Share your story by clicking the 

Invite Contributors button top-right. 
You can invite some existing Photobucket 
users or invite others to join in via email. 
You are also able to share a story via 
Facebook or Twitter. 

Muzy
Muzy has over 20 million 

users worldwide and allows sharing 
and editing of pictures either 
through the phone app or your 
web-based Muzy profi le. 

Instagram
Instagram also facilitates 

photo sharing and editing, and 
currently has over 100 million users 
with superb edits and fi lters for 
retro-looking images.

Flickr
The offi  cial app for the 

world’s largest photo-sharing site. 
Flickr also has built in-camera/
editing functions to share you 
images in the moment.

Livemapp
Livemapp allows you to 

snap and share your travel images 
by pinning them on a map, so 
they’re available for your Livemapp 
community to enjoy.

Apps for sharing
your photos

4 of the best…
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Sharing

Back up using iCloud 
and Photo Stream
Take advantage of iCloud’s awesome free photo back-up 
and sharing service

P hoto Stream is an excellent concept, 
letting users share and back up their 
latest and greatest photographs with little 

to no effort. The system is based on iCloud, so 
you will need to have at least OS X Lion 10.7.2 and 
iOS 5 set up and running on your Mac and iOS 
device respectively. 

With the updates added and iCloud set up, all 
you need to do is enable Photo Stream and the 
system will begin to collect your most recently 
taken shots on your iPhone or iPad. They then 
become instantly visible on all of your iOS devices 
and Mac (as long as you’re connected to Wi-Fi). 

There are a couple of conditions, which is to be 
expected with a free service. The limits imposed 
on storage are up to 1,000 photographs or 30 
days worth of images. If you reach either of these 
limits then any photographs that are taken or 
stored afterwards will replace the earlier ones 
that were added. So, as a backup, you have a limit, 
but as a sharing service you always have the most 
recent pictures. 

Photo Stream is wonderful because you will 
never need to connect your iDevice to iPhoto 
again, as they are automatically saved in a new 
event. Here’s how to use it…

Effortlessly back up 
your precious images

What you’ll need…
  i    Photos
Twitter account

We used…
   Flickr

You could try…
   Twitpic
 yFrog
   TwitrPix

What you’ll learn…
  How to integrate 
Twitter with Flickr
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Back up using iCloud and Photo Stream

Using iCloud Set up a Photo Stream on your Mac

iPhone and Contacts
Sync contacts via all your devices
iOS 5, iOS 6 and iOS 7 enable you 
to create new contacts or update 
old ones with email addresses and 
the like, and then sync them across 
multiple devices.

iPad and iBooks
Read on any iDevice
Buy a book on your iPad and iCloud 
will remember it so you can access 
it via your iPhone or Mac later.

Documents in the Cloud
Change the way you work 
Start a spreadsheet on your iPad 
and then pick up where you left off  
on your Mac later on that day when 
you’re back in the offi  ce.

Mac and iTunes
Making music accessible
The new iTunes and iCloud work 
together to remember your 
purchase history and download the 
same songs to multiple devices.

Import existing pictures 

3 All of the pictures you have taken 
within the last 30 days will begin to 

fill the interface in iPhoto. You can now 
view these images as you would any 
other photos. Drag them into the Pictures 
folder to save and keep them locally.

System Preferences
1 If you have already set up iCloud, 

you’ll come straight to this screen 
after clicking the iCloud icon from your 
System Preferences. All you need to do is 
enable the service by clicking the tick box 
in the options provided. 

iPhoto 

2 You will need to make sure that your 
copy of Apple iPhoto is up to date. If 

it is, you will see the screen above when 
you click iCloud on the left-hand side of 
the interface. Click Turn On Photo Stream 
and it will begin to populate.

Visit the cloud
5 Open your web browser and go 

to www.iCloud.com, enter your 
username and password, and then click 
on your name at the top of the browser. 
That will bring up the screen shown 
above. Click on the Advanced option.

Deletion
6 As with all permanent moves on a 

computer, you will be prompted to 
make sure you want to proceed. If you’re 
okay with this, click OK. If you wish, you 
can also reset your Photo Stream and 
remove your images from iCloud.

Add to Photo Stream 
4 If you want to add new pictures to 

your Photo Stream from your iPhoto 
library, just click on the image, hit the 
Share button (in the bottom-right corner 
toolbar) then click on the Photo Stream 
option. It’s as simple as that.

iCloud on iOS devices
Apple’s iCloud and Photo Stream 

services are fantastic for backing up, 
as long as you activate them on your 
devices first! Open the Settings app 
and go to the iCloud category. Go to 
Photos and make sure the My Photo 
Stream slider is to the right.

iCloud features of 
iPhone & iPad

4 of the best…
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Sharing

Make a slideshow 
with iMovie for Mac
Assemble your favourite images into a video slideshow, 
adding transitions, effects and music 

C reating a slideshow of photographs has 
always been a great way to exhibit your 
latest work, and with image software like 

Preview on Mac or Photo Gallery on Windows, 
it’s no trouble to assemble your snaps into a 
slideshow quickly. If you want to take things a 
step further and create a more advanced and 
detailed slideshow, giving yourself complete 
control over the positioning, presentation and 
duration of your images, then check out this 
tutorial. We’ll show you how to build a slideshow 
out of your images using iLife’s iMovie software, 
which is available on Mac. iMovie is made 
primarily for editing together video clips, and 

because of this it has the perfect interface for 
assembling a slideshow using a series of images. 
You’ll also be able to use iMovie to add extra 
content to your slideshow including transitions, 
titles, music, sound effects and more. You can 
also use it to crop your image and make edits like 
colour correction.

Once you’re happy with your creation you 
can simply export the slideshow in a variety of 
different ways, uploading it directly to YouTube, 
posting it on your Facebook account or burning 
it onto DVD using iLife’s iDVD. Follow these 
simple steps to start piecing together a fantastic 
slideshow of your own.

Share
The new Theatre mode 
in iMovie lets you 
upload your movies 
to iCloud, and access 
them instantly on other 
devices too

Split
Use layers to 
stack two images 
or videos on top 
of each other 
to create a split 
screen effect

Enhance
The Adjust 
option presents 
you with all 
that you need 
to modify and 
improve your 
image with ease

What you’ll need…
  iLife featuring 
iMovie
A collection of 
photos stored on 
your computer

We used…
   iMovie 10.01 on 
OSX Mavericks

You could try…
   All previous 
versions of iMovie

 Previous Mac OSs
   Windows Movie 
Maker

What you’ll learn…
  How to make a 
slideshow of your 
images in iMovie
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Make a slideshow with iMovie for Mac

Create a slideshow Showcase your photos in iMovie

Edit your images
4 Click on an image so that a yellow 

box appears around it, and then 
click on Adjust. Click the palette icon 
to colour-correct an image, or use the 
contrast square icon to adjust an image’s 
colour balance.

Motion effects
5 Select the crop icon above the  

image window, then select the Ken 
Burns effect. Position and resize the 
Start box, then do the same for the End 
box. This will add a motion effect to your 
selected image.

Content Library 
6 In the Content Library, click Titles. 

Drag a title thumbnail onto your 
timeline. Double-click on the text in the 
image window to edit it. Click iTunes. 
Here you can drop a music track into  
your timeline.

Share your slideshow
7 Click Share in order to share your 

video in different formats. Click File 
to export an .mp4 version of the video. 
Change the size to reduce the file size. 
Click Next, select a destination and click 
Save to export.

Create a project
1 Open iMovie. In the top toolbar go 

to File>New Movie. In the Themes 
window, select No Theme so you’re 
working with a blank canvas, then click 
Create. Title your movie. Click OK to 
create the project.

Import your images
2 In your new project, click Import, 

which can be found above your 
media library. Browse the folder that 
holds your images, select the images that 
you want to import, then click Import 
Selected/All.

Arrange your images
3 Click and drag an image into your 

timeline, and then repeat this 
process with all of your images. Click 
and drag on the edge of an image in the 
timeline in order to change its duration in 
the slideshow.

Ways to spice it up

Add a map
If you want 
to put 
together a 

travel slideshow, you can use Maps 
and Backgrounds in the Content 
Library to add location information.

Add 
transitions
In the 
Content 

Library, select Transitions. Click 
and drag a transition thumbnail 
between two photos in your 
timeline to add it to the slideshow.

Enhance 
your images 
Click 
Enhance in 

order to automatically improve the 
colour and contrast of your 
images. You can then adjust the 
colour effects manually.

3 of the best…
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Aperture
Aperture decides how much light is let in 
to the camera, and it is measured on a 
scale of f-numbers. This setting also 
dictates how much of the image is in or 
out of focus.

SMALL APERTURE – A small-sized 
aperture of f11, f16 or f22 keeps 
objects that are in the distance 
looking sharp. 

LARGE APERTURE – Shooting with 
a large-sized aperture of f2, f2.8 or 
f4, will make objects in the distance 
appear out of focus, placing 
emphasis on the main subject 
closer to the lens.

APERTURE PRIORITY MODE – This 
lets you choose the aperture with 
which you need to shoot. You’ll find 
that the camera will automatically 
control other important settings in 
the process.    

Colour cast
Colour cast describes the tinting that an 
image may have due to the type of 
lighting used. This could be due to either 
wrong settings or for creative effect. 

Photography glossary
What does it all mean? We take a moment to talk about key 
phrases you’re likely to come across in photography

Contrast
Contrast is the vividness of the colours 
and tones in an image, and how much 
they stand out from subject to subject.   

Exposure
Exposure describes the amount of light 
that has entered the camera to form an 
image. This is dependent on camera 
settings being correctly balanced, so  
that enough light is captured for a 
perfect exposure.

OVEREXPOSE – If an image is 
overexposed, too much light has 
entered through the lens and the 
subject appears ‘bleached’ out, or far 
too white. 

UNDEREXPOSE – Underexposure is 
when not enough light has entered 
the lens, and images look dull and 
lack-lustre in their contrast and colour.

LONG EXPOSURE – Light has been 
allowed to enter the camera for 
extended periods. This is usually 
put to use to create movement in 
landscape or sports photography.      

 Filters
Filters can be applied over the lens for 
replicating certain styles or effects. 
Some types include colour, grain and 
lighting effects. A lot of compacts will 
also add in-camera filters. 

Focal lengths
Measured in millimetres, camera 
lenses have various focal lengths, 
which are used to zoom in or out on a 
subject. Focal lengths can be fixed, 
made to extend to huge distances, or 
to capture subjects close up. 

TELEPHOTO – Lenses which are 
telephoto are used to capture 
subjects that are in the distance. 
These lenses are popular with 
sports and wildlife photographers, 
using a lens with a focal length of 
200-400mm, for example.

WIDE-ANGLE – Lenses that have 
a wide angle cover a very broad 
field of view. Focal lengths 
include 15-30mm and these  
are extremely useful for 
landscape photography. 

FISH-EYE – Fish-eye lenses 
distort the scene you are 
shooting in order to produce a 
sometimes-abstract 
composition, almost creating a 
bubble effect. The focal lengths 
involved in fish-eye photography 
can be 10mm or less.

Large apertures create 
blurred backgrounds

This underexposed 
photo is far too dark
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HDR
HDR stands for high dynamic range and 
describes an image that has strong 
details, lighting and colours throughout. 

Histogram
A histogram like the one below is used in 
photography to assess the lighting 
pattern through any given image. It 
shows which areas are most inside the 
visible spectrum.

Image stabilisation
Either built in to a lens or in-camera, 
image stabilisation counter-balances 
unstable movement. This helps to reduce 
the amount of blur that is caused by  
hand movement. 

ISO
This is how sensitive the camera sensor is 
to light, starting as low as ISO 64 (which 
is not very sensitive) and up to ISO 3200 
or above (which is very sensitive). 
Sensitive ISO ratings produce the most 
distortion, however.

JPG
JPG is used in all digital cameras to 
capture images in a compressed but 
high-resolution format. Images are 
portable but they cannot be enlarged.  

Live view
Live view is available with DSLR cameras 
and it allows you to use the screen to 
compose an image. This is instead of 
using the viewfinder. 

Macro
Macro is the art of capturing subjects at 
extreme closeness, creating heavy 
blurring in the process. Subjects can be 
larger than they are in real life.

Megapixels
The number of pixels in an image is 
measured in megapixels (mp). The more 
megapixels, the larger the resolution and 
printable size of the image.   

Metering
Metering is the way in which the camera 
analyses the lighting of the scene to make 
the exposure, for example, using just the 
central part, or an average. Metering 
modes are altered according to the scene 
and also the subject.  

SPOT, OR PARTIAL, METERING – In 
this setting, the camera takes a light 
reading from the centre of the scene 
and calculates the exposure. Light in 
the background is not considered. 

EVALUATIVE METERING – This takes 
the entire scene’s lighting into 
account to make the exposure. It’s 
also ideal if you’re not sure which 
setting to use, or if the scene is 
constantly changing.

CENTRE-WEIGHTED METERING – 
This metering system is where the 
camera uses the most central part of 
the scene to calculate the exposure, 
as well as some of the surrounding 
light. It’s halfway between Spot and 
Evaluative metering.  

Noise
Created by the lack of light in a scene, 
noise is the distortion of pixels mainly 
seen in the shadow areas of an image. 
Noise occurs with sensitive ISO ratings. 

Prime lens
A prime lens has a single, ‘fixed’ focal 
length, with no zoom function, for 
example 50mm. These are popular for 
their excellent build quality and 
advanced optics.   

RAW
RAW images are uncompressed and 
high-quality. They have a level of detail 
that is second-to-none in post-shoot 
editing. This is a standard feature of 
DSLR cameras. 

Saturation
The strength, or amount, of colour in an 
image is described as ‘saturation’. A 
highly saturated image has unusually 
strong colour, and can look unnatural. 

SD/SDHC/SDXC
These are common memory cards that 
many compact and DSLR cameras use to 
store images. Measured in gigabytes, the 
larger the card size, the more photos you 
can shoot. 

Shutter speed
Shutter speed is the length of time that 
the camera sensor is exposed to light. 
Measured in fractions of a second, fast 
speeds prevent blurring.  

White balance
White balance is used to keep the colour 
of light in an image looking natural (as if 
shot in daylight). Types of white balance 
include tungsten, flash and fluorescent.

Reference

The histogram should have an  
even spread

Choose your metering system wisely 
to get the best exposure
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